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1 Introduction
GFI FaxMaker is a fax server that enables your network users to send and receive faxes and SMS directly
from their machine. GFI FaxMaker centralizes your fax infrastructure, without maintaining multiple fax
machines distributed across the office(s) and eliminates the need to print a fax before sending or when
receiving a fax.

GFI FaxMaker for Exchange/SMTP integrates with various mail servers such as Microsoft® Exchange
Server, Lotus Notes and with other SMTP/POP3 mail servers.

While every effort is made to ensure that all functionality and references to third party software are correct,
there might be discrepancies due to updates at the discretion of the aforementioned third party vendors.

1.0.1 Conventions used in this manual

Convention Description

> Step by step navigational instructions to access a specific function.

Bold text Items to select such as nodes, menu options or command buttons.

Italics text Parameters and values that you must replace with the applicable value, such as custom paths and file
names.

Code Indicates text values to key in, such as commands and addresses.

1.1 How fax receiving works

Step 1: Receive fax call

The sender transmits the fax. This is received by GFI FaxMaker either from a fax line or from a hosted
fax service.

Step 2: GFI FaxMaker processes fax & content

GFI FaxMaker processes the received fax. Amongst others:

(Optional) Blocks junk faxes.

(Optional) Optically recognizes text in fax (OCR).
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Determines recipients according to fax routing settings.

Forwards fax by email to appropriate users.

For more information, refer to Configuration - Receiving faxes (page 161).

Step 3: Recipients receive the fax

The fax recipients receive the fax in their mailbox. For more information, refer to How users view
received faxes (page 71).

1.2 How fax sending works

Step 1: Various methods used to send a fax

The fax content is sent to GFI FaxMaker using one of the various supported methods:

Via email

Web Client

NetPrintQueue2Fax

Text, XML or Web Service API

For more information, refer to How users send faxes (page 65).

Step 2: GFI FaxMaker processes fax content

GFI FaxMaker processes the received content and prepares it for transmission. Amongst others, GFI
FaxMaker:

Resolves and formats the number to dial

Converts content to fax format

Adds any coverpages

Adds any headers and footers
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For more information, refer to Configuration - Sending faxes (page 127).

Step 3: Fax transmission

GFI FaxMaker transmits the fax:

to an installed fax device which in turn transmits the fax over the telephone line

or to a hosted fax service.
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2 System Requirements
Before installing GFI FaxMaker, ensure that the system meets or exceeds the below requirements. If these
requirements are not met, you may encounter problems during installation or in functionality.

NOTE
The below requirements are for GFI FaxMaker software only. Third-party software or hardware (such
as fax cards and their drivers) may have higher or different requirements. Ensure that the system meets
or exceeds the requirements for both GFI FaxMaker and third-party software/hardware.

2.1 Software requirements 11

2.2 Hardware requirements 12

2.2.1 Fax transmission 13

2.3 Backup software 13

2.4 Anti-virus software 13

2.5 Firewall settings 13

2.1 Software requirements

Supported operating systems

Install GFI FaxMaker on any 64-bit versions of the operating systems listed below.

Operating system (64-bit
only)

Supported editions and notes

Windows Server® 2016 Supported editions: Datacenter, Standard & Essentials

Windows Server® 2012 R2 Supported editions: Standard, Datacenter, Essentials & Foundation

Windows Server® 2008 R2 Supported editions: Standard & Enterprise

Windows® SBS 2011 Supported editions: Standard & Premium

Windows® 10 Supported editions: Pro & Enterprise
For more information, refer to Installing GFI FaxMaker on Windows 10, 8 or 7 (page
63).

Windows® 8 and 8.1 Supported editions: Pro & Enterprise
For more information, refer to Installing GFI FaxMaker on Windows 10, 8 or 7 (page
63).

Windows® 7 Supported editions: Ultimate, Enterprise & Professional
For more information, refer to Installing GFI FaxMaker on Windows 10, 8 or 7 (page
63).

Supported mail servers

GFI FaxMaker can be installed in an environment with any of the mail servers listed below.
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Mail server type

Microsoft® Exchange Server 2010 or later

Microsoft® Exchange cluster environments 2010 or later

Lotus Notes/Domino

Hosted mail servers

Other SMTP/POP3 servers

For more information, refer to Mail server configuration (page 15). If no mail server is available, refer to
UsingGFI FaxMaker without amail server.

NOTE
The GFI FaxMaker server requires a public IP address when using a hosted email service, such as
Microsoft®Office 365™ or Google Apps for Business. For more information, refer to Hosted email (page
34).

Other required components

Component Environment

Microsoft® .NET
Framework 4 or
over

Required as from GFI FaxMaker version 2013 Service Release 3.

IIS SMTP service Required except when installing GFI FaxMaker on the Microsoft® Exchange server.
NOTES:

Ensure that the SMTP service is running in the Services applet.
This service is not available on Microsoft®Windows® 10, 8 or 7. In this case, fax/SMS emails

cannot be routed to GFI FaxMaker via this service. Use an alternative method of sending faxes
instead. For more information, refer to Installing GFI FaxMaker on Windows 10, 8 or 7 (page 63).

IIS WWW service Required to access the GFI FaxMaker web interface.
If not found, this is automatically installed by GFI FaxMaker during installation.

Hub Transport
role

Required when installing on a Microsoft® Exchange Server 2010 or newer.

Internet
Explorer®

Required for HTML cover pages.

2.2 Hardware requirements
Install GFI FaxMaker on a server with the following minimum specifications.

Component Minimum requirement

Processor Intel Pentium or compatible - 2GHz 32 bit processor

Memory 1GB RAM (dedicated to GFI FaxMaker)

Physical
storage

500 MB required for GFI FaxMaker installation only.
Note: Temporary fax storage, archiving and backup require extra space depending on the amount and
size of faxes processed.
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2.2.1 Fax transmission
GFI FaxMaker requires at least onemedium that enables sending and receiving of faxes.

Component Description

Fax device A professional fax modem class 2, 2.0 or 2.1 using either the Microsoft® or the GFI fax modem drivers,
such as: Brooktrout TR 1034 or Trufax fax board, a Dialogic Diva Pro/Server fax card or an AVM active
fax card.
For a complete list of supported devices, refer to: http://go.gfi.com/?pageid=FM_Devices
NOTE: For more information related to the installation of fax devices go to:
http://go.gfi.com/?pageid=FM19help&lang=en#cshid=FDIManual
NOTE: Minimum requirements for particular fax devices may be higher than GFI FaxMaker’s.

Fax over IP Use a supported Fax over IP (FoIP) implementation to transmit faxes over the IP network , such as to a
VoIP PBX, Media Gateway or a SIP trunk provider. Supported FoIP implementations include TE-
SYSTEMS XCAPI and Dialogic Brooktrout SR140. For more information related to the installation of fax
devices go to: http://go.gfi.com/?pageid=FM19help&lang=en#cshid=foip

Online fax
service

An account with a supported online fax provider. For more information go to
http://go.gfi.com/?pageid=FM_FaxServices.
To use this service, the GFI FaxMaker machine must be able to connect to the fax provider via Internet.

2.3 Backup software
Backup software can cause GFI FaxMaker to malfunction if GFI FaxMaker is denied access to some of its
files.

Backup GFI FaxMaker installation files only when GFI FaxMaker services are not running. From the
Services applet, stop the following services:

GFI FaxMaker Fax Server

GFI FaxMaker Message Transfer Agent

GFI FaxMaker Attendant

For more information, refer to How to backupGFI FaxMaker settings (page 181).

2.4 Anti-virus software
Anti-virus software causes GFI FaxMaker to malfunction if GFI FaxMaker is denied access to some of its
files. Add an anti-virus exclusion that prevents the anti-virus engine from scanning the GFI FaxMaker
installation folder and other folders used by the product, such as the Text and XML API folders.

2.5 Firewall settings
Configure your firewall to allow connections from the GFI FaxMaker server on the following ports:

Port Protocol Description

25 TCP IIS SMTP - Used by GFI FaxMaker to communicate with mail server.

80 TCP The default port used to access the GFI FaxMaker web interface using a web browser. This
can be customized in IIS, for example when using a secure HTTP connection which by
default uses port 443.

http://go.gfi.com/?pageid=FM_Devices
http://go.gfi.com/?pageid=FM19help&lang=en#cshid=FDIManual
http://go.gfi.com/?pageid=FM19help&lang=en#cshid=foip
http://go.gfi.com/?pageid=FM_FaxServices
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Port Protocol Description

135-139 TCP/UDP Microsoft® file sharing Server Message Block (SMB) - Used by the GFI FaxMaker remote
management tools to connect to the GFI FaxMaker share.

445 TCP/UDP Direct-hosted SMB traffic without a network basic input/output system (NetBIOS) - Used by
the GFI FaxMaker remote management tools to connect to the GFI FaxMaker share.

8555 TCP Used by the GFI FaxMaker Client and Web Services API. This port can be automatically
opened whilst running the GFI FaxMaker Configuration Wizard.
For more information refer to
http://go.gfi.com/?pageid=FM19help&lang=en#cshid=FirewallPorts

http://go.gfi.com/?pageid=FM19help&lang=en#cshid=FirewallPorts
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3 Mail server configuration
When users send fax or SMS by sending an email to number@faxmaker.com, the mail server must route
this email to GFI FaxMaker to enable fax transmission. To enable this functionality, configure routing
connectors on your mail server that route all emails addressed to *@faxmaker.com and
*@smsmaker.com to GFI FaxMaker.

NOTE
When installing GFI FaxMaker on Microsoft®Windows® 10, 8 or 7, faxes cannot be routed to GFI
FaxMaker using connectors. Use a POP3 mailbox instead. For more information, refer to Installing GFI
FaxMaker onWindows 10, 8 or 7 (page 63).

Choose the email service type:

3.1 Microsoft Exchange 15

3.2 Lotus Notes/Domino 19

3.3 Hosted email 34

3.4 Other mail environments 44

3.5 Using GFI FaxMaker without a mail server 45

3.1 Microsoft Exchange
In a Microsoft Exchange environment, GFI FaxMaker can be installed directly on theMicrosoft Exchange
server or on a separatemachine.

For Microsoft Exchange clusters, refer toMicrosoft Exchange cluster.

3.1.1 Install directly on Microsoft Exchange server
GFI FaxMaker can be installed directly on a Microsoft® Exchange Server 2010/2013/2016 environment,
that includes the Hub Transport role. For more information, refer to SystemRequirements (page 11).

Screenshot 1: GFI FaxMaker installed on the Exchange server

During installation, GFI FaxMaker automatically configures Microsoft® Exchange to process faxes and
SMS. No further configuration is required post-installation.



GFI FaxMaker 3Mail server configuration | 16

Process Description

Client side Users send faxes/SMS via email using Microsoft® Outlook® or via the GFI FaxMaker Client
application.

Sending
faxes/SMS

The mail server is automatically configured to route all emails addressed to faxmaker.com,
smsmaker.com, Fax: & SMS: to GFI FaxMaker.

Received
faxes/SMS

After determining the users to whom to forward incoming faxes/SMS, GFI FaxMaker sends
transmission report via Microsoft® Exchange.

3.1.2 Install on a machine separate than Microsoft Exchange
When GFI FaxMaker is not installed directly on the Microsoft Exchange server, configure connectors on the
mail server that route fax and SMS to GFI FaxMaker.

3.1.3 How it works

Screenshot 2: GFI FaxMaker installed on a dedicated server

Process Description

Client side Users send faxes/SMS via email using Microsoft® Outlook® or via the GFI FaxMaker Client
application.

Sending
faxes/SMS

SMTP connectors on the Microsoft® Exchange server forward all emails addressed to
*@faxmaker.com, *@smsmaker.com, Fax: & SMS: to GFI FaxMaker.

Received
faxes/SMS

After determining the users to forward incoming faxes/SMS to, GFI FaxMaker sends transmission report
via SMTP to the Microsoft® Exchange server.

Creating the connectors

Create SMTP connectors on Microsoft® Exchange to route all emails addressed to faxmaker.com,
smsmaker.com, fax: and sms: to GFI FaxMaker.

NOTES

1. To use this setup, install the IIS SMTP service on the GFI FaxMaker server.

2. The default fax (faxmaker.com) and SMS (smsmaker.com) domains can be customized by the
GFI FaxMaker administrator. For more information, refer to Fax and SMS domain names (page 105).

1. Run the GFI FaxMaker setup on the Microsoft® Exchange server (the Hub Transport role for Microsoft®
Exchange 2007 onwards).

2. When choosing the components to install, disableGFI FaxMaker Fax Server and select Exchange
SMTP connector.

3. In the next screen, specify the IP address or server name of the GFI FaxMaker server.
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4. Proceed with installation.

The setup creates the required connectors on Microsoft Exchange. For more information, refer to
Microsoft® Exchange 2010/2013/2016 Connector (page 17).

3.1.4 Microsoft® Exchange 2010/2013/2016 Connector

When using GFI FaxMaker in a Microsoft® Exchange 2010/2013/2016 environment, configure SMTP
connectors to route all emails addressed to faxmaker.com, smsmaker.com, fax: and sms: to GFI
FaxMaker.

NOTE
The default fax (faxmaker.com) and SMS (smsmaker.com) domains can be customized by the GFI
FaxMaker administrator. For more information, refer to Fax and SMS domain names (page 105).

Creating the connectors automatically

GFI FaxMaker installed onMicrosoft® Exchange Hub Transport Server

During installation, GFI FaxMaker automatically configures Microsoft® Exchange to allow processing of
faxes and SMS.

The setup creates a Foreign Connector and a Receive Connector namedGFIFaxMaker.

No further configuration is required post-installation.

GFI FaxMaker installed on a separatemachine

To configure connectors when installing GFI FaxMaker on a separate machine than Microsoft® Exchange
2010/2013/2016 Hub Transport role server:

1. Run the GFI FaxMaker setup on the Microsoft® Exchange Hub Transport server.

2. When choosing the components to install, disableGFI FaxMaker Fax Server and select Exchange
SMTP connector.

3. In the next screen, specify the IP address or server name of the GFI FaxMaker server.

4. Proceed with installation.

The setup creates a Send Connector and a Receive Connector namedGFIFaxMaker.

For more information, refer to Installation procedure (page 48).

Creating the connectors manually

GFI FaxMaker installed onMicrosoft® Exchange Hub Transport Server

Use the following Microsoft® Exchange Management Shell commands to create the connectors manually
when GFI FaxMaker is installed on Microsoft® Exchange Hub Transport Server. This procedure is not
usually required since GFI FaxMaker automatically configures the connectors automatically during
installation.

1. Create a Receive Connector:

new-receiveconnector -name "GFIFaxMaker" -Bindings "0.0.0.0:25" -RemoteIPRanges
"127.0.0.1" -AuthMechanism "ExternalAuthoritative" -PermissionGroups
"ExchangeServers" -fqdn "faxmaker.com"

2. Create and set a Foreign Connector:
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New-ForeignConnector -Name GFIFaxmaker -AddressSpaces "SMTP:faxmaker.com" ,
"SMTP:smsmaker.com" , "FAX:*" , "SMS:*"

Set-ForeignConnector -Identity GFIFaxmaker -DropDirectory "C:\Program Files
(x86)\GFI\FAXmaker\Sinkdrop"

Change C:\Program Files (x86)\GFI\FAXmaker with the path to your GFI FaxMaker installation
folder.

NOTE
ASend Connector should not be created when GFI FaxMaker is installed on the Hub Transport Server.

GFI FaxMaker installed on a separatemachine

To create the connectors manually, when GFI FaxMaker is installed separately from the Microsoft®
Exchange Hub Transport server:

1. From the Microsoft® Exchange Management Shell, create a Receive Connector:

new-receiveconnector -name "GFIFaxMaker" -Bindings "0.0.0.0:25" -RemoteIPRanges
"10.10.10.10" -AuthMechanism "ExternalAuthoritative" -PermissionGroups
"ExchangeServers" -fqdn "faxmaker.com"

Replace 10.10.10.10 with the IP address of the GFI FaxMaker machine.

2. Create a Send Connector:

new-sendconnector -name "GFIFaxmaker" -AddressSpaces SMTP:faxmaker.com ,
SMTP:smsmaker.com , FAX:* , SMS:* -DNSRoutingEnabled:$false -SmartHosts
"10.10.10.10"

Replace 10.10.10.10 with the IP address or name of the GFI FaxMaker machine.

NOTES
1. The default fax (faxmaker.com) and SMS (smsmaker.com) domains can be customized by the
GFI FaxMaker administrator. If using custom domains, key in the custom domains instead.
2. A Foreign Connector should not be created when installing GFI FaxMaker separately from the Hub
Transport Server.

3.1.5 Microsoft Exchange cluster
To install GFI FaxMaker in a Microsoft® Exchange cluster environment:

1. Install GFI FaxMaker on a machine that does not form part of the cluster.

2. On each cluster node, setup Microsoft® Exchange SMTP connectors to forward emails addressed to
*@faxmaker.com, *@smsmaker.com, Fax: &SMS: to GFI FaxMaker.

Microsoft® Exchange 2010/2013/2016:

NOTE
The default fax (faxmaker.com) and SMS (smsmaker.com) domains can be customized by the GFI
FaxMaker administrator. If using different domains, specify your custom domains. After installation,
specify the domains in the GFI FaxMaker Configuration. For more information, refer to Fax and SMS
domain names (page 105).
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3.2 Lotus Notes/Domino
Use Lotus Notes/Domino with GFI FaxMaker to send faxes and SMS.

GFI FaxMaker can be installed in a Lotus Domino/Notes 4/5/6/6.5 environment, either directly on the server
or on a separate machine. For larger networks it is recommended to install GFI FaxMaker on a separate
machine than Lotus Notes/Domino.

3.2.1 How it works

Screenshot 3: GFI FaxMaker installed on the Lotus Notes machine

Process Description

Client side Users send faxes/SMS using:
GFI FaxMaker Client - via the Fax Message Form.
Lotus Notes/Domino email client - send email to fax/SMS using the following address format

<faxnumber>@faxmaker.com or <smsnumber>@smsmaker.com.

NOTE: The default fax (faxmaker.com) and SMS (smsmaker.com) domains can be customized by the
GFI FaxMaker administrator. Use the configured fax or SMS domain accordingly. For more information,
refer to Fax and SMS domain names (page 105).

Sending
faxes/SMS

Lotus Notes/Domino routes faxes/SMS to a dedicated mailbox. GFI FaxMaker retrieves faxes/SMS from
this mailbox via POP3. To do this:

Create a dedicated mailbox for GFI FaxMaker in Lotus Notes/Domino.
Route all emails addressed to *@faxmaker.com and *@smsmaker.com to this mailbox.
Configure GFI FaxMaker POP3 Connector to retrieve emails stored in this mailbox.

NOTE: The default fax (faxmaker.com) and SMS (smsmaker.com) domains can be customized by the
GFI FaxMaker administrator.

Received
faxes/SMS

After determining the users to forward incoming faxes/SMS to, GFI FaxMaker sends transmission report
via SMTP to the Lotus Domino/Notes server.

Select the appropriate version:

LotusDomino/Notes server 6.5

LotusDomino/Notes server 6

LotusNotes 4 and 5
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3.2.2 Lotus Notes 4 and 5

Step 1: Create a dedicated database for GFI FaxMaker

Screenshot 4: Creating a Notes Fax database

1. In the NotesWorkspace select File > Database > New.

2. In New Database dialog, set the following options:

Option Setting

Server Local

Title GFI FaxMaker

Template Server Local

Template Mail (R5.0/6.0).

ClickOK.

3. Right-click new database and select Access Control.

4. InManager rights, enable Delete document option.

Step 2: Define the database as a POPMailbox

1. From the NotesWorkspace, navigate to Server and open the server Address book.

2. Click Add Person.

3. From Basics tab, enter a Name and Password for the Mailbox and set the user name Fax.

4. FromMail tab, setMail system to POP or IMAP.

5. From Internet message storage option, setMail section to Notes and Internet Mail.

6. Click Save and Close.
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Screenshot 5: Setting up the POP mailbox for GFI FaxMaker

Step 3: Set up forwarding of the domain

1. From the Lotus workspace, open the address book and navigate to Server > Domains.
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Screenshot 6: Setting up a Foreign Domain in Lotus Notes

2. Click Add domain.

3. In the Basics section, setDomain type to Foreign Domain.

4. In the Foreign Domain Name field, enter the name of the domain you want to set up (for example, fax).

5. Select theMail information tab.
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Screenshot 7: Foreign Domain options

6. InGateway server name, key in the name of the server where the GFI FaxMaker mailbox is found (for
example, fax\gfi).

7. InGateway mail file name, key in the name of the GFI FaxMaker mailbox (for example, mail\GFI
FaxMaker.nsf).

8. Click Save and close.

Step 4: Modifying the GFI FaxMaker Notesmailbox views

Set up the GFI FaxMaker mailbox views to allow the GFI FaxMaker MTA to see the forwarded mail.

1. Log on to the GFI FaxMaker mailbox client from a Notes client.

2. SelectDesign > Views.
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Screenshot 8: Modifying the mailbox views

3. Double-click ($POP3).

4. Delete all the entries in the script windows (lower window).

5. Save and close.
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Screenshot 9: The ($POP3) view
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3.2.3 Lotus Domino/Notes server 6

Step 1: Create amailbox database on the Domino server

Screenshot 10: Creating a new database

1. From Domino Administrator menu bar, select File > Database > New.

2. Select your Domino Server. Choose mail directory and enter GFIFaxMaker.nsf as the filename.

3. ClickOK to create the database.

Step 2: Configure the Person for the GFI FaxMaker Domino database

1. From Domino Administrator, click Add Person.



GFI FaxMaker 3Mail server configuration | 27

Screenshot 11: Add a person

2. Fill in the following fields:

Option Setting

First name GFI FaxMaker

Last name Mailbox

User name GFI FaxMaker

Short name/User ID GFIFaxMaker

Internet Password Choose a POP3 password.

Mail System POP or IMAP

Mail Server Domino Server name

Internet Address The email address which will be able to receive email on the server.

3. Click Save and Close.

Step 3: Give theGFI FaxMaker Person permission on theGFI FaxMaker database

1. In the Domino Administrator, select File > Database > Open to open the GFI FaxMaker database.
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Screenshot 12: Open the GFI FaxMaker database

2. Select server and browse to the GFI FaxMaker database. ClickOpen.

3. Navigate to File > Database > Access Control.

Screenshot 13: Configuring permissions
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4. Click Add to add the GFI FaxMaker Person.

5. Select the GFI FaxMaker Person and from the Attributes section, selectUser type: Person, Access:
Manager.

6. SelectDelete Documents.

7. ClickOK.

Step 4: Remove default $POP3 View

1. From Lotus Domino Designer, select File > Database > Open.

2. Select your Domino server, the mail directory andGFIFaxMaker.nsf.

3. From Views node, double-click $POP3.

Screenshot 14: Removing the default POP3 view

4. ClickOK to the warning prompt.

5. Select the following two lines and delete them from the $POP view object.

DEFAULT DeliveredDate := “”;

SELECT DeliveredDate != “”
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Screenshot 15: Delete lines from $POP view

6. Save and exit Domino Designer.

Step 5: Add the FAX Foreign Domain

1. Load Domino Administrator.

2. SelectConfiguration tab and selectMessaging\Domains.

4. Click Add Domain and select Foreign Domain.

5. Enter fax as the Foreign Domain Name.

6. Select theMail Information tab.

7. Enter the Domino server name as theGateway server name.

8. Enter mail\GFI FaxMaker.nsf as theGateway Mail File Name.

NOTE
When RFC822 phrase handling is enabled on outbound email, the fax number appears twice when GFI
FaxMaker sends the fax. To resolve this, perform the following from Notes Administrator:
1. From the Configuration tab, selectMessaging > Configurations.
2. Click Edit Configuration on the server with the GFI FaxMaker mailbox.
3. Select theMIME tab > Advanced Tab > Advanced Outbound Message Options tab.
4. Set RFC822 Phrase Handling to Do not add phrase.

3.2.4 Lotus Domino/Notes server 6.5

Step 1: Allow mail relay from LotusDomino/Notes server

1. From the GFI FaxMaker server, load the Internet Information Services console.

2. Right-clickDefault SMTP Virtual Server node and select Properties.

3. From Access tab, clickRelay….
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Screenshot 16: Relay restrictions dialog

4. SelectOnly the list below and click Add….

5. Select Single computer and in the IP address field specify the Lotus Domino/Notes Server IP address.
ClickOK.

6. ClickOK in all dialogs to apply changes.

Step 2: Add a foreign SMTP domain on the Lotus server

1. From Domino Administrator, selectConfiguration tab.

2. Navigate toMessaging > Domains node.
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Screenshot 17: Adding a new domain

3. Click Add Domain.
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Screenshot 18: Configuring the domain type

4. From New Domain page, select Basics tab and set the Domain type to Foreign SMTP Domain.

5. SelectRouting tab and fromMessages Addressed to, set Internet Domain to:
faxmaker.com,smsmaker.com.

NOTE
The default fax (faxmaker.com) and SMS (smsmaker.com) domains can be customized by the GFI
FaxMaker administrator. If using different domains, specify your custom domains. After installation,
specify the domains in the GFI FaxMaker Configuration. For more information, refer to Fax and SMS
domain names (page 105).
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Screenshot 19: Configure the routing settings

6. Under Should be Routed to section, set Internet host to the IP address (enclosed in [ ] ) or name of the
GFI FaxMaker server.

7. Save and close Foreign SMTPDomain entry.

8. Reload Domino router from the Domino server console with the following commands:

tell router stop

tell router start

3.3 Hosted email
When using an online hosted email service, create connectors that route fax and SMS to GFI FaxMaker.

Select your hosted email provider:

Microsoft® Office 365™ Enterprise accounts

Microsoft® Office 365™ Email only accounts

Google Apps for Business - Gmail

Internet Service Provider

Other hosted email providers

3.3.1 Microsoft® Office 365™ Enterprise accounts

Refer to the following steps to use GFI FaxMaker with Microsoft®Office 365™Enterprise account types.
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Step 1: Install GFI FaxMaker and set mail server details

Step 2: Set Connectors

Step 3: Test functionality

Step 1: Install GFI FaxMaker and set mail server details

Install GFI FaxMaker on a machine that meets or exceeds the GFI FaxMaker system requirements. For
more information, refer to SystemRequirements (page 11).

Launch the GFI FaxMaker installer and follow the wizard to complete installation. For more information,
refer to Installation procedure (page 48).

On install completion, the installer automatically launches the Configuration Wizard that assists you through
the basic steps of configuration. Configure the following wizard steps:

1. In the Configuration Wizard welcome screen clickNext.

2.ChooseMy email server will forward faxes and SMSs to this GFI FaxMaker machine. ClickNext.

Option Description

Mail server name
or IP address

Key in smtp.office365.com

Port Key in 587.

Use Secure
Connection

Select this option and choose TLS.

Use SMTP
Authentication

Select this option and enter the credentials of a Microsoft®Office 365™ mailbox user. Key in the
user's full email address in the Account name and the Password.
Do not select Secure Password Authentication.

NOTE
If GFI FaxMaker is already installed, configure the above mail server details fromGFI FaxMaker
Configuration > Email2FaxGateway.

3. Proceed with wizard to finalize configuration. For more information, refer to Run theGFI FaxMaker Con-
figurationWizard (page 52).

NOTE
When sending emails to your organization users, for example when notifying administrators of system
errors, GFI FaxMaker sends the email from the email address fax@<fax domain>, for example,
fax@faxmaker.com. Ensure that GFI FaxMaker can send emails via your mail server from this email
address.

Step 2: Set Connectors

NOTE
Connectors are not available with all Office 365 plans. If your plan does not support connectors, refer to
Microsoft®Office 365™Email only accounts.

Configure fax and SMS connectors in Microsoft®Office 365 Exchange Admin Center to route outgoing
fax/SMS emails from Microsoft®Office 365 to the GFI FaxMaker server.
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Connectors must be configured such that when the recipient domain of an outgoing email matches the fax
or SMS domains, the email gets routed to GFI FaxMaker for fax/SMS transmission.

Create a connector using the following options:

From Office 365

To your organization’s email server

Choose to use the connectors when email messages are sent to particular domains and add the fax
& SMS domains

Specify the GFI FaxMaker server public IP address or Fully Qualified Domain Name as the Smart Host.

Configure the other connector settings depending on your organization's setup. For more information about
Office 365 connectors refer to http://go.gfi.com/?pageid=FM_Office365Connector.

Your users should now be able to send faxes using the standard addressing format <fax
number>@faxmaker.com (for example, 12345678@faxmaker.com).

Step 3: Test functionality

Test fax sending

Use a hosted email user to send a fax or SMS via email.

View the email being processed in the GFI FaxMaker Monitor and confirm that the fax is received by the
recipient.

If you cannot see the fax email being processed in the GFI FaxMaker Monitor, troubleshoot the relaying of
the email from the mail server to GFI FaxMaker.

Test fax receiving

From a test fax line, send a fax to a fax line connected and configured in GFI FaxMaker.

View the incoming fax status from GFI FaxMaker Monitor.

Unless Routing rules were previously configured, the fax is delivered through the Default Routers (Available
fromGFI FaxMaker Configuration > Routing > Properties > Default Routers). Ensure that the fax is
successfully delivered to the Default Routers’ mailbox.

3.3.2 Microsoft® Office 365™ Email only accounts

Refer to the following steps to use GFI FaxMaker with Microsoft®Office 365™Email only account types or for
other plans that do not include email connectors.

With the following setup, users cannot use faxmaker.com and smsmaker.com when sending faxes
since connectors cannot be created. Instead, configure fax and SMSDNS records, such as
fax.mydomain.com and sms.mydomain.com.

Step 1: Install GFI FaxMaker and set mail server details

Step 2: Create alias records

Step 3: Configure GFI FaxMaker domains

Step 4: Test functionality

Step 1: Install GFI FaxMaker and set mail server details

Install GFI FaxMaker on a machine that meets or exceeds the GFI FaxMaker system requirements. For
more information, refer to SystemRequirements (page 11).

http://go.gfi.com/?pageid=FM_Office365Connector
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Launch the GFI FaxMaker installer and follow the wizard to complete installation. For more information,
refer to Installation procedure (page 48).

On install completion, the installer automatically launches the Configuration Wizard that assists you through
the basic steps of configuration. Configure the following wizard steps:

1. In the Configuration Wizard welcome screen clickNext.

2.ChooseMy email server will forward faxes and SMSs to this GFI FaxMaker machine. ClickNext.

3. Specify the mail server details where GFI FaxMaker forwards received emails.

Option Description

Mail server name
or IP address

Key in smtp.office365.com.

Port Key in 587.

Use Secure
Connection

Select this option and choose TLS.

Use SMTP
Authentication

Select this option and enter the credentials of a Microsoft®Office 365™ mailbox user. Key in the
user's full email address in the Account name and the Password.
Do not select Secure Password Authentication.

NOTE
If GFI FaxMaker is already installed, configure the above mail server details fromGFI FaxMaker
Configuration > Email2FaxGateway.

4. Proceed with wizard to finalize configuration. For more information, refer to Run theGFI FaxMaker Con-
figurationWizard (page 52).

NOTE
When sending emails to your organization users, for example when notifying administrators of system
errors, GFI FaxMaker sends the email from the email address fax@<fax domain>, for example,
fax@faxmaker.com. Ensure that GFI FaxMaker can send emails via your mail server from this email
address.

Step 2: Create alias records

NOTE
If you are not familiar with DNS, contact your DNS hosting company to create these records.

Create two new alias records (“A” record) with your DNS hosting provider that are dedicated for the fax and
SMS domains (for example, fax.mydomain.com and sms.mydomain.com).

Point the destination of these records to the public IP address of the GFI FaxMaker server.

When emails are addressed to these domains, the hosting provider's mail relay server routes the email to
GFI FaxMaker.

NOTE
DNS changes can take up to 72 hours to take effect.
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Step 3: Configure GFI FaxMaker domains

1. From GFI FaxMaker Configuration, right-click Email2FAXGateway node and select Properties.

2. From the Fax/SMS domains tab, specify custom Fax domain name and/or SMS domain name (for
example, fax.mydomain.com and sms.mydomain.com).

3.ClickOK to apply changes.

Step 4: Test functionality

Test fax sending

Use a hosted email user to send a fax or SMS via email.

View the email being processed in the GFI FaxMaker Monitor and confirm that the fax is received by the
recipient.

If you cannot see the fax email being processed in the GFI FaxMaker Monitor, troubleshoot the relaying of
the email from the mail server to GFI FaxMaker.

Test fax receiving

From a test fax line, send a fax to a fax line connected and configured in GFI FaxMaker.

View the incoming fax status from GFI FaxMaker Monitor.

Unless Routing rules were previously configured, the fax is delivered through the Default Routers (Available
fromGFI FaxMaker Configuration > Routing > Properties > Default Routers). Ensure that the fax is
successfully delivered to the Default Routers’ mailbox.

3.3.3 Google Apps for Business - Gmail
Refer to the following steps to use GFI FaxMaker with Gmail for Google Apps for Business.

With Google Apps, users cannot use faxmaker.com and smsmaker.com when sending faxes since
connectors cannot be created. Instead, configure fax and SMSDNS records, such as
fax.mydomain.com and sms.mydomain.com.

Step 1: Install GFI FaxMaker and set mail server details

Step 2: Create alias records

Step 3: Configure GFI FaxMaker domains

Step 4: Test functionality

Step 1: Install GFI FaxMaker and set mail server details

Install GFI FaxMaker on a machine that meets or exceeds the GFI FaxMaker system requirements. For
more information, refer to SystemRequirements (page 11).

Launch the GFI FaxMaker installer and follow the wizard to complete installation. For more information,
refer to Installation procedure (page 48).

On install completion, the installer automatically launches the Configuration Wizard that assists you through
the basic steps of configuration. Configure the following wizard steps:

1. In the Configuration Wizard welcome screen clickNext.

2.ChooseMy email server will forward faxes and SMSs to this GFI FaxMaker machine. ClickNext.



GFI FaxMaker 3Mail server configuration | 39

3. Specify the mail server details where GFI FaxMaker forwards received emails.

Option Description

Mail server name
or IP address

Key in smtp.gmail.com.

Port Use port 465 which requires SSL or port 587 which requires TLS.

Use Secure
Connection

Select this option and choose SSL or TLS depending on the port chosen.

Use SMTP
Authentication

Select this option and enter the credentials of a Google Apps mailbox user. Key in the user's full
email address in the Account name and the Password.
Do not select Secure Password Authentication.

NOTE
If GFI FaxMaker is already installed, configure the above mail server details fromGFI FaxMaker
Configuration > Email2FaxGateway.

4. Proceed with wizard to finalize configuration. For more information, refer to Run theGFI FaxMaker Con-
figurationWizard (page 52).

NOTE
When sending emails to your organization users, for example when notifying administrators of system
errors, GFI FaxMaker sends the email from the email address fax@<fax domain>, for example,
fax@faxmaker.com. Ensure that GFI FaxMaker can send emails via your mail server from this email
address.

Step 2: Create alias records

NOTE
If you are not familiar with DNS, contact your DNS hosting company to create these records.

Create two new alias records (“A” record) with your DNS hosting provider that are dedicated for the fax and
SMS domains (for example, fax.mydomain.com and sms.mydomain.com).

Point the destination of these records to the public IP address of the GFI FaxMaker server.

When emails are addressed to these domains, the hosting provider's mail relay server routes the email to
GFI FaxMaker.

NOTE
DNS changes can take up to 72 hours to take effect.

Step 3: Configure GFI FaxMaker domains

1. From GFI FaxMaker Configuration, right-click Email2FAXGateway node and select Properties.

2. From the Fax/SMS domains tab, specify custom Fax domain name and/or SMS domain name (for
example, fax.mydomain.com and sms.mydomain.com).

3.ClickOK to apply changes.
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Step 4: Test functionality

Test fax sending

Use a hosted email user to send a fax or SMS via email.

View the email being processed in the GFI FaxMaker Monitor and confirm that the fax is received by the
recipient.

If you cannot see the fax email being processed in the GFI FaxMaker Monitor, troubleshoot the relaying of
the email from the mail server to GFI FaxMaker.

Test fax receiving

From a test fax line, send a fax to a fax line connected and configured in GFI FaxMaker.

View the incoming fax status from GFI FaxMaker Monitor.

Unless Routing rules were previously configured, the fax is delivered through the Default Routers (Available
fromGFI FaxMaker Configuration > Routing > Properties > Default Routers). Ensure that the fax is
successfully delivered to the Default Routers’ mailbox.

3.3.4 Other hosted email
This topic explains how to setup an environment for fax server integration with a hosted mail server. Use
your preferred hosted email service to forward fax emails designated to GFI FaxMaker.

Users typically send fax or SMS by sending an email to number@faxmaker.com and
number@smsmaker.com. The mail server routes emails addressed to *@faxmaker.com and
*@smsmaker.com to GFI FaxMaker. If your mail provider does not allow routing to domain, configure
alias domains dedicated for fax and SMS, for example fax.mydomain.com.

NOTES

1. Your hosted mail server configuration procedure may differ than the instructions provided in this
topic. For more information refer to the service provider’s help.

2. These instructions apply to fax subdomains. Repeat procedure for SMS domain if required.

IMPORTANT
While editing and configuring A (Host) and MX records, ensure that you are setting the records for the
fax and SMS subdomains only. Changes to the A (Host) and MX records for the primary domain can
disrupt email/web traffic for that domain.

Requirements

Ensure that you have adequate permissions to create subdomain forwarding:

Domain Registrar Control Panel Access: Administrative access to the hosted email domain registrar
control panel is needed to:

Create and register the fax subdomain

Create and register a new A record for the fax subdomain

Create and register a newMX record for the fax subdomain

Mail Host Control Panel Access: From the mail host control panel, register the fax subdomain to the mail
host and determine the MX record information.
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Step 1: Fax subdomain configuration

Log into your domain registrar control panel and open the Forward Subdomains configuration to create a
new fax subdomain. Choose option to add a new subdomain.

Specify a new subdomain name, for example fax, and specify the public-facing IP address you intend to
use with your fax domain.

Screenshot 20: Adding a subdomain

Return to your domain control panel and open DNS Manager.

Screenshot 21: Creating a Host Record

In the DNSManager, create a new A (Host) Record for your new subdomain, specifying the new subdomain
name (for example, fax) and the public-facing IP address you intend to use with your fax domain.

Screenshot 22: Creating an MX record

Create a newMXRecord for the new subdomain and set the priority to 1.
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Screenshot 23: The newly added record

It can take anywhere from 24 to 48 hours for the new subdomain changes to become active for use by your
registrar. When the wait-time for propagation has passed, verify that the subdomain name is pointing to your
public IP address by performing a Name Server lookup from command prompt, for example: nslookup
fax.mydomain.com. Ensure that the resulting IP address is your public IP address.

NOTE
Ensure that SMTP port 25 on your local firewall is open and forwards to the internal IP address of your
GFI FaxMaker server.

Step 2: GFI FaxMaker Domain Configuration

Configure GFI FaxMaker to convert emails addressed to your subdomain to fax. For more information, refer
to Fax and SMS domain names (page 105).

1.Open the GFI FaxMaker Email2FaxGateway properties and go to the Fax/SMS domains tab.

2. Key in the new fax subdomain, for example fax.mydomain.com.

3.ClickOK and choose to restart your GFI FaxMaker services for changes to take effect.

Step 3: Specify the mail server details

Screenshot 24: MX records

1. Locate the MX record specified for your primary domain in the control panel and copy it.

2.Open the GFI FaxMaker Email2FaxGateway properties.

3. In the SMTP Connector tab key in the MX record for your primary domain in theMail server name/IP
and port box.

4. In the test email area, key in a valid email address for a user in your domain and click Send test email.
Ensure that the user receives a test email from GFI FaxMaker.
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Screenshot 25: Email2Fax configuration

NOTE
When sending emails to your organization users, for example when notifying administrators of system
errors, GFI FaxMaker sends the email from the email address fax@<fax domain>, for example,
fax@faxmaker.com. Ensure that GFI FaxMaker can send emails via your mail server from this email
address.

Step 4: Test functionality

Ensure that fax emails are being forwarded to and processed by GFI FaxMaker.

To do this, open a newmessage form in your web email client and send a sample fax. Ensure that the
recipient’s domain is the configured subdomain. For example, send a fax to
+12345678@fax.mydomain.com. Replace +12345678 with a test fax number and
fax.mydomain.com with your subdomain.

Ensure that the fax was forwarded to GFI FaxMaker successfully by checking the GFI FaxMaker Monitor.
For more information, refer to Monitoring GFI FaxMaker operation (page 79).

3.3.5 ISP hosted
GFI FaxMaker can be installed in an environment where the mail service is provided by the ISP.
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Process Description

Client side Users send faxes/SMS using the GFI FaxMaker Client - Fax Message Form to route directly to GFI
FaxMaker server.
NOTE: Users cannot use email client to send faxes/SMS.

Sending
faxes/SMS

GFI FaxMaker clients route faxes/SMS directly to GFI FaxMaker via SMTP.
NOTE: Install the IIS SMTP service on the GFI FaxMaker server.

Received
faxes/SMS

After determining the users to forward incoming faxes/SMS to, GFI FaxMaker sends transmission
report via SMTP to the hosted mail server.

3.4 Other mail environments
Other email server environments:

SMTP server

POP3mailbox

Multiple Mail servers

SAP 4.7

3.4.1 SMTP server
GFI FaxMaker can be installed in an SMTP server environment such as MDaemon.

To do this:

1.Create a routing rule on your mail server that routes all messages sent to faxmaker.com and sms-
maker.com domains to the GFI FaxMaker server.

2. Install the IIS SMTP service on the GFI FaxMaker server.

3. Install GFI FaxMaker. For more information, refer to Installation procedure (page 48).



GFI FaxMaker 3Mail server configuration | 45

NOTE
The default fax (faxmaker.com) and SMS (smsmaker.com) domains can be customized by the GFI
FaxMaker administrator. Use the configured fax or SMS domain accordingly. For more information,
refer to Fax and SMS domain names (page 105).

3.4.2 POP3 mailbox
GFI FaxMaker can retrieve faxes/SMS from a dedicated POP3 mailbox.

1.On the mail server, create a POP3 mailbox that is dedicated for GFI FaxMaker.

2. Install GFI FaxMaker on a separate machine than the mail server. For more information, refer to Install-
ation procedure (page 48).

3. In the Sending Options screen of the post-installation configuration wizard, specify the details of this
POP3 mailbox and proceed with the wizard.

4.Configure the GFI FaxMaker POP3 Downloader to retrieve emails stored in this mailbox. For more inform-
ation, refer to POP3Downloader (page 103).

When using a POP3 mailbox, the method of sending faxes/SMS via email is different than when routing
emails via SMTP. For more information, refer to Sending faxes/SMS via a POP3Mailbox (page 105).

3.4.3 Multiple mail servers
In a network where multiple mail servers are independent from each other, configure each email server
individually to forward faxes to GFI FaxMaker. Use the same methods described for each type of mail
server.

For more information, refer to Mail server configuration (page 15).

3.4.4 SAP 4.7
For more information how to configure SAP 4.7 to send faxes using GFI FaxMaker, refer to
http://go.gfi.com/?pageid=FM_SAP47.

3.5 Using GFI FaxMaker without a mail server
GFI FaxMaker can be configured to work in environments without a mail server. There are, however, some
limitations with certain features. For example, GFI FaxMaker users cannot send faxes and SMS via email
when a mail server is not available.

Refer to the following sections for assistance on how to install, configure and use GFI FaxMaker in
installations where a mail server is not available.

3.5.1 Sending faxes and SMS
In installations where there is no mail server available, use a method of sending faxes and SMS that does
not require email:

Sending faxes via web client

Printing content to GFI FaxMaker - NetPrintQueue2Fax

Via API

http://go.gfi.com/?pageid=FM_SAP47
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NOTE
If using the GFI FaxMaker Client application, set the Client to connect directly to GFI FaxMaker via
HTTP.

3.5.2 Receiving faxes
When a fax is received, GFI FaxMaker typically sends out an email to the recipient(s). Use other methods to
view received faxes/SMS:

Automatically print incoming faxes

Store incoming faxes to a network share

Alternatively you may also consider using an online mail service for GFI FaxMaker to send out notifications.
For more information, refer to Using an online SMTP server (page 46).

3.5.3 Receiving SMS
When an SMS is received, GFI FaxMaker sends out an email to the recipient(s).

To view received SMSs when a mail server is not available, refer to the SMS log files. For more information,
refer to SMS log files (page 199).

Alternatively you may also consider using an online mail service for GFI FaxMaker to send out notifications.
For more information, refer to Using an online SMTP server (page 46).

3.5.4 GFI FaxMaker system notifications
GFI FaxMaker uses a mail server to send various system notifications to administrators, such as system
errors. When a mail server is not available, GFI FaxMaker cannot send out these notifications.

To monitor GFI FaxMaker operation when a mail server is not available, refer to the logs shown in the GFI
FaxMakerMonitor.

Alternatively you may also consider using an online mail service for GFI FaxMaker to send out notifications.
For more information, refer to Using an online SMTP server (page 46).

3.5.5 Transmission reports
GFI FaxMaker uses a mail server to send transmission reports to your users when they send out a fax or
SMS. When a mail server is not available, GFI FaxMaker cannot send out transmission reports.

In this scenario, the status of sent faxes can be manually monitored from the Archive Viewer. Note that the
Archive Viewer is only accessible from the GFI FaxMaker server machine itself, so your users may not have
access to it.

Alternatively you may also consider using an online mail service for GFI FaxMaker to send out notifications.
For more information, refer to Using an online SMTP server (page 46).

3.5.6 Using an online SMTP server
When a mail server is not available, you may consider using an online mail service that allows SMTP
connections, such as Gmail or Yahoo! Mail. GFI FaxMaker connects to the service using your account
credentials to send out notification emails.

To do this, create a dedicated mailbox on the chosen service and key in the SMTP and account settings in
the GFI FaxMakermail server settings screen. GFI FaxMaker uses this server to send out emails.
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Important notes on choosing a mail server provider:

1.Certain SMTP providers restrict the number of emails that can be sent per day.

2.With this type of SMTP server you will not be able to resend sent or previewed faxes by replying to the
GFI FaxMaker notification, since emails are not routed back from the mailbox to GFI FaxMaker.

3.Certain providers, such as Gmail, need to be configured to allow connections from third party applic-
ations. In Gmail, go to the account settings and from the security options, enable access for less secure
apps.
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4 Installing GFI FaxMaker for the first time
If you have an older version of GFI FaxMaker and wish to upgrade to the latest version, go to Upgrading
from earlier versions.

4.1 Installation procedure

4.1.1 Important notes
During upgrade, GFI FaxMaker services and operations are stopped. Ensure that there are no faxes in

queue as these are permanently lost during upgrade.

Check that you are installing GFI FaxMaker on the machine that meets the system and hardware
requirements.

Log on as Administrator or use an account with administrative privileges.

GFI FaxMaker 19.2 and later offers two types of licensing services:

Using the GFI Account credentials. The username and password are retrieved fromGFI
Accounts and assigned to the user at the moment of the registration of the account.

Using a license key. When upgrading to a newmajor release you also need to upgrade your
license key.

Save any pending work and close all open applications on the machine.

Disable anti-virus software on the server machine during the upgrade. Re-enable it once upgrade is
complete.

4.1.2 Start installation
1.Download the GFI FaxMaker installer. Go to https://www.gfi.com/products-and-solutions/email-and-mes-
saging-solutions/gfi-faxmaker/download

2.Right-click the GFI FaxMaker installer and choose Properties. From theGeneral tab, clickUnblock and
then Apply. This step is required to prevent the operating system from blocking certain actions by the
installer.

3. Launch the GFI FaxMaker installer.

4. Select installation language and clickOK.

5. In the welcome screen, clickNext.

6. To check for a newer build other than the one being installed, selectCheck for a newer build of GFI
FaxMaker on the GFI web site and clickNext. Otherwise, selectDo not check for a new build and click
Next.

NOTE
An active Internet connection is required to check for newer build.

7.Read the license agreement and click Agree to accept and proceed.

https://accounts.gfi.com/
https://accounts.gfi.com/
https://www.gfi.com/products-and-solutions/email-and-messaging-solutions/gfi-faxmaker/download
https://www.gfi.com/products-and-solutions/email-and-messaging-solutions/gfi-faxmaker/download
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Screenshot 26: GFI FaxMaker license page wizard

8. Select a method to enter your subscription details. The options are:

Option Description

Get sub-
scription
information
from GFI
Accounts

This option is selected by default. In the Email Address or username and Password fields, enter your
GFI Accounts Portal credentials or the account used when signing up to download GFI FaxMaker. Click
Login to retrieve the license keys registered to your account. Choose a key from the Available keys
drop-down. If you do not have a GFI account yet, click Sign up now and fill in the registration form.

Manually
enter a
License key

Select this option the copy and paste a license key if you already have one at hand. Click OK to val-
idate the license.

9.ClickNext.

https://accounts.gfi.com/
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Screenshot 27: Selecting what components to install

10. Select the component to install:

Component Description

GFI FaxMaker
Fax Server

Installs GFI FaxMaker on the machine.

Microsoft
Exchange SMTP
connector

Installs the GFI FaxMaker Microsoft® Exchange connectors only. Use this option when GFI
FaxMaker is not installed on the Microsoft® Exchange server to automatically create the
connectors.
If choosing this option, in the next screen specify the IP address of the GFI FaxMaker server and
proceed to install the connectors.
NOTE: Do not select this option when running setup on a machine that is not the Microsoft®
Exchange server or not using Microsoft® Exchange as your mail server.
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Screenshot 28: Web application settings

11.Choose the IIS website where to host the GFI FaxMaker virtual directory and key in a name for the Vir-
tual Directory, which by default is Faxmaker. For more information about how to use the web interface refer
to TheGFI FaxMaker web interface. ClickNext.

Screenshot 29: Account name for services
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12. Provide credentials of an account with administrative privileges, used for GFI FaxMaker services man-
agement. ClickNext.

NOTE
If changing the password after installing GFI FaxMaker, update the password for the GFI FaxMaker
services from the Services applet. When GFI FaxMaker is installed in a domain, these credentials are
also used to connect to Active Directory and retrieve the list of users.

13.ClickNext to continue installing GFI FaxMaker to the default folder, or Browse to select a new install-
ation path.

14.ClickNext to install GFI FaxMaker. In certain environments, you may be prompted to restart the IIS
SMTP service.

15.Click Finish.

After installation, the GFI FaxMaker Configuration Wizard is automatically launched to help you configure
basic settings. For more information, refer to Run theGFI FaxMaker ConfigurationWizard (page 52).

4.2 Run the GFI FaxMaker Configuration Wizard
The GFI FaxMaker Configuration Wizard assists you through the basic steps of configuring GFI FaxMaker.
The wizard runs automatically after installation or run it manually from Start > Programs > GFI FaxMaker
> GFI FaxMaker Configuration Wizard.

1.ClickNext in the welcome screen.

2. The GFI FaxMaker Client and other Web Services API applications connect to GFI FaxMaker over HTTP
port 8555. If this port is not open, clickOK to have GFI FaxMaker automatically open these ports. You can
also open these ports manually. For more information go to: http://go.g-
fi.com/?pageid=FM19help&lang=en#cshid=FirewallPorts

NOTE
When GFI FaxMaker is installed on the Microsoft® Exchange server, skip to step 5.

http://go.gfi.com/?pageid=FM19help&lang=en#cshid=FirewallPorts
http://go.gfi.com/?pageid=FM19help&lang=en#cshid=FirewallPorts
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Screenshot 30: Setting up the sending options

3.When GFI FaxMaker is not installed on the same machine running Microsoft® Exchange, configure the
mail server options. Select how to forward faxes and SMSs to GFI FaxMaker.

Option Description

Faxes and SMS will be forwarded directly
to this machine via SMTP email, via APIs
or when using the GFI FaxMaker Client.

Select this option when using any of the following methods to send
faxes:

GFI FaxMaker Client
Web client
TextAPI, XMLAPI or Web Services API
Email such that your mail server is configured to forward all faxes

and SMSs to GFI FaxMaker via SMTP. For more information, refer to
Mail server configuration (page 15).

NOTE: Faxes & SMS cannot be sent via an SMTP mail server when GFI
FaxMaker is installed on Windows 10, 8 or 7. For more information, refer
to Installing GFI FaxMaker on Windows 10, 8 or 7 (page 63).

GFI FaxMaker will download faxes and
SMSs from a POP3 mailbox

Select option if GFI FaxMaker downloads fax/SMS from a dedicated
POP3 mailbox. For more information, refer to POP3 mailbox (page 45).
Specify the details of the dedicated POP3 mailbox.
IMPORTANT: Ensure that there are no emails in mailbox and that it is
dedicated to GFI FaxMaker only. Any emails in mailbox are downloaded
by GFI FaxMaker and permanently deleted.

ClickNext to continue.
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Screenshot 31: The wizard will prompt you for a mail server name

4. Specify mail server details where GFI FaxMaker forwards received emails.

Option Description

Mail server
name or IP
address

Enter the name or IP address of the mail server where to upload received faxes.

Use Secure
Connection

Choose this option when the mail server requires a secure connection. Choose the type of
encryption required SSL or TLS.

Use SMTP
Authentication

Instructs GFI FaxMaker to connect to the mail server using specific user credentials. Enter credentials
in the Account and password text boxes. Select Secure Password Authentication if required by the
mail server.

ClickNext to continue.

5. Specify the Country code of the country where the fax lines are connected. This is used by GFI
FaxMaker to determine the appropriate number to dial (for example, removes the country code for faxes
within the same country). ClickNext.
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Screenshot 32: Selecting the type of fax hardware to be used with GFI FaxMaker

6. Select the fax devices to use with GFI FaxMaker.

Fax
device

Description

Brooktrout
by
Dialogic

Select when using one or more Brooktrout devices or SR140 fax software. On clicking Next, click Yes to
install driver software for the device, or click No to use other drivers.

ISDN
/CAPI
devices

Select:
TE-SYSTEMS XCAPI Fax over IP - Instructs GFI FaxMaker to use the TE-SYSTEMS XCAPI Fax over

IP solution. Click Yes to install XCAPI software to integrate the system with Fax over IP or an ISDN con-
troller, or click No to use other drivers.

Other devices - Instructs GFI FaxMaker to use a device that is not TE-SYSTEMS XCAPI Fax over IP.

Fax
modems

Select to automatically detect fax modem drivers and click Next. GFI FaxMaker attempts to detect
Microsoft® Fax drivers and other modems already installed on the machine.

Fax ser-
vices

Select to use an online fax service. Click Next to enter the fax service details.

IMPORTANT
1. Ensure that devices are properly installed before proceeding.
2. For some devices, you may be prompted to configure the fax lines.
For more information go to: http://go.gfi.com/?pageid=FM19help&lang=en#cshid=FDIManual

ClickNext to continue.

7. Set up your fax lines in GFI FaxMaker. ClickConfigure lines... to launch the Add fax line tool. Use this
tool to add your fax lines. For more information, refer to Adding new fax lines (page 90).

http://go.gfi.com/?pageid=FM19help&lang=en#cshid=FDIManual
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Screenshot 33: Choosing a user directory service

8.When installing GFI FaxMaker for the first time on a server that is part of an Active Directory environment,
choose the user directory service to use. Choose Active Directory to add users from Active Directory, or
GFI Directory to install and manage users in GFI Directory. To help you choose, refer to Choosing a user
directory service. If GFI FaxMaker is NOT installed in an Active Directory environment, GFI Directory must
be used and is automatically installed by the Configuration Wizard.

9. If Active Directory is not found or if GFI Directory is chosen and installed the first time, the wizard prompts
to create the default administrator in GFI Directory. This user is added to GFI FaxMaker, set as an admin-
istrator and set as the default fax/SMS router. Key in the user details and clickNext.
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Screenshot 34: Specifying users

10. Specify the GFI FaxMaker users and administrators, depending on the user directory environment:

Environment Description

Active
Directory

GFI FaxMaker connects to Active Directory to enable you to choose users. If no fax administrators are
configured, add the administrators from the Select Users or Groups dialog and click OK.
After adding administrators, you may click Add users to add fax users, or click Next to proceed.

GFI Directory When GFI Directory is installed the first time, the user specified in step 8 is automatically set as an
administrator. Optionally you may click Add users to add more fax users. Use the Import Users tool to
add users from GFI Directory or Windows® users.
If GFI Directory was already installed before GFI FaxMaker was installed, choose the administrators
and users to add to GFI FaxMaker using the Import Users tool.

11.Wizard will now test the mail server settings. Click Test to send a test email to the configured fax admin-
istrators. ClickNext to continue.

NOTE
If the test fails, the error condition is displayed. Use the error to troubleshoot and resolve issues. For
more information, refer to Email2FaxGateway test fails (page 203).

12.GFI FaxMaker now starts the services. ClickNext to continue.

13.Click Finish.

4.3 Upgrading GFI FaxMaker
Choose your current GFI FaxMaker version for notes and instructions on how to upgrade to the latest
version while retaining all settings:
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GFI FaxMaker 19.1 or later

GFI FaxMaker 19

GFI FaxMaker 2015

GFI FaxMaker 2013 & 2014

To determine your current version number open the GFI FaxMaker Configuration and navigate toGeneral
> Version Information > Properties.

4.3.1 Upgrading from version 19.1 or later
This section describes how to upgrade a GFI FaxMaker 19.1 or later installation to the latest version while
retaining all settings.

Important notes when upgrading

Upgrade is not reversible; you cannot downgrade to the last version.

GFI FaxMaker 20 works with a subscription model, where after the subscription expiration the product
stops sending faxes and SMS. A renewal of the subscription is required to resume the service.

GFI FaxMaker 19.2 and later only support 64-bit installations. It is not possible to upgrade over a 32-bit
instance and a new installation in a supported environment is required. For more information, refer to How
tomove your GFI FaxMaker installation to a different server (page 177).

Backup the GFI FaxMaker configuration before upgrade. For more information, refer to How to backup
GFI FaxMaker settings (page 181). The backup may be useful to revert configuration when upgrade fails.

During upgrade, GFI FaxMaker services and operations are stopped. Ensure that there are no faxes in
queue as these are permanently lost during upgrade.

Check that you are installing GFI FaxMaker on the machine that meets the system and hardware require-
ments.

Log on as Administrator or use an account with administrative privileges.

GFI FaxMaker 19.2 and later offers two types of licensing services:

Using the GFI Account credentials. The username and password are retrieved fromGFI
Accounts and assigned to the user at the moment of the registration of the account.

Using a license key. When upgrading to a newmajor release you also need to upgrade your
license key.

Save any pending work and close all open applications on the machine.

Disable anti-virus software on the server machine during the upgrade. Re-enable it once upgrade is com-
plete.

Upgrade procedure

1.Download the latest build of GFI FaxMaker. Go to https://www.gfi.com/products-and-solutions/email-
and-messaging-solutions/gfi-faxmaker/download

2.Right-click the newly downloaded installer and choose Properties. From theGeneral tab, clickUnblock
and then Apply. This step is required to prevent the operating system from blocking certain actions by the
installer.

3. Launch the newly downloaded installer on the server where GFI FaxMaker is currently installed. You are
notified that an older version of GFI FaxMaker already exists. Click Yes to uninstall it.

4.When uninstall is complete, follow on-screen instructions to install the latest version.

https://accounts.gfi.com/
https://accounts.gfi.com/
https://www.gfi.com/products-and-solutions/email-and-messaging-solutions/gfi-faxmaker/download
https://www.gfi.com/products-and-solutions/email-and-messaging-solutions/gfi-faxmaker/download
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5. Enter your GFI Account credentials or upgrade your license key and key in the new key. If you do not
have your license key at hand, you can get it from theGFI Customer Area.

6.When installation is complete, the setup automatically launches the GFI FaxMaker Configuration Wizard
to restart the GFI FaxMaker services.

7.When using a Brooktrout TR1034 fax board, open the Brooktrout Configuration Tool to verify settings.
Save and close. A restart of services may be required.

8.Go to the GFI FaxMaker Monitor and ensure that fax lines are present and initialized. If you encounter
problems, refer to http://go.gfi.com/?pageid=FM_LineInitialize.

9. Test the functionality of GFI FaxMaker by sending and receiving a test fax. For more information, refer to
Testing your installation (page 64).

4.3.2 Upgrading from version 19
This section describes how to upgrade a GFI FaxMaker 19 installation to the latest version while retaining all
settings.

Important notes when upgrading

Upgrade is not reversible; you cannot downgrade to the last version.

GFI FaxMaker 20 works with a subscription model, where after the subscription expiration the product
stops sending faxes and SMS. A renewal of the subscription is required to resume the service.

GFI FaxMaker 19.2 and later only support 64-bit installations. It is not possible to upgrade over a 32-bit
instance and a new installation in a supported environment is required. For more information, refer to How
tomove your GFI FaxMaker installation to a different server (page 177).

Backup the GFI FaxMaker configuration before upgrade. For more information, refer to How to backup
GFI FaxMaker settings (page 181). The backup may be useful to revert configuration when upgrade fails.

During upgrade, GFI FaxMaker services and operations are stopped. Ensure that there are no faxes in
queue as these are permanently lost during upgrade.

Check that you are installing GFI FaxMaker on the machine that meets the system and hardware require-
ments.

Log on as Administrator or use an account with administrative privileges.

GFI FaxMaker 19.2 and later offers two types of licensing services:

Using the GFI Account credentials. The username and password are retrieved fromGFI
Accounts and assigned to the user at the moment of the registration of the account.

Using a license key. When upgrading to a newmajor release you also need to upgrade your
license key.

Save any pending work and close all open applications on the machine.

Disable anti-virus software on the server machine during the upgrade. Re-enable it once upgrade is com-
plete.

Upgrade procedure

1.Download the latest build of GFI FaxMaker. Go to https://www.gfi.com/products-and-solutions/email-
and-messaging-solutions/gfi-faxmaker/download

2.Right-click the newly downloaded installer and choose Properties. From theGeneral tab, clickUnblock
and then Apply. This step is required to prevent the operating system from blocking certain actions by the
installer.

http://go.gfi.com/?pageid=gen_UpgradeKey
https://customers.gfi.com/products/default.aspx
http://go.gfi.com/?pageid=FM_LineInitialize
https://accounts.gfi.com/
https://accounts.gfi.com/
https://www.gfi.com/products-and-solutions/email-and-messaging-solutions/gfi-faxmaker/download
https://www.gfi.com/products-and-solutions/email-and-messaging-solutions/gfi-faxmaker/download
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3. Launch the newly downloaded installer on the server where GFI FaxMaker is currently installed. You are
notified that an older version of GFI FaxMaker already exists. Click Yes to uninstall it.

4.When uninstall is complete, follow on-screen instructions to install the latest version.

5. Enter your GFI Account credentials or upgrade your license key and key in the new key. If you do not
have your license key at hand, you can get it from theGFI Customer Area.

6.When installation is complete, the setup automatically launches the GFI FaxMaker Configuration Wizard
to restart the GFI FaxMaker services.

7.When using a Brooktrout TR1034 fax board, open the Brooktrout Configuration Tool to verify settings.
Save and close. A restart of services may be required.

8.Go to the GFI FaxMaker Monitor and ensure that fax lines are present and initialized. If you encounter
problems, refer to http://go.gfi.com/?pageid=FM_LineInitialize.

9. Test the functionality of GFI FaxMaker by sending and receiving a test fax. For more information, refer to
Testing your installation (page 64).

4.3.3 Upgrading from version 2015
This section describes how to upgrade a GFI FaxMaker 2015 installation to the latest version while retaining
all settings.

Important notes when upgrading

Upgrade is not reversible; you cannot downgrade to the last version.

GFI FaxMaker 20 works with a subscription model, where after the subscription expiration the product
stops sending faxes and SMS. A renewal of the subscription is required to resume the service.

GFI FaxMaker 19.2 and later only support 64-bit installations. It is not possible to upgrade over a 32-bit
instance and a new installation in a supported environment is required. For more information, refer to How
tomove your GFI FaxMaker installation to a different server (page 177).

Backup the GFI FaxMaker configuration before upgrade. For more information, refer to How to backup
GFI FaxMaker settings (page 181). The backup may be useful to revert configuration when upgrade fails.

Log in to theGFI Customer Area to get a new license key. Click the blue key icon on the right and select
Upgrade License Key, or clickRenewal to extend your maintenance agreement.

During upgrade, GFI FaxMaker services and operations are stopped. Ensure that there are no faxes in
queue as these are permanently lost during upgrade.

Check that you are installing GFI FaxMaker on the machine that meets the system and hardware require-
ments.

Log on as Administrator or use an account with administrative privileges.

GFI FaxMaker 19.2 and later offers two types of licensing services:

Using the GFI Account credentials. The username and password are retrieved fromGFI
Accounts and assigned to the user at the moment of the registration of the account.

Using a license key. When upgrading to a newmajor release you also need to upgrade your
license key.

Save any pending work and close all open applications on the machine.

Disable anti-virus software on the server machine during the upgrade. Re-enable it once upgrade is com-
plete.

http://go.gfi.com/?pageid=gen_UpgradeKey
https://customers.gfi.com/products/default.aspx
http://go.gfi.com/?pageid=FM_LineInitialize
https://customers.gfi.com/products/default.aspx
https://accounts.gfi.com/
https://accounts.gfi.com/
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Upgrade procedure

1.Download the latest build of GFI FaxMaker. Go to https://www.gfi.com/products-and-solutions/email-
and-messaging-solutions/gfi-faxmaker/download

2.Right-click the newly downloaded installer and choose Properties. From theGeneral tab, clickUnblock
and then Apply. This step is required to prevent the operating system from blocking certain actions by the
installer.

3. Launch the newly downloaded installer on the server where GFI FaxMaker is currently installed. You are
notified that an older version of GFI FaxMaker already exists. Click Yes to uninstall it.

4.When uninstall is complete, follow on-screen instructions to install the latest version.

5.Use the license key obtained from theGFI Customer Area.

6.When installation is complete, the setup automatically launches the GFI FaxMaker Configuration Wizard
to restart the GFI FaxMaker services.

7.When using a Brooktrout TR1034 fax board, open the Brooktrout Configuration Tool to verify settings.
Save and close. A restart of services may be required.

8.Go to the GFI FaxMaker Monitor and ensure that fax lines are present and initialized. If you encounter
problems, refer to http://go.gfi.com/?pageid=FM_LineInitialize.

9. Test the functionality of GFI FaxMaker by sending and receiving a test fax. For more information, refer to
Testing your installation (page 64).

4.3.4 Upgrading from version 2013/2014
This section describes how to upgrade a GFI FaxMaker 2013/2014 installation to the latest version while
retaining all settings.

NOTE
Direct upgrades from version 2011 or earlier versions are not supported and it is recommended to
uninstall and reconfigure GFI FaxMaker.

Important notes when upgrading

Upgrade is not reversible; you cannot downgrade to the last version.

GFI FaxMaker 20 works with a subscription model, where after the subscription expiration the product
stops sending faxes and SMS. A renewal of the subscription is required to resume the service.

GFI FaxMaker 19.2 and later only support 64-bit installations. It is not possible to upgrade over a 32-bit
instance and a new installation in a supported environment is required. For more information, refer to How
tomove your GFI FaxMaker installation to a different server (page 177).

Backup the GFI FaxMaker configuration before upgrade. For more information, refer to How to backup
GFI FaxMaker settings (page 181). The backup may be useful to revert configuration when upgrade fails.

Log in to theGFI Customer Area to get a new license key. Click the blue key icon on the right and select
Upgrade License Key, or clickRenewal to extend your maintenance agreement.

GFI FaxMaker 2015 introduces GFI Directory as a new user management system when Active Directory
is not available. When upgrading over an installation without Active Directory, run the Configuration Wizard
after the installation to automatically install and import all users to GFI Directory.

When upgrading over an installation that uses a Microsoft Access archive database, GFI FaxMaker
migrates archive data to a Firebird database. When using a Microsoft® SQL/MSDE database, GFI

https://www.gfi.com/products-and-solutions/email-and-messaging-solutions/gfi-faxmaker/download
https://www.gfi.com/products-and-solutions/email-and-messaging-solutions/gfi-faxmaker/download
https://customers.gfi.com/products/default.aspx
http://go.gfi.com/?pageid=FM_LineInitialize
https://customers.gfi.com/products/default.aspx


GFI FaxMaker 4 Installing GFI FaxMaker for the first time | 62

FaxMaker upgrades the database schema. These database changes are automatically done in the back-
ground separate from the installation. It is recommended to take a backup of the database before starting
the upgrade. This backup may be useful to re-import the database if upgrade fails.

During upgrade, GFI FaxMaker services and operations are stopped. Ensure that there are no faxes in
queue as these are permanently lost during upgrade.

Check that you are installing GFI FaxMaker on the machine that meets the system and hardware require-
ments.

Log on as Administrator or use an account with administrative privileges.

GFI FaxMaker 19.2 and later offers two types of licensing services:

Using the GFI Account credentials. The username and password are retrieved fromGFI
Accounts and assigned to the user at the moment of the registration of the account.

Using a license key. When upgrading to a newmajor release you also need to upgrade your
license key.

Save any pending work and close all open applications on the machine.

Disable anti-virus software on the server machine during the upgrade. Re-enable it once upgrade is com-
plete.

Upgrade procedure

1.Download the latest build of GFI FaxMaker. Go to https://www.gfi.com/products-and-solutions/email-
and-messaging-solutions/gfi-faxmaker/download

2.Right-click the newly downloaded installer and choose Properties. From theGeneral tab, clickUnblock
and then Apply. This step is required to prevent the operating system from blocking certain actions by the
installer.

3. Launch the newly downloaded installer on the server where GFI FaxMaker is currently installed. You are
notified that an older version of GFI FaxMaker already exists. Click Yes to uninstall it.

4.When uninstall is complete, follow on-screen instructions to install the latest version.

5.Use the license key obtained from theGFI Customer Area.

6.When installation is complete, the setup automatically launches the GFI FaxMaker Configuration Wizard
to restart the GFI FaxMaker services.

7.When using a Brooktrout TR1034 fax board, open the Brooktrout Configuration Tool to verify settings.
Save and close. A restart of services may be required.

8.Go to the GFI FaxMaker Monitor and ensure that fax lines are present and initialized. If you encounter
problems, refer to http://go.gfi.com/?pageid=FM_LineInitialize.

9. Test the functionality of GFI FaxMaker by sending and receiving a test fax. For more information, refer to
Testing your installation (page 64).

4.4 Choosing a user directory service
GFI FaxMaker can get users and groups from one of two supported user directory services, Active Directory
and GFI Directory.

https://accounts.gfi.com/
https://accounts.gfi.com/
https://www.gfi.com/products-and-solutions/email-and-messaging-solutions/gfi-faxmaker/download
https://www.gfi.com/products-and-solutions/email-and-messaging-solutions/gfi-faxmaker/download
https://customers.gfi.com/products/default.aspx
http://go.gfi.com/?pageid=FM_LineInitialize
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NOTES:

1. If GFI FaxMaker server is not connected to a domain, Active Directory cannot be used as a user dir-
ectory service and GFI Directory is required.

2. Evaluate your preferred service before installation since the directory chosen cannot be changed
after installation.

Refer to the sections below for information on when and how to use these services.

GFI Directory

GFI Directory is a directory of users and groups that integrates with GFI FaxMaker and other GFI products.

If this user directory service is chosen, GFI FaxMaker automatically installs and configures GFI Directory on
the server during the Configuration Wizard. If GFI Directory is already installed on the machine where you
are installing GFI FaxMaker, for example when another GFI product is utilizing this service, GFI FaxMaker
setup automatically connects to the local GFI Directory service.

Users and groups can be automatically created and managed from the Licensed Users node of GFI
FaxMaker. On user creation, use theWelcome email feature to send an email to users, containing a link to
set their account password. This is required to authenticate to GFI FaxMaker, for example, when logging in
to the web console or when sending faxes using the GFI FaxMaker Client.

GFI Directory can also be managed separately from GFI FaxMaker, in its own web-based management
console. In a web browser, go to:

http://[server name/IP]/GFIDirectory

For example, http://myfaxserver.mydomain.com/GFIDirectory

For more information about GFI Directory refer to: http://go.gfi.com/?pageid=DIR_Help_En

Active Directory

GFI FaxMaker server can get use the directory services of Active Directory when it is connected to a
domain.

Administrators can grant fax and SMS access to Active Directory users and groups. Administrators and
users authenticate to GFI FaxMaker using their Active Directory credentials, for example, when logging in to
the web console or when sending faxes using the GFI FaxMaker Client.

It is recommended to use Active Directory when it is available so that user management is done from a
central location. No additional configuration is required when using this service.

4.5 Installing GFI FaxMaker on Windows 10, 8 or 7
Microsoft®Windows® 10, 8 (including 8.1) and 7 do not include the Microsoft® IIS SMTP server that is used
when the mail server routes fax/SMS emails to GFI FaxMaker.

Consequently when installing GFI FaxMaker on these operating systems, faxes and SMS cannot be sent via
email using the domains @faxmaker.com and @smsmaker.com.

There are two main methods of sending faxes/SMS that can be used instead:

Sending faxes via web client - users login to GFI FaxMaker using a web browser and compose faxes
using the web client.

Use email via a POP3mailbox - Users send fax/SMS emails to a dedicated POP3 mailbox. GFI
FaxMaker picks up the emails from this mailbox and prepares the content for transmission. This method is

http://go.gfi.com/?pageid=DIR_Help_En
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more difficult to use since it requires TextAPI parameters to be included in the email body when composing
fax/SMS emails. For more information, refer to Sending faxes/SMS via a POP3Mailbox (page 105).

Alternatively when installing GFI FaxMaker on Windows 10, 8 or 7, you may use other methods to send
faxes and SMS. These methods do not require the IIS SMTP service:

Sending faxes via web client

Printing content to GFI FaxMaker - NetPrintQueue2Fax

Via API

4.6 Testing your installation
Follow the steps in this topic to ensure that your GFI FaxMaker installation is processing sent and received
faxes successfully.

4.6.1 Send a test fax
1. From the email client of a user listed as a Licensed user, create an email, in the following format:

Field Configuration

To Enter recipient in the following format number@faxmaker.com. Replace number with the recipient’s fax
number. For example, 12345678@faxmaker.com.
NOTE: The default fax (faxmaker.com) and SMS (smsmaker.com) domains can be customized by the
GFI FaxMaker administrator. Use the configured fax domain.For more information, refer to Fax and SMS
domain names (page 105).

Subject Key in Test fax.

Email body Key in some text.

Attachment Attach a one page PDF document containing some test content, such as text and graphics.

2.Click Send.

3. View the outgoing fax status from theGFI FaxMaker Monitor.

4. Ensure that the sender receives a transmission report for the sent fax, to confirm that GFI FaxMaker can
send notifications over the configuredmail server.

5.Confirm that the fax is received by the recipient and confirm that all settings, such as coverpage and head-
ers/footers, are applied.

4.6.2 Receiving a test fax
1. From a test fax line, send a fax to a fax line connected and configured in GFI FaxMaker.

2. View the incoming fax status fromGFI FaxMaker Monitor.

3. The fax should be routed depending on the configured Routing rules. If no routing rule is matched or
routing rules are not configured, the fax is routed to a Default Router. The fax should also be routed to users
configured to receive all faxes.
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5 Using GFI FaxMaker
This topic contains information about:
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5.5.1 Generating reports 83
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5.5.4 Exporting activity data to a CSV 87

5.1 How users send faxes
There are various ways how users can send faxes:

Fax method Description

Web client Access the GFI FaxMaker web interface from a supported web browser and compose faxes
from the web client. For more information, refer to Sending faxes via web client (page 67).

Email Users can send faxes directly from their favorite email client, such as Microsoft® Outlook®.
Address the email to faxnumber@faxmaker.com, where faxnumber is replaced by the
recipient’s fax number. The email body gets added to the coverpage and add any attachments
to transmit via fax.
For more information, refer to Sending faxes via email (page 66).
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Fax method Description

NetPrintQueue2Fax To send faxes, users print content to the NetPrintQueue2Fax printer driver. The fax recipient
number is keyed in within the document in a customizable format, for example Fax:
12345678.
This enables fax sending in any format that allows printing of content (without installing
application on GFI FaxMaker machine).
For more information, refer to NetPrintQueue2FAX (page 153).

APIs Use third-party tools to automatically generate APIs containing the information about the faxes
to send and automate the fax sending process.
Store TextAPIs or XMLAPIs to a central location and GFI FaxMaker automatically processes
files located in this folder.
Or use Visual Studio to develop Web Service APIs which you can use to automatically send
and receive faxes.
For more information, refer to GFI FaxMaker APIs (page 157).

5.1.1 Sending faxes via email
Licensed users can send faxes directly from their email client:

Use the Microsoft®Outlook® address book for recipients that have a fax number configured. Address
the email to [FAX:faxnumber], where faxnumber is replaced by the Outlook® contact’s fax number.

Address an email to faxnumber@faxmaker.com, where faxnumber is replaced by the recipient’s
fax number. For example: +441273123456@faxmaker.com

The same fax can also be sent to multiple fax numbers, using the same format for each and separated
with a semi-colon (;). For example: +441273123456@faxmaker.com; +420313414515@-
faxmaker.com;

NOTE
The default fax (faxmaker.com) and SMS (smsmaker.com) domains can be customized by the GFI
FaxMaker administrator. Use the configured fax domain accordingly.

The first page of the fax contains the recipient’s name, sender’s name, email subject and email body. If the
email includes attachments, these are included in subsequent pages of the fax.
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Screenshot 35: Sending a fax using the email client

This method is available for all email users, with no installation of other software or custom configurations
required.

To use this method:

Add the users allowed to send fax in the Licensed Users list. For more information, refer to Licensed
users (page 98).

Configure mail servers to forward emails addressed to *@faxmaker.com, *@smsmaker.com,
Fax:* and SMS:* (or your custom domains) to GFI FaxMaker. For more information, refer to Mail server
configuration (page 15).

NOTE
This method is only applicable when routing emails via SMTP. This is not applicable when using the GFI
FaxMaker POP3 Downloader to poll faxes from a POP3 Mailbox. For more information, refer to Sending
faxes/SMS via a POP3Mailbox (page 105).

5.1.2 Sending faxes via web client
Licensed users can send faxes by accessing the GFI FaxMaker web client from a supported web browser.
This method is available for all GFI FaxMaker users, with no additional software on users’ machines.
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To access the web client, login to the GFI FaxMaker web console and click the Client tab. From the left
pane, clickCompose under Fax.

Screenshot 36: Sending a fax using the GFI FaxMaker web client

To send a fax, fill in the fax message form as follows:

Fax para-
meter

Description

Subject Key in a fax subject in the Enter message subject field.

Recipients Enter the numbers of all the recipients to receive the fax. Separate multiple recipients using a comma
',' or a semi-colon ';'. Click To... to load the address book and select recipients from the address book.
For more information, refer to Web client address book (page 74).

Message
body

Key in a fax body that will be displayed in the fax coverpage.
Your personal signature is automatically displayed in the bottom. For more information, refer to Web
Client settings and personal preferences (page 69).



GFI FaxMaker 5 UsingGFI FaxMaker | 69

Fax para-
meter

Description

Attachments Drag and drop files to fax in the message body area, or click Add attachment to select files to fax.
In case of multiple attachments, GFI FaxMaker faxes attachments in the order shown. To arrange the
order of how attachments are faxed, drag and drop attachments to sort in the order required.
Default file formats
File formats supported by the GFI FaxMaker web client:

Plain text: .txt
Rich text: .rtf
Portable document: .pdf
Images: .gif, .jpeg, .jpg, .fax, .tif, .tiff
MIME HTML: .mht
Microsoft Word: .doc, .docx
Microsoft Excel: .xls, .xlsx
Microsoft PowerPoint: .ppt, .pptx
Microsoft Visio: .vsd, .vsdx

NOTE: A licensed version of Microsoft® Office® is required on the GFI FaxMaker server to convert
Microsoft® Office® file formats.
Other file formats
Use the Web Printer to send other file formats that are not supported by default by GFI FaxMaker. The
Web Printer converts files on clients machines. For more information, refer to Web Client Printer Driver
(page 72).

Priority Select the priority of the fax. When there are multiple faxes to be sent by GFI FaxMaker, faxes with
higher priority get faxed first, while faxes with lower priority get faxed after the other faxes.

Resolution The quality of the fax image. High resolution (fine) faxes have better quality but take longer to get faxed
than normal resolution.

Delivery Choose whether to deliver the fax immediately or send it at a particular date and time.
NOTE: The actual transmission process may be different than configured depending on the number of
faxes in the GFI FaxMaker queue and when a fax line is available.

Web Client settings and personal preferences

Personal client settings are applied by default on all messages composed in the web client. From the top
menu bar, click to open the settings screen and selectClient from the left pane.

Screenshot 37: Configuring web client references

Configure the following web client options:
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Fax para-
meter

Description

Signature Compose your signature. This text is automatically added to the fax message body.

Resolution Configure the default quality of fax images. High resolution (fine) faxes have better quality but take
longer to get faxed than normal resolution.
This setting can be overridden when composing a fax.

Coverpage Choose whether to add a coverpage to your fax messages.
If adding a coverpage, choose the coverpage to add:

Default: your default coverpage is added to fax messages as configured by your GFI FaxMaker
administrator.

Custom: key in the name of a custom coverpage as configured in GFI FaxMaker. Contact your admin-
istrator for a list of coverpages available.

Billing
code

If applicable, enter your billing code as instructed by your GFI FaxMaker administrator. Leave this field
empty if a billing code is not required by your organization.

NOTE
These settings are applied only when sending faxes from the web client and not when sending faxes
using other methods.

5.1.3 Resending a fax
When GFI FaxMaker sends out a fax, an email is sent to the sender containing important fax job information
- a transmission report. If a fax fails or you wish to forward the same fax to a different recipient, use the
transmission report to resend the fax.

To resend a fax to the original recipient, reply to the transmission report and do not change any of the email
fields. GFI FaxMaker does not include the transmission report in the fax, but re-sends the original fax
message.

To resend the fax to a different recipient, reply to the transmission report, changing the To field to the new
recipient's fax number, in this format: <faxnumber>@faxmaker.com. For example,
+420313414515@faxmaker.com. Do not change any other message field and click Send. GFI
FaxMaker re-sends the original fax content, updating recipient-related coverpage fields to match those of
the new recipient.

Important notes:

1. The subject field of the transmission report contains a ::resend API command and a job ID that enable
GFI FaxMaker to find the original fax job when resending a fax. If these details are modified, GFI FaxMaker
will not be able to identify the fax to be resent, resulting either in an error or sends out a fax containing the
transmission report.

2. By default, GFI FaxMaker stores sent faxes for 2 days and failed faxes for 1 week. Users cannot resend
faxes after these periods.

3. The administrator may disable fax resending by not storing faxes. For more information, refer to Storing
faxes (page 123).

4. The default fax (faxmaker.com) and SMS (smsmaker.com) domains can be customized by the GFI
FaxMaker administrator. Use the configured fax domain accordingly.
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5.2 How users view received faxes
Received faxes are forwarded to the user via email. The email will contain a fax report and the fax file
included with the email as an attachment. Faxes can be attached in several formats, such as PDF.

Configure routing options for GFI FaxMaker to route received faxes to the correct recipient. For more
information, refer to Fax routing (page 162).

Screenshot 38: Email notification confirming receipt of a new fax

Received faxes can also be automatically printed and/or stored to a folder on disk.

NOTE
If a received fax is to be routed to a Web API user, the fax does not get delivered to the user via email,
but must be picked up using the Web Service API.
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5.3 Logging in to the GFI FaxMaker web interface
GFI FaxMaker users can log in to the web interface to access the web client to send faxes and SMS.
Administrators can use the web interface to generate reports and monitor GFI FaxMaker operation.

To access the GFI FaxMaker interface from your browser, key in the following URL:

http://<GFI FaxMaker host name>/FaxMaker

For example: http://myfax.mydomain.com/FaxMaker

Key in your credentials to login to GFI FaxMaker depending on the user mode:

Active Directory: Key in your Active Directory username and password. Typically these are the same
credentials used to login to Windows®.

GFI Directory:When GFI FaxMaker is installed in GFI Directory mode, key in your GFI Directory cre-
dentials. Ensure that users are assigned a GFI Directory password to be able to authenticate and login to
the web interface. If users do not have a password, send them aWelcome email that enables them to set a
password. From the Licensed Users configuration screen, select the users or groups to send the Welcome
email to and click Send welcome instructions.

NOTE
Only licensed users can login to the web interface. Ensure that all users allowed to access the web client
are added to the GFI FaxMaker Licensed Users screen. For more information, refer to Licensed users
(page 98).

For information on how to use the web interface, refer to the following topics:

Sending faxes via web client

Sending SMS via web client

Using theWeb Printer to send faxes via web client

Monitoring operation

Monitoring system notifications

Working with reports

Configuring system updates

Changing the web interface language

Resetting the user password

Enforcing SSL

5.3.1 Web Client Printer Driver
The GFI FaxMaker Web Client Printer enables users to print documents on their machines before sending
the fax using the Web Client. This ensures that file conversion processing on the GFI FaxMaker server is
minimized. This also enables users to use native applications to print documents which cannot be converted
on the GFI FaxMaker server. For example, users that have Adobe InDesign installed on their machines, can
fax Adobe InDesign documents by printing documents to the GFI FaxMaker Web Printer.

How the Web Printer works

Install the Web Printer driver on client machine. To send a fax using the Web Printer:
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1. Print a document or file to the Web Printer, named FAXmaker.

2.On completion, the printed content is uploaded to GFI FaxMaker and the GFI FaxMaker web interface is
automatically loaded in a new browser window.

3. Log in to the GFI FaxMaker web interface in the automatically loaded window.

4. The Client is automatically launched with the printed document pre-populated in the attachments area.
The attachment name is PreUploaded File.

5. Proceed to fill in the message form and hit Send to transmit the fax.

Installing the Web Printer

NOTE
The Web Printer cannot be installed on a machine where the GFI FaxMaker Client is already installed.

To download and install the Web Printer:

1. Login to the GFI FaxMaker Web Interface.

2. From the top menu bar, click to open the settings screen and selectClient from the left pane.

3.UnderWeb Printer Installer, read the terms and conditions, and if you agree choose I agree with the
Web Printer Terms and Conditions. The Web Printer cannot be downloaded if you do not accept the
terms and conditions.

4.ClickDownload to start the download.

5.On download completion launch the installer.

6. Key in theGFI FaxMaker Server URL. This value is the same as the addressed used to access the web
interface login page. For example, https://fax.mydomain.com/FaxMaker. Click Test to verify.

7.Click Install to start installation.

8.Click Finish on install completion.

A new printer FAXmaker is now added to your list of printer devices.

5.3.2 User's web profile settings

Changing the GFI FaxMaker web interface language

To change the language of the GFI FaxMaker web interface:

1. From the top menu bar, hover over the profile icon and click Profile.

2. In the Display language area, choose your preferred language and click Save.

Resetting the password

To change your web interface login password:

1. From the top menu bar, hover over the profile icon and click Profile.

2. In the Reset Password area, clickChange Password.

3. Key in your current password, your new password and re-confirm your new password.

4.Click Save password.
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NOTE
This option is not available when using your domain credentials (Active Directory) to login to GFI
FaxMaker.

5.3.3 Web client address book
The GFI FaxMaker web client address book enables you to store and manage lists of recipients, contact
details and their particulars. Contacts in the address book may be shared with all GFI FaxMaker users or
stored as private, accessible only by the user who created the contact. When GFI FaxMaker is installed in a
Microsoft Exchange environment, the address book may also retrieve the user account's personal contacts.

When composing a fax or SMS, click To next to the field where recipients are specified, to load the address
book.

Screenshot 39: Web client address book

Choose the actions to do in the web client address book:

Choose fax/SMS recipients

Open the address book and choose fax or SMS recipients.

The displayed list of recipients includes:

All personal contacts that were added by the user.

Contacts added by other users that were set as public.
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List of personal contacts from the user's Microsoft Exchange account. These are available only in
Microsoft Exchange environments when GFI FaxMaker has access to the user's personal contacts list.

Use the Search bar to find particular contacts using their name, surname, fax or mobile numbers.

Click Add recipients to close the address book and add the selected contacts to the fax/SMS recipients box.

Adding new contacts

1. To create a contact, clickNew contact.

2.Choose whether to make the contact accessible by all GFI FaxMaker users . Choose Private to make the
contact accessible only to yourself or Public to allow all GFI FaxMaker to use the contact. Contacts that are
made public can only be modified or deleted by the user creating the contact or by GFI FaxMaker admin-
istrators. Other users cannot delete or modify public contacts.

3. Specify the contact's personal and contact details. These details are used to populate fields in the cov-
erpage. For example if the coverpage includes a recipient's company field, this gets automatically pop-
ulated by the company name specified. The First name and a Fax orMobile numbers are required. All
other details are optional.

4.Click Save contact to add the new contact to the address book.

Changing contact details

Click on a contact to launch the contact's details. Apply the required changes and clickUpdate contact.

Contact details can only be changed by the user that created the contact or by GFI FaxMaker
administrators. Other users can only view the contact details. Microsoft Exchange contacts cannot be
modified from GFI FaxMaker.

Delete one or more contacts

Choose the contacts to delete and clickDelete Contact. ClickOK to confirm deletion.

A contact can only be deleted by the user that created it or by GFI FaxMaker administrators. Microsoft
Exchange contacts cannot be deleted from GFI FaxMaker.

IMPORTANT
Deleted contacts are permanently removed and cannot be recovered after deletion.

5.3.4 Monitoring GFI FaxMaker updates
Monitor and configure howGFI FaxMaker downloads and installs updates issued by GFI Software.

1. Log in to the GFI FaxMaker web interface and from the top menu bar, click Settings .

2. From the left pane choose Updates.
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Screenshot 40: Updates settings

3.Configure the following options:

Option Description

Platform
Updates

Displays a list of pending and installed updates for the GFI FaxMaker server. Click any entry in the list
to view additional information. Click Check to verify if any new updates are available.

Auto
updates

Choose whether to automatically install updates when these are available.
If enabling this setting, specify a schedule for when to install updates. It is recommended to install
updates at off-peak hours.
Check Apply major platform updates immediately to immediately install important updates as soon as
these are available.

Notifications Enable this option to receive email notifications when updates are available or installed. When
enabling, you can check any of the following options:

New updates are available - to send email notifications whenever GFI FaxMaker finds new
updates.

Platform update was successfully installed - to send email notifications whenever updates are suc-
cessfully installed. Note that GFI FaxMaker always sends a notification when an update fails to install.

Notify all administrators - to notify all fax administrators about the updates. Un-check this option to
manually enter a list of email addresses that will receive these notifications.

4.Click Save to apply changes.

5.3.5 Server notifications
In the notifications area you can view system events generated by GFI FaxMaker services. Use the
notifications to monitor the functionality and operation of GFI FaxMaker.

To access the notifications, from the top navigation menu of the GFI FaxMaker web interface, click .
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Screenshot 41: The Notifications area

Perform the following actions:

Action Description

Filter events
by type

Use the menu on the left to filter notifications by type. Available filters: All, Info, Warning or Error. When
a type is chosen, only events matching the selected type are shown in the main viewing pane.

Search and
filter events

Use the Search for and Filter sources fields to locate specific events.

View addi-
tional inform-
ation

Click any notification icon to view detailed information about the event.

5.3.6 Securing Access to the web interface with SSL
You can use HTTPS certificates to secure access to the web interface of GFI FaxMaker. Configure IIS to use
HTTPS to provide a secure connection when network users access the GFI FaxMaker web interface.

This feature is especially recommended when the GFI FaxMaker web interface is accessed from external
networks so that all communications are encrypted.

To enable HTTPS for the GFI FaxMaker web interface:

Step 1: Configure an HTTPS certificate

Configure your IIS web server to use a certificate.

To create or import a certificate:

1.Open Internet Information Services (IIS) Manager.

2. Select Server.

3. In the left pane, under IIS click Server Certificates.

4.Under Action, you can import an existing certificate or create a self-signed certificate.
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NOTE
The certificate created or imported in IIS needs to be distributed to the machines from where the GFI
FaxMaker web interface needs to be accessed.

Step 2: Configure HTTPS binding

Ensure that HTTPS bindings is enabled for the web server hosting the GFI FaxMaker web site:

1.Open Internet Information Services (IIS) Manager.

2.Go to Server > Sites.

3.Right-click on Default Web Site and select Edit Bindings.

4.Click Add... and selectHTTPS.

5. The default port is set to 443. If another port needs to be used it can be changed here.

6.Under SSL certificate, select the certificate imported or created in the previous step.

7.ClickOK twice.

8.ClickClose to complete the process.

Step 3: Enforce the use of SSL

Enforce the use of SSL to ensure that HTTPS is required for users to access the GFI FaxMaker web
interface:

1.Open Internet Information Services (IIS) Manager.

2.Go to Server > Sites > Default Web Site.

3. Select the GFI FaxMaker virtual directory. (Default is Faxmaker.)

4. In the left pane, under IIS click SSL Settings.

5. SelectRequire SSL.

6. In the Client Certificate options, selectRequire.

7.Click Apply.

After completing the steps above on your favorite browser access https://servername/Faxmaker.
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5.4 Monitoring GFI FaxMaker operation

Screenshot 42: The GFI FaxMaker web monitor

Use theGFI FaxMaker Monitor to track and manage GFI FaxMaker fax and SMS transmission and queue
operations.

To access the Monitor, login to the GFI FaxMaker web console and click the required dashboard from the
Monitor tab in the top menu bar.

NOTE
Only fax administrators have access to the Monitor. For more information, refer to Fax administrators
(page 101).

Use the following topics for information on how to use the GFI FaxMaker Monitor:

5.4.1 Monitoring Fax Lines 79

5.4.2 Monitoring Faxes in Queue 80

5.4.3 Monitoring SMSDevices and Queue 81

5.4.1 Monitoring Fax Lines
Use the GFI FaxMaker Monitor to track the activity of fax lines and devices in real-time. The Fax Lines
dashboard displays all the configured fax devices and their current transmission state.

To access the Monitor, login to the GFI FaxMaker web console and click the required dashboard from the
Monitor tab in the top menu bar.

NOTE
Only fax administrators have access to the Monitor. For more information, refer to Fax administrators
(page 101).
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Screenshot 43: Monitoring Fax Lines

Use the left pane on the dashboard, to filter fax lines by their current status.

Administrators can also take various actions to manage fax lines:

Action Description

Change Refresh Rate Set the time interval to refresh the data on the fax lines page.

Restart Server Click to restart the GFI FaxMaker Fax Server service. Restarting the service
is useful when encountering issues with fax lines or fax transmission. This
service also requires a restart when applying changes to the faxing medium
of choice (for example, after applying changes to the XCAPI configuration).

Initialize Fax Lines On the left pane, click Uninitialized tab and locate the fax devices to ini-
tialize. This action is available for certain types of lines only.

Halt Fax Progress To terminate the fax transmission on a particular line, click in the Trans-
mission Status column of that fax device. Click OK to confirm.

The Fax Lines monitor also displays information on:

Feature Description

Out of queue The number of faxes still pending to be processed and added in queue for transmission.

Converter Displays the current activity of email to fax converter.

Latest File The latest attachment processed by the fax service.

Refresh Rate The time interval configured to refresh the content on the page.

5.4.2 Monitoring Faxes in Queue
Use the GFI FaxMaker Monitor to track faxes that are in queue, ready to be transmitted.

To access the Monitor, login to the GFI FaxMaker web console and click the required dashboard from the
Monitor tab in the top menu bar.

NOTE
Only fax administrators have access to the Monitor. For more information, refer to Fax administrators
(page 101).
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Screenshot 44: Monitoring Queued Faxes

Use the left pane on the dashboard, to filter faxes in the queue by their current status.

Administrators can use theQueued Faxes dashboard to:

Action Description

Search faxes in
the queue

Key in a word to search faxes in the Sender, Recipient or Priority fields in the queue.

View fax inform-
ation

Double-click any fax in the queue to view more detailed information about that particular fax.

Remove a fax
from the queue

Select one or more faxes to remove from the queue. You can also click to select all displayed
faxes. Click Delete and click OK to confirm deletion.

Restart MTA Click to restart the GFI FaxMaker Message Transfer Agent service, when required.

5.4.3 Monitoring SMS Devices and Queue
Use the GFI FaxMaker Monitor to track the activity of SMS devices and SMS transmission.

To access the Monitor, login to the GFI FaxMaker web console and click the required dashboard from the
Monitor tab in the top menu bar.

NOTE
Only fax administrators have access to the Monitor. For more information, refer to Fax administrators
(page 101).
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Screenshot 45: Monitoring SMS

The SMS dashboard displays the list of SMS devices and their current transmission status and properties.

The dashboard also contains information on:

Feature Description

SMS in queue The total number of SMS in queue to be sent to devices for transmission.

Last SMS Number The last phone number on which the SMS was sent.

Local SMS sent (last 30 days) The number of local SMS sent in last 30 days.

International SMS sent (last 30 days) The number of international SMS sent in last 30 days.

5.5 Reports
GFI FaxMaker enables administrators to access and generate reports that provide insight on fax and SMS
usage.

Reports are based on data logged to the GFI FaxMaker Firebird or Microsoft® SQL/MSDE archiving
database. Ensure that the database contains all the GFI FaxMaker data to be reported upon. For example,
when changing the database backend from Firebird to Microsoft® SQL/MSDE, run theMigration Tool to
migrate historical data from the Firebird database to the new database. This ensures that historical data is
included in all reports that are generated.

To access reports, log in to the GFI FaxMaker web console and click the Reports tab from the top menu bar.
Only GFI FaxMaker administrators have access to this screen and it is not shown to regular users that login
to the web console.

Use the left pane of the Reports screen to filter between reports. In the Default Reports section, choose All
to show all the default reports or click Fax or SMS to show default reports related to fax or SMS usage
respectively. In the Corporate section, access your Custom or Scheduled reports.
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Screenshot 46: A sample graphical fax usage report

5.5.1 Generating reports
Reports can be downloaded immediately from the GFI FaxMaker web console or sent via email to a custom
list of recipients.

1. Log in to the GFI FaxMaker web console and choose the Reports tab.

2.Use the left pane of the Reports screen to filter between reports. In the Default Reports section, choose
All to show all the default reports or click Fax or SMS to show default reports related to fax or SMS usage
respectively. In the Corporate section, access your Custom or Scheduled reports.

3. To generate and download a report without customizing settings, hover on report and clickDownload
now. Alternatively clickCustomize to generate to open the report settings.

4. From theGeneral tab, configure report options. The options available may vary between different report
types. The following are the basic, most common options across reports.

Option Description

Scope The time period that the report data covers. Choose either a relative time period with respect to the date
when the report is generated, for example, choose Last 7 days to show data for a week prior to the date
when report is generated. Alternatively, choose a Custom date range with custom from and to dates.
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Option Description

Report
for

Choose to show report data that has a particular property, such as the Status which allows you to filter
reports depending on the transmission status of the message. In the Add filters text field, key in or choose
the data to filter for. Click + to apply the filter. Repeat the process to add any different filters as applicable.
For example, to show faxes transmitted over line 23 that failed, choose Fax Line, add filter 23 and click +.
Then choose Status, select Failed and click +.

Group
by

Defines how report data is grouped. Choose All to have different sections within the report grouped by all
the possible groupings. Alternatively group data by a particular property, for example, choose Day to show
total usage during each day within the scope.

Format Choose the format of the report when it is generated.

5.When all report data is configured, choose how to generate the report:

Save as Custom - Click this button to save the report as a custom report before generating it, enabling
you to save the report settings and re-generate the report without re-configuring the settings. For more
information, refer to Custom reports (page 84).

Download now - Click this button to download the report as configured.

Send Now - Go to this tab to send the report via email. Specify the recipients of the report and click
Send.

Send via email periodically - Go to the Schedule tab to send this report via email every couple of days.
For more information, refer to Scheduled reports (page 85).

5.5.2 Custom reports
Custom reports are pre-configured reports with custom data filters that are readily available whenever
required.

To open the list of custom reports, from the left pane go to Corporate > Custom.

Creating a custom report

1.Hover over a default report that will serve as the basis of your custom report and clickCustomize.

2. Specify a custom report name by clicking on the report name at the top and keying in the custom name.
Report names must be unique.

3.Click on the report description underneath the name and key in a friendly description of the report to help
you understand the aim of the report.

4. From theGeneral tab, configure report options. The options available may vary between different report
types. The following are the basic, most common options across reports.

Option Description

Scope The time period that the report data covers. Choose either a relative time period with respect to the date
when the report is generated, for example, choose Last 7 days to show data for a week prior to the date
when report is generated. Alternatively, choose a Custom date range with custom from and to dates.

Report
for

Choose to show report data that has a particular property, such as the Status which allows you to filter
reports depending on the transmission status of the message. In the Add filters text field, key in or choose
the data to filter for. Click + to apply the filter. Repeat the process to add any different filters as applicable.
For example, to show faxes transmitted over line 23 that failed, choose Fax Line, add filter 23 and click +.
Then choose Status, select Failed and click +.
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Option Description

Group
by

Defines how report data is grouped. Choose All to have different sections within the report grouped by all
the possible groupings. Alternatively group data by a particular property, for example, choose Day to show
total usage during each day within the scope.

Format Choose the format of the report when it is generated.

5.Click Save as Custom to save the custom report. The report is stored and is accessible from the left
pane tab Corporate > Custom.

Generating custom reports

To generate a custom report, from the left pane go to Corporate > Custom. Choose how you would like the
report delivered to you:

Download immediately: hover over the report and clickDownload now.

Send report via email: Click on Customize and go to the Send Now tab. Specify the recipients of the
report and click Send.

Send via email periodically - Click on Customize and go to the Schedule tab to send this report via
email every couple of days. For more information, refer to Scheduled reports (page 85).

Modifying a custom report

To change the settings of a custom report, from the left pane go to Corporate > Custom. Hover over the
report to modify and clickCustomize. Apply the required changes and click Save.

Deleting custom reports

Custom reports can be deleted one-by-one or by deleting multiple reports at once. To delete custom
reports, from the left pane go to Corporate > Custom.

To delete multiple reports at one go, click on the check sign in the top right corner of the reports to

delete. When all reports to delete are selected, click in the top left corner of the view. When prompted
to confirm deletion, clickOK.

To delete one report, hover over the report to delete and click the cross symbol in the top left corner.
When prompted to confirm deletion, clickOK.

5.5.3 Scheduled reports
GFI FaxMaker reports enable you to generate reports on a pre-defined schedule to automate the
generation of reports that are required on regular basis. Scheduled reports are sent via email to a custom
list of email addresses at a particular frequency.

To open the list of scheduled reports, from the left pane go to Corporate > Scheduled.

Creating a scheduled report

1.Hover over a default or a custom report that will serve as the basis of your scheduled report and clickCus-
tomize.

2. Specify a report name by clicking on the report name at the top and keying in the custom name. Report
names must be unique.
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3.Click on the report description underneath the name and key in a friendly description of the report to help
you understand the aim of the report.

4. From theGeneral tab, configure report options. The options available may vary between different report
types. The following are the basic, most common options across reports.

Option Description

Scope The time period that the report data covers. Choose either a relative time period with respect to the date
when the report is generated, for example, choose Last 7 days to show data for a week prior to the date
when report is generated. Alternatively, choose a Custom date range with custom from and to dates.

Report
for

Choose to show report data that has a particular property, such as the Status which allows you to filter
reports depending on the transmission status of the message. In the Add filters text field, key in or choose
the data to filter for. Click + to apply the filter. Repeat the process to add any different filters as applicable.
For example, to show faxes transmitted over line 23 that failed, choose Fax Line, add filter 23 and click +.
Then choose Status, select Failed and click +.

Group
by

Defines how report data is grouped. Choose All to have different sections within the report grouped by all
the possible groupings. Alternatively group data by a particular property, for example, choose Day to show
total usage during each day within the scope.

Format Choose the format of the report when it is generated.

5.Go to the Schedule tab and configure the schedule settings:

Option Description

Send to Add all the email addresses to receive the scheduled report. Separate multiple recipients using a comma
(,) or semi-colon (;) symbols.

Start On Choose the date and time when the schedule is to start being sent.

Frequency Choose how frequent the scheduled email is to be sent.

6.Click Schedule to save the schedule settings. The report is stored and is accessible from the left pane
tab Corporate > Scheduled.

Modifying a scheduled report

To change the settings of a scheduled report, from the left pane go to Corporate > Scheduled. Hover over
the report to modify and clickCustomize.

To change the data shown in the report, apply the required changes in theGeneral tab. Click Save to
store changes.

To change the schedule when reports are sent, go the Schedule tab and apply the necessary changes.
ClickReschedule to apply changes.

Deleting scheduled reports

Scheduled reports can be deleted one-by-one or by deleting multiple reports at once. To delete scheduled
reports, from the left pane go to Corporate > Scheduled .

To delete multiple reports at one go, click on the check sign in the top right corner of the reports to

delete. When all reports to delete are selected, click in the top left corner of the view. When prompted
to confirm deletion, clickOK.
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To delete one report, hover over the report to delete and click the cross symbol in the top left corner.
When prompted to confirm deletion, clickOK.

5.5.4 Exporting activity data to a CSV
Export fax and SMS activity in a custom date range to a comma separated file. This is useful to track fax and
SMS usage in a separate tool, for example, to create pivot charts using GFI FaxMaker data in spreadsheets.

To export activity data, login to the GFI FaxMaker web interface and go to the Reports tab. From the left
pane under Categories, select the node to export data for:

All - export activity for both fax and SMS

Fax - export fax activity only

SMS - export SMS activity only

In the main pane, click on Export Data. Select the date range for the data to export and click Export to CSV
to start the download.

NOTE
Alternatively you can also use the Fax Archive data report which provides more customization,
scheduling and filtering.

The exported CSV contains the following columns:

Column Description

Type Defines whether the message is a fax or an SMS.

Direction Defines if message is inbound (received) or outbound (sent).

Date The complete date of transmission.

Day The day number of transmission.

Month The month number of transmission.

Year The year of transmission.

Time The full time of transmission.

Hour The hour of transmission in 24-hour format.

Minute The minutes of transmission.

Host Name The name of the GFI FaxMaker server where transmission occurred.

Method
Submitted /
Routing
Mechanism

The value of this column depends on the direction of the message:
Outbound messages: The method used by users to send the message.
Inbound message: Routing rules matched to deliver message to internal users.

Billing
Code

The billing code value of outbound faxes if specified.

Sender
Number

The Caller Line Identity Presentation (CLIP) or Caller ID of the fax sender if available.

Sender The value of this column depends on the direction of the message:
Outbound messages: The email address of the user sending the message.
Inbound message: The sender's CSID if known.
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Column Description

Recipient
Number

The message recipient's number.

Recipient
Name

The recipient's name for outbound faxes.
Note that this value is not always retrievable by GFI FaxMaker. For example, it can be determined if
sending a fax from the web client using the web client address book (if a name is specified), but not
retrievable if sending a fax from Microsoft Outlook using the Microsoft Outlook local contacts.

Recipient
Company

The recipient's company name for outbound faxes.
Note that this value is not always retrievable by GFI FaxMaker. For example, it can be determined if
sending a fax from the web client using the web client address book (if a company name is specified),
but not retrievable if sending a fax from Microsoft Outlook using the Microsoft Outlook local contacts.

Line The GFI FaxMaker fax line used to transmit the message.

Fax Pages
excluding
coverpage

Number of pages excluding the coverpage for outbound faxes.

Fax Pages
including
coverpage

Total number of fax pages sent or received.

Total
Pages/SMS

Total number of fax pages or total number of SMS messages transmitted.

Resolution The quality of fax resolution.

Speed Fax transmission speed.

Retries Number of times that GFI FaxMaker tried to send the fax. Value is 0 if sent fax is successfully transmitted
on the first attempt.

Call dur-
ation
(seconds)

Fax call duration in seconds.

Status The transmission result: Success or Failed.
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6 General configuration settings
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6.1 Fax Lines 90

6.2 Licensed users 98

6.3 Fax administrators 101

6.4 Mail server settings 102

6.5 POP3 Downloader 103

6.6 Fax and SMS domain names 105

6.7 Fax archiving 107

6.8 Fax services 116

6.9 OCR 119

6.10 Log files 121

6.11 HPDigital Sender integration 122

6.12 Storing faxes 123

6.13 Licensing information 124

See also:
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6.1 Fax Lines
A fax line is a physical telephone line assigned to a fax device (modem or ISDN/fax card). Depending on the
device type, fax devices may support multiple lines. GFI FaxMaker enables you to configure different
options per fax line.

Screenshot 47: The Line/Devices dialog

Fax lines are configurable fromGFI FaxMaker Configuration > Lines/Devices > Properties.

For more information, refer to:

Adding new fax lines

Editing fax lines

Deleting fax lines

Faxmodem properties

CustomModemProperties

6.1.1 Adding new fax lines

NOTE
You can add the maximum number of lines supported by your fax device, up to the GFI FaxMaker limit
of 128 lines.

1. Navigate toGFI FaxMaker Configuration > Lines/Devices > Properties and click Add….
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2. When adding new fax modems after installing GFI FaxMaker, clickDetect in the Lines/Devices dialog to
attempt automatic detection and add them to the list of devices.

Screenshot 48: Adding an ISDN channel

3. Specify the following details:

Setting Configuration

Available fax lines Select one of the available fax line numbers. This is used as a reference to that particular
line.

Device type Specify the type of fax device used.

Physical line/port Select the channel or port to configure.

Copy settings from
installed device

To copy the settings of a previously configured fax line, select this option and specify the
fax line to copy settings from.

ClickOK.

4. From the Device tab in the line properties dialog, configure:

Device Type Settings

ISDN
ISDN BRI CAPI2.0 devices
ISDN PRI/IP CAPI2.0
devices
ANALOG CAPI2.0 devices
Gateway devices

ISDN type - Select the ISDN device type.
MSN numbers - Enter the number to answer incoming calls for. Key in a full num-

ber entry (for example, 82733099) or a prefix number (for example, 82733 to answer
all numbers in the range 82733000-8273099).

Answer All - Click to answer all incoming calls received on the ISDN channel.

Brooktrout Card type - Select the Brooktrout device type
Line capabilities - depending on the properties of your fax device, select the appro-

priate type, None, DTMF or DID/ISDN.
Tone dialling - If supported, select for faster dialling. If disabled, pulse dialling is

used.
Wait for dialtone - Starts dialling only when a dial tone is established.
Rings until answer - Configure the number of rings before answering incoming

calls.
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Device Type Settings

GFI Fax Modem Driver Modem type - Select the fax modem type.
Advanced Modem Options - GFI FaxMaker ships with a number of pre-configured

devices. Click to create new devices or manually configure device options. For more
information, refer to Fax modem properties (page 97).

Initialization string - Displays the string used by the modem driver to initialize the
modem.

Rings until answer - Configure the number of rings before answering incoming
calls.

Tone dialling - If supported, select this option for faster dialling. If disabled, pulse
dialling is used.

Wait for dialtone - Starts dialling only when a dial tone is established.
Check for busy tone - Checks if line is busy before sending fax.
Speaker mode - Configure speaker settings: Always Off, Until Connected or

Always On.
Speaker volume - Set the appropriate volume.

Microsoft® Fax Modem
Driver

Type - Select the Fax type.
Rings until Answer - Configure the number of rings before answering incoming

calls.

NOTE: Ensure that the Fax Server role is installed and the Fax service is running from
the Services applet.

Fax Services Displays settings for the selected Fax Service line. To send faxes through an online
fax provider, specify your account details in the Fax Services node. For more
information, refer to Fax services (page 116).
To associate a line with a DID, choose the DID number from the list. This option
requires that the Fax service account is validated in the Fax services node.
IMPORTANT
Online fax services require the full recipient number, including the international dial
symbol "+", the country and area codes. Do not use hyphens, spaces or dashes
between any parts of the fax number.
The full recipient number is also required when sending faxes locally.
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Screenshot 49: The line options tab

5. From the Line options tab, configure:

Option Configuration

Max.
resolution

Set the maximum resolution for faxes sent and received on this line.

Max. speed Set the maximum speed for faxes sent and received on this line. A lower speed limit will increase call
duration but on an analog line, it helps to avoid loss of quality when there is noise in the telephone
line.

Local fax ID Specify the TSID value sent to recipients when sending faxes over this line. This is usually set as the
line's fax number. For more information, refer to Customizing the caller ID and TSID of outbound faxes
(page 149).
NOTE: Some PABX devices or telecommunications service providers do not accept a custom TSID
when making outbound calls. In this case it is recommended to leave this field empty.

Receive
incoming
faxes

Allow receiving faxes on this fax line.

Send
outgoing
faxes

Allow transmission of faxes on this fax line.

Dial prefix &
suffix

If your lines are located behind a PBX, you can specify a dial prefix or suffix.
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Option Configuration

Do not dial
prefix if fax
number is

Exclude dialling of prefix when the fax number is less than, equal to or more than a certain number of
digits. This can be useful when using different providers for local, national or international faxes.

Fax header Key in the text to show at the very top of a fax, for example the company name.

Number of
retries

Sets the number of times GFI FaxMaker will try to re-send a fax.

Retry delay Set a delay between retries, in seconds.

Disable use
of ECM if
available

By default, GFI FaxMaker automatically corrects errors caused by noise that interferes with the
transmission of a fax. Select this option to disable automatic correction.

Screenshot 50: The advanced line/device options

6. From the Advanced tab, configure:

Option Configuration

Auto-print faxes
received on this
line

Automatically print faxes received on this line.
1. Click Setup printers... to configure printing settings.
2. In the Incoming faxes auto-print setup, configure how to size faxes for printing or select
Nearest size to automatically detect the appropriate size to use.
3. Click Print setup... to select the printer to print for that particular paper size.
4. Click OK.
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Option Configuration

Backup faxes
received on this
line

Stores a copy of all incoming faxes in a folder. Key in the folder where to store received faxes.

Backup faxes sent
on this line

Stores a copy of all outgoing faxes in a folder. Key in the folder where to store received faxes.

Backup faxes in
the following file
format

Select the format to use when backing up faxes.

Number of DID
digits to capture

Routes faxes to individual users based on the DID number. Set the number of digits to capture.
For example, use 2 to capture from 00 to 99.

Generate beep
tone before
capture

Fax device gives a beep when answering a call as a signal to the user to enter the DTMF
number. If available, it is recommended that this option is always selected. From the drop down
list select the tone of the beep.

Flash after DTMF
capture and before
fax tone

Only used for Multitech modems. Select this option so that after successfully detecting a tone,
the fax server goes 500ms on hook (flash).

Screenshot 51: The users tab

7. From the Users tab, select the users allowed to send faxes using this line. Configure:
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Option Description

All users/groups can send on this line Allows all licensed users to send faxes on this line.

Listed users/groups can send on this line Limits the users that can send faxes on this line.

Add… Specify users/groups allowed to send faxes on this line.

Delete Deletes selected users/groups from the list of allowed users.

Reserve line only for listed users/groups Sets the line exclusively reserved for the selected users/groups

Screenshot 52: Line test tab

8. From the Line test tab, you can send a fax to test the line settings. Key in a fax number where to send the
test fax in Fax number to dial and click Send test fax. ClickMonitor test fax to launch the GFI FaxMaker
Monitor in a web browser and monitor the status of the test fax. For more information, refer to Monitoring
GFI FaxMaker operation (page 79).

9. ClickOK to save settings.

10. When changing settings for any lines/devices, it is necessary to restart theGFI FaxMaker Fax Server
service for changes to take effect. Click Yes to restart.

6.1.2 Editing fax lines
1. Navigate toGFI FaxMaker Configuration > Lines/Devices > Properties.

2. Select the device line to edit and click Properties.

3. Perform the required changes in the rule properties and clickOK to save changes.
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4. When changing settings for any lines/devices, it is necessary to restart theGFI FaxMaker Fax Server
service for changes to take effect. Click Yes to restart.

6.1.3 Deleting fax lines
1. Navigate toGFI FaxMaker Configuration > Lines/Devices Properties.

2. Select the device line to remove and clickDelete.

3. ClickOK to save settings.

4. When changing settings for any lines/devices, it is necessary to restart theGFI FaxMaker Fax Server
service for changes to take effect. Click Yes to restart.

6.1.4 Fax modem properties
GFI FaxMaker can send and receive faxes using a wide range of fax modems connected to the server’s
Communications ports.

To send faxes using these devices:

1. In the Lines/Devices list, add the modem as aGFI Fax Modem Driver.

2. In the device properties dialog, select theModem type by model name and number, or select aGeneric
class that best matches device’s properties.

3. Click Advanced modem options… and select:

Option Description

New modem (current
modem as template)…

Adds a new modem to modems lists. Initial properties are based on selected modem type.
For more information, refer to Custom modem properties (page 98).

Edit modem… Loads the modem properties. For more information, refer to Custom modem properties
(page 98).

Delete modem Removes selected modem from list.

Reset all modem
drivers to default

Resets all modems properties to default.

Table 1: Manage fax modems

4. Configure the other device/line options and clickOK.
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Custom modem properties

Screenshot 53: Custom modem properties dialog

Customize the following options, based on fax modem specifications:

Option Description

Modem type Key in a user friendly name for the modem type, such as the device brand, name or model
number.

Flow control
Fax class
Voice chipset
DLE codes method
Thread priority
Data initialization

string
Fax initialization

string
Voice initialization

string
Pre-command delay
Character delay

Provide settings based on device specifications.

ClickOK to apply settings.

6.2 Licensed users
The list of users who can send or receive faxes must be configured in GFI FaxMaker.
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Screenshot 54: List of GFI FaxMaker users and groups

The list of licensed users is available fromGFI FaxMaker Configuration > Licensed Users node.

Managing
users/groups

Description

Adding users
or groups

Active Directory: Click New licensed user/group.... Use the Active Directory user and group picker
to choose the users and groups to add.

GFI Directory: To create new users, click New licensed user/group... and specify the user details.
Alternatively, add users that already exist in GFI Directory or add Windows users, from the User Import
tool. Right-click Licensed users and choose Import users.... For more information, refer to Importing
users to GFI FaxMaker (page 100).

Welcome
email

Active Directory: The Welcome email provides high-level instructions to users on how to use GFI
FaxMaker.

GFI Directory: Use the Welcome email to send instructions to your new users to set an account
password . Your users use this password to login to the web client. This feature may also be used
when users need to reset their existing password.

To send a Welcome email, select the users or groups to send the Welcome email to and click Send
welcome instructions.
The Welcome email can also be sent to individual members of a group. Open the group properties
and select the Welcome Email tab. Select the users to send the Welcome email to and click Send.

Reset user
password

Active Directory: Reset user passwords and manage other user account settings directly in Active
Directory.

GFI Directory: Right-click the user whose password you want to reset and click Reset Password.
GFI FaxMaker sends an email to the user containing a link to the GFI FaxMaker web interface with a
unique reset password token which can only be used one time. The user must follow the link and cre-
ate a new password.

User/Group
properties

Right-click a user/group and click Properties to show user properties.
Active Directory: User properties are retrieved from Active Directory
GFI Directory: User properties are retrieved from GFI Directory. User details can be customized

directly from the Properties screen. On clicking OK, changes are applied in GFI Directory. For Web
Service API users, password reset can be done directly in the GFI FaxMaker Configuration.
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Managing
users/groups

Description

Web Service
API users

Register users that will make use of the GFI FaxMaker Web Service API functionality. Right-click user
to register and from the Web API Service tab select Web Service API User.
For more information refer to the GFI FaxMaker API manual.
NOTE: Received faxes that are routed to users registered for Web Service API are stored in the Web
Service API queue and not forwarded to the user via email.
To remove a user from the Web API register, right-click user and from the Web API Service tab
uncheck Web Service API User. Click OK.
NOTE: When unregistering users from the Web API Service, all faxes in their name that are in the
service queue are permanently deleted. Unregister users with caution.

Removing
users/groups

Right-click a user/group to delete and click Delete. Click OK to confirm.
Users are removed from GFI FaxMaker but not removed from Active Directory or GFI Directory.

NOTE
You can also create a dedicated Active Directory group (for example,GFI FaxMaker users) so that you
can manage all GFI FaxMaker users directly in Active Directory.

6.2.1 Importing users to GFI FaxMaker
The user import feature enables the addition of users to GFI FaxMaker from GFI Directory or from
Windows®.

NOTES

1. This feature is only available when GFI FaxMaker uses GFI Directory as a user directory service.

2. To import users from a CSV, first import the CSV in GFI Directory and then use this tool to import the
users to GFI FaxMaker. For more information on how to import users from a CSV in GFI Directory refer
to https://manuals.gfi.com/en/dir2015v2/#topics/importusersbulk.htm

Screenshot 55: Importing users from GFI Directory

http://go.gfi.com/?pageid=FM19help&lang=en#cshid=APImanual
https://manuals.gfi.com/en/dir2015v2#topics/importusersbulk.htm
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Right-click Licensed users and select Import users…. From Source, choose from where to get the users to
import.

Source Description

GFI Directory Add users from GFI Directory. Select the users to import and click Add.

Local
machine

Import Windows® user accounts from the GFI FaxMaker server. Select the users to import and click
Add.
NOTE: Since Windows account users do not have an email address available, one needs to be
configured. To use the account name and append a domain to it, specify the email domain in the Add
domain to username field. For example if the username is JohnSmith and the domain is
mydomain.com, the generated email address is JohnSmith@mydomain.com. If the email address is
different, you can change the email address later from Licensed users screen.

Remote
machine

Import Windows® user accounts from a separate server. Key in the remote server name or IP address
and click List users. Select the users to import and click Add.
NOTE: Since Windows account users do not have an email address available, one needs to be
configured. To use the account name and append a domain to it, specify the email domain in the Add
domain to username field. For example if the username is JohnSmith and the domain is
mydomain.com, the generated email address is JohnSmith@mydomain.com. If the email address is
different, you can change the email address later from Licensed users screen.

On selecting all users to add, clickOK. Users are now included in the Licensed Users screen and can start
using GFI FaxMaker.

For users to login and send faxes/SMS using the web client, send them aWelcome email so that they can
set an account password. Select the added users and click Send welcome instructions.

6.2.2 Unlimited Users license - Types of users
This feature is only applicable to the GFI FaxMaker Unlimited Users license.

Configure the types of users allowed to send/receive faxes using GFI FaxMaker. Navigate toGFI
FaxMaker Configuration >Advanced > Miscellaneous node:

Allow non-AD users to send faxes - Allows all faxes/SMS to be processed by GFI FaxMaker, even if
user is not in Active Directory.

Only allow users in the Licensed user list to send faxes - allows a user to send faxes/SMS only if
included in the Licensed User list.

6.3 Fax administrators
A fax administrator's primary role is to monitor and manage GFI FaxMaker operation. Administrators are
also notified via email when critical conditions occur and have access to theMonitor and Reports screen in
the GFI FaxMaker web interface.
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Screenshot 56: List of Fax administrators

To manage the list of Fax administrator, from GFI FaxMaker Configuration navigate to Advanced > Fax
administrators.

Function Description

Add
administrators

Click New… to select the users to set as administrators.
Active Directory: Choose the Active Directory objects to set as administrators. When using Active

Directory, a fax administrator does not have to be added as a Licensed User.
GFI Directory: Select the users that you would like to set as administrators. Only users that were

previously added to the Licensed Users screen can be set as administrators.

Edit
administrator
properties

Right-click administrator and select Properties.

Remove
administrators

Right-click administrator and select Delete.

6.4 Mail server settings
Configure the mail server to use when GFI FaxMaker sends emails:

1. From GFI FaxMaker Configuration, right-click Email2FaxGateway and select Properties.
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Screenshot 57: Email2Fax Gateway setup

2. From the SMTP Connector tab, configure the following options:

Option Description

Mail server name/IP
and port

Enter the name or IP address of the mail server and the port number.

Use Secure
Connection

Choose this option when the mail server requires a secure connection. Choose the type of
encryption required SSL or TLS.

Use SMTP
Authentication

Instructs GFI FaxMaker to connect to the mail server using a particular user credentials. Enter
credentials in the Account and password text boxes.

Secure Password
Authentication

Select this option if Secure Password Authentication is required by the mail server.

3. To ensure that GFI FaxMaker can send email through the configured mail server, enter an email address
and click Send test email. Ensure that the test email is received in the mailbox. If the test fails, troubleshoot
setup and configuration. For more information, refer to Email2FaxGateway test fails (page 203).

4. ClickOK.

6.5 POP3 Downloader
GFI FaxMaker can be configured to retrieve faxes and SMS for transmission from a POP3 mailbox.
Configure the POP3 Connector to poll and download faxes from a dedicated GFI FaxMaker POP3 mailbox.
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IMPORTANT NOTES

1. This option is not available if mail server is configured to route faxes and SMS to GFI FaxMaker via
SMTP.

2. Ensure that the POP3 mailbox is dedicated exclusively to GFI FaxMaker. GFI FaxMaker downloads
all emails contained in this mailbox for processing and emails are permanently deleted from the mailbox
after download.

3. The method of sending fax/SMS via email when using POP3 is different than SMTP. For more inform-
ation, refer to Sending faxes/SMS via a POP3Mailbox (page 105).

Configure POP3 mailbox settings:

1. From GFI FaxMaker Configuration, right-click Email2FaxGateway and select Properties.

Screenshot 58: The POP3 connector

2. From the POP3 Downloader tab, configure the following options:

Option Description

Enable POP3 downloader Enable downloading of faxes from a POP3 mailbox.

Mail server name/IP and port Enter the name or IP address of the mail server and the port number.

Mailbox account and password Key in credentials to access mailbox.

Full email address of mailbox
specified above

The email address of the POP3 mailbox.
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Option Description

Use SSL Instructs GFI FaxMaker to connect and communicate with the mail server
using SSL.

Time interval to check for new faxes Key in the frequency for GFI FaxMaker to check for new faxes in the GFI
FaxMaker mailbox.

3. ClickOK.

6.5.1 Sending faxes/SMS via a POP3 Mailbox
When using the GFI FaxMaker POP3 Downloader to poll fax/SMS emails from a dedicated POP3 mailbox,
the method of sending via email is different than when using SMTP.

Sending faxes via a POP3 mailbox

Licensed users can use their preferred email client and compose fax emails as follows:

Parameter Description

Email recipient In the To field, enter the POP3 mailbox email address. For example, fax-
makermailbox@mydomain.com.

Email subject The email subject is used as the fax subject and shown, if configured, in the fax coverpage.

First line of email
body

Key in the fax recipient's fax number in the first line of the email body in the following format:
::fax number
For example:
::+441273123456

Email body The rest of the email body is shown in the fax coverpage.

Attachment Include any attachments to include in the fax.

Sending SMS via a POP3 mailbox

Licensed SMS users can use their preferred email client and compose SMS emails as follows:

Parameter Description

Email recip-
ient

In the To field, enter the POP3 mailbox email address. For example, fax-
makermailbox@mydomain.com.

Email subject The email subject is ignored.

Email body First line: key in ::SMS to declare that the email is an SMS.
Second line: key in the recipient's SMS number in the following format: ::SMS number
Third line: key in the short message text.

For example:
::SMS
::+44123456789
Hello John, how are you?

Attachment Attachments are ignored.

6.6 Fax and SMS domain names
When installing GFI FaxMaker, connectors are configured on the mail server (either automatically or
manually) to route all emails addressed to particular domains to GFI FaxMaker. The default fax and SMS
domains are *@faxmaker.com and *@smsmaker.com.
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When domain users send emails to these domains, the mail server routes these emails to GFI FaxMaker
which converts and transmits them over fax or SMS.

For example, with the default fax domain, users can send a fax to number 123456 by composing an email
addressed to 123456@faxmaker.com.

6.6.1 Modifying the default fax and SMS domain names

IMPORTANT - Use this feature with caution.
Failing to complete the steps described in this topic will hinder mail flow and consequently fax
transmission.
It is recommended to only modify the domain names when constraints in the mail environment do not
allow using the default domain names. For example, when using Microsoft®Office 365™ Email only
account types.

GFI FaxMaker enables modification of the default fax and SMS domain names. When these are modified,
users send an email addressed to the custom domain name.

For example, when modifying the fax domain name to fax.mydomain.com, users can send a fax to
number 123456 by composing an email addressed to 123456@fax.mydomain.com.

Step 1: Configure connectors on mail server

NOTE
When GFI FaxMaker is installed on the Microsoft® Exchange Server, the connectors are modified
automatically in Step 2.

Create new or modify existing connectors on the mail server using the new domain names. Connectors
should route all emails addressed to the fax and SMS domain names to the GFI FaxMaker server.

For example, to use fax.mydomain.com as your fax domain name, on your mail server create a
connector that routes all emails addressed to fax.mydomain.com to GFI FaxMaker.

IMPORTANT
If the connectors on the mail server are not modified, emails addressed to the custom fax & SMS
domains are sent over the Internet, probably resulting in an NDR.

For more information how to configure connectors in your environment, refer toMail Servers.
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Step 2: Change domain names from GFI FaxMaker Configuration

Screenshot 59: Customizing the fax and SMS domain names

1. From GFI FaxMaker Configuration, right-click Email2FAXGateway node and select Properties.

2. From the Fax/SMS domains tab, specify custom Fax domain name and/or SMS domain name (for
example, fax.mydomain.com and sms.mydomain.com).

3.ClickOK to apply changes.

NOTE
To restore the default faxmaker.com and smsmaker.com domains, clickReset to default and click
OK.

Step 3: Test the new settings

When completed, it is recommended to test this functionality by sending a test fax from an email account to
the new domain names. Check that the email is received by GFI FaxMaker in theGFI FaxMaker Monitor.

6.7 Fax archiving
GFI FaxMaker can archive all inbound and outbound faxes to a central location. This enables the recording
all fax communications and the retrieval of old faxes.

There are 2 methods of archiving:
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Send fax copies to an email address - copies of transmitted, received and/or failed faxes are sent via
email to a mailbox. You can then use an email archiving solution, such as GFI Archiver, to archive the mail-
box. For more information, refer to Archive tomailbox (page 108).

Archive to a database - Store all faxes in a Firebird or a Microsoft® SQL/MSDE database. For more
information, refer to Archive faxes to database (page 109).

6.7.1 Archive to mailbox
Use this option to send a copy of incoming, outgoing and/or failed faxes to an email address. This includes
transmission reports and the fax as attachment.

1. From GFI FaxMaker Configuration, right-click Archiving node and select Properties.

Screenshot 60: Archiving to an email archiving package

2. In the Archive to Mailbox tab, select the type of faxes to archive:

Option Description

Enable mail archiving for
received faxes

Enable received faxes archival.

Enable mail archiving for
sent faxes

Enable sent faxes archival.

Enable mail archiving for
failed faxes

Enable failed faxes archival.

Email address Specify the email address where to forward archived faxes.
NOTE: Email address must be included in the Licensed users list of GFI FaxMaker.

Archive faxes in this
format

By default, GFI FaxMaker archives faxes in .fax format. To archive in a different format (for
example PDF) enable and select the format.
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3. ClickOK.

6.7.2 Archive faxes to database
GFI FaxMaker can archive all faxes and SMS to a Firebird or a Microsoft® SQL/MSDE database. The
database is used by the GFI FaxMaker Reports and the Archive Viewer to show reports and information
about sent and received faxes and SMS.

Choosing a database

Database
type

Description

Firebird Firebird is a free and open source database format. When chosen, GFI FaxMaker automatically creates
and configures a Firebird database using the specified database location and filename. No further
configuration is required. This database is used to store fax images. Fax metadata is always stored in a
separate Firebird database and is used in Reports and Archive Viewer.
A Firebird database has a size limit of 10GB. When the database reaches 10GB, GFI FaxMaker does
not continue to archive faxes. Before this occurs, it is recommended to switch to and migrate data to
Microsoft® SQL/MSDE.

Microsoft®

SQL/MSDE
A Microsoft® SQL/MSDE database typically does not have size limitations, unless limitations are
imposed by the database administrator. GFI FaxMaker stores all metadata and fax images in the
database configured.
Configure a Microsoft® SQL/MSDE server and specify the server details as per instructions below. GFI
FaxMaker can either create a new database or use a pre-created database dedicated for GFI FaxMaker
data.
NOTE: Archive data stored on a Microsoft® SQL/MSDE server cannot be migrated back to Firebird.

How to enable fax archiving

1. From GFI FaxMaker Configuration, right-click Archiving node and select Properties.
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Screenshot 61: Archiving properties

2. In the Archive to Database tab, select Enable database archiving.
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Screenshot 62: Database configuration

3.Click Setup Database to configure the database where to store faxes:

Option Description

Firebird
database

Enable archiving to a Firebird database. Key in or browse to the location where to store the database
file and specify the database name in .FDB format.
A Firebird database has a size limit of 10GB. When the database reaches 10GB, GFI FaxMaker does
not continue to archive faxes.

Microsoft®
SQL/MSDE
database

Archive to a Microsoft® SQL Server® or MSDE database. Key in the server name/IP or select from
the list of automatically detected servers. Enter credentials to connect to the server.
In Select database, specify the database to archive to. Choose one of the detected databases from
the list or archive to a new database called FAXmakerArchive that is automatically created by GFI
FaxMaker.
NOTES:

GFI FaxMaker archiving requires mixed mode authentication to be enabled on the SQL Server®.
The database name cannot contain any spaces or special characters..
Some databases may have size limitations. Ensure that this limit is not exceeded.

4.Click Test to verify settings and clickOK.

5. To archive faxes and SMS to GFI Archiver, select Enable GFI Archiver and configure settings. For more
information, refer to Archive faxes to GFI Archiver (page 112).

6. By default, GFI FaxMaker archives faxes in .TIFF format. To archive in a different format, for example
PDF, select Archive faxes in this format and specify custom format required.

7.ClickOK.
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NOTE
GFI FaxMaker Reports and the Archive Viewer read the data from the current active database as
configured above. When changing the database type, for example from Firebird to Microsoft® SQL,
data in the older database is not shown in reports and in the Archive Viewer. Use the Migration Tool to
migrate data from the old database to the new database so that old data is shown. For more
information, refer to Migrating archive data between databases (page 115).

6.7.3 Archive faxes to GFI Archiver
Sent and received faxes and SMS can be archived to GFI Archiver. With this feature enabled, faxes and
SMS can be easily identified, searched and retrieved using GFI Archiver, ensuring that communications
history is secure, accessible and meet a number of compliance and eDiscovery regulations.

Requirements

Before using this feature, ensure that:

GFI Archiver is installed, properly configured and functional.

GFI Archiver is accessible from the GFI FaxMaker server. To confirm this, try to login to GFI Archiver via
a web browser from the GFI FaxMaker server.

If inclusion or exclusion lists are used in GFI Archiver, ensure that these are properly configured so that
GFI FaxMaker users are not blocked by these lists.

For compliance purposes, ensure that GFI Archiver configuration meets your legal requirements. For
example, retention policies maybe configured to automatically delete archived items, in breach of your fax
retention requirements.

Enable archiving to GFI Archiver

1. From GFI FaxMaker Configuration, right-click Archiving node and select Properties.

2. In the Archive to Database tab, select Enable GFI Archiver and click Setup GFI Archiver....
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Screenshot 63: Configuring GFI Archiver connection settings

3. Specify the GFI Archiver connection details:

Option Description

GFI Archiver URL Key in the URL used to launch GFI Archiver. This is the same URL used when load GFI Archiver
from a web browser. Ensure that this location is accessible from the GFI FaxMaker server.
If the GFI Archiver URL is secure (HTTPS), GFI FaxMaker validates the SSL certificate to ensure
that the certificate is valid. For more information refer to Other notes section below.

GFI Archiver
administrator
credentials

Key in the credentials of a user with GFI Archiver administrative privileges.

4.Click Test to verify connection and authentication with GFI Archiver. If the test fails ensure that the
GFI Archiver address is accessible form the GFI FaxMaker server and that the credentials entered are cor-
rect.

5.ClickOK.

6. In the Archive to Database tab, choose the format to archive fax images in.

7.ClickOK to apply settings and start archiving to GFI Archiver.

Other notes

When enabling the above settings, GFI FaxMaker starts archiving faxes and SMS that it processes to
GFI Archiver, but it does not add old and historical archive data. Use the Migration Tool to copy old GFI
FaxMaker data to GFI Archiver. For more information, refer to Migrating archive data between databases
(page 115).

When connection with GFI Archiver cannot be established, faxes and SMS are temporarily stored in a
folder until connection is re-established. Items are temporarily stored in the following location: <GFI
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FaxMaker installation folder>\archive\DBCache. GFI FaxMaker attempts to re-archive
items every 60 minutes.

If the GFI Archiver URL is secure (HTTPS), by default GFI FaxMaker does not accept invalid or untrus-
ted certificates. To ignore untrusted certificates, create the following registry key and restart the GFI
FaxMaker Attendant service:

Registry Loca-
tion

64-bit servers: HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\GFI Fax & Voice\FAX-
maker\Config

32-bit servers: HKEY_LOCAL_MACHINE\SOFTWARE\GFI Fax & Voice\FAXmaker\Config

Key Value
Name

IgnoreSSLPolicyErrors

Key Value
Type

REG_DWORD (32bit)

Key Value Data 1

For more information, refer to the GFI Archiver documentation from http://go.gfi.com/?pageid=MAR_
DownloadDocumentation.

6.7.4 Viewing faxes archived to a database
The GFI FaxMaker Archive Viewer enables users to view sent and received faxes. If database archiving is
enabled, the tool can also be used to view fax images.

NOTE
As an alternative to this tool, you can also use the Fax Archive data report to download archive data to
a CSV file. Fax image previews, however, can only be done via the Archive Viewer.

To access the Archive Viewer, go to the GFI FaxMaker installation folder and open the ArchiveViewer
folder. LoadGFI.FaxMaker.ArchiveViewer.exe.

Screenshot 64: The GFI FaxMaker Archive Viewer

The list of archived faxes is displayed, showing the most important information.

Click on a fax to showmore detailed information.

http://go.gfi.com/?pageid=MAR_DownloadDocumentation
http://go.gfi.com/?pageid=MAR_DownloadDocumentation
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Screenshot 65: Viewing fax details in the GFI FaxMaker Archive Viewer

When viewing the detailed fax information you can also:

Click Preview to open the fax in the archived format.

(Outbound faxes only) ClickResend to resend the fax.

Searching archived faxes

To search through the list of archived faxes, click Filter to show the filtering pane.

Screenshot 66: Filtering faxes in Archive Viewer

Select a filtering parameter and key in or choose the data to filter. You can also:

Click Add filter to add more filters.

Click next to a filter to remove it.

When all the required filtering parameters are configured, click Apply to filter the results. The Archive Viewer
shows faxes that match all the specified filters.

6.7.5 Migrating archive data between databases
GFI FaxMaker includes a tool to export archived data from one database format to another.
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This tool is useful in various scenarios, including:

When using a Microsoft Access archive database with GFI FaxMaker version 2014 or earlier, and
upgrading to version 2015 or later to use a Firebird database.

Changing your database format, for example, upgrade from Firebird to Microsoft SQL.

Copy all GFI FaxMaker archived data to GFI Archiver.

Archive data can be copied between the following database formats:

Source database type Destination database type

Microsoft Access Firebird

Microsoft Access Microsoft SQL

Microsoft Access GFI Archiver

Firebird Microsoft SQL

Firebird GFI Archiver

Microsoft SQL Microsoft SQL

Microsoft SQL GFI Archiver

Important notes:

GFI FaxMaker Reports and Archive Viewer use the currently active archive database as configured in
the GFI FaxMaker Configuration. Use the Migration tool to ensure that all archive data is included in the act-
ive database,

The Migration tool copies the archive data from the source database to the destination, so the data in the
source database is retained.

Migration of data can take a long time depending on various factors such as the size of the data to
migrate, disc read and write speeds and network bandwidth when migrating data to remote servers.

When a migration process is run and then run again using the same source and destination databases,
data is not duplicated on the destination database if the source database is not altered in any way. If source
database is renamed, content altered or the re-migration run on a different server, data may become duplic-
ated on the destination database..

Using the DatabaseMigrator tool

1. From the GFI FaxMaker Configuration, select the Archiving node.

2. From the right pane, clickMigration Tool to open the GFI FaxMaker Database Migrator and clickNext.

3. Select a source database to copy GFI FaxMaker data from. Choose the database type and specify the
source database details. ClickNext.

4. Select the destination database where data from the source database will be copied. Choose the data-
base type and specify the destination database details. ClickNext.

5.ClickNext to start migration. On completion clickClose.

6.8 Fax services
GFI FaxMaker can send and receive faxes through supported online fax providers. To use this feature, GFI
FaxMaker requires an internet connection and a subscription with a supported online fax service provider:
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GFI Online Fax Service

etherFAX fax service

With Fax Services, GFI FaxMaker does not require a faxing device, enabling GFI FaxMaker to be installed in
a virtual environment such as Microsoft Hyper-V, Microsoft Virtual Server, Microsoft Virtual PC or VMware.

When sending a fax via Fax Services, GFI FaxMaker sends the fax via a secure HTTPS connection to the
service provider. The provider transmits the fax to the recipient and sends back a confirmation to GFI
FaxMaker which then delivers the transmission report to the sender.

If your provider assigns dedicated fax numbers to your subscription, faxes received on these numbers are
sent to GFI FaxMaker via a secure HTTPS connection. GFI FaxMaker then processes and delivers the fax
to the intended recipients.

For more information go to http://go.gfi.com/?pageid=FM_FaxServices.

6.8.1 Specifying the fax number
Online fax services require the full recipient number, including the international dial symbol "+", the country
and area codes. Do not use hyphens, spaces or dashes between any parts of the fax number.

The full recipient number is also required when sending faxes locally.

Example 1:When sending a fax to Czech Republic number 313-414-515 use
+420313414515@faxmaker.com. Where:

+ is the international dial prefix

420 is the Czech Republic country code

313414515 is the fax number

Example 2: Sending a fax to a UK number, with area code 01273, and number 123-456. In this case use
+441273123456@faxmaker.com. Where:

+ is the international dial prefix

44 is the UK country code

1273 is the area code (in the case of the UK the preceding 0 is dropped when using the international dial
number)

123456 is the fax number

6.8.2 Configuring a GFI Online Fax Service account
When a GFI Online Fax Service account is available, specify the account details in GFI FaxMaker:

1. From GFI FaxMaker Configuration, right-click Fax Services node and selectNew fax service account.

2. SelectGFI Online Fax Service and clickOK.

http://go.gfi.com/?pageid=FM_FaxServices
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Screenshot 67: New GFI Online Fax Service account

3.Configure the following options:

Option Description

Account name Key in a friendly account name which will be used to identify this service.

User ID Enter your GFI Online Fax Service user ID. This usually starts with MBX.

Password Key in you GFI Online Fax Service account password.

4.Click Validate Account to check if GFI FaxMaker can access the service using the details provided.

5. In Receive poll interval in minutes specify the frequency for GFI FaxMaker to check for new faxes.

6.ClickOK.

Next, configure a fax line for the fax service so that GFI FaxMaker can start sending/receiving faxes from
this service. For more information, refer to Fax Lines (page 90).

6.8.3 Configuring an etherFAX fax service
When an etherFAX account is available, specify the account details in GFI FaxMaker:

1. From GFI FaxMaker Configuration, right-click Fax Services node and selectNew fax service account.

2. Select etherFAX and clickOK.
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Screenshot 68: New etherFAX account

3. Configure the following options:

Option Description

Account name Key in a friendly account name which will be used to identify this service.

etherFAX Account Enter your etherFAX account. This usually starts with EFAX-.

etherFAX Server Choose your preferred etherFAX server location.

User ID Your etherFAX username specified when signing up to the service.

Password Key in you GFI Online Fax Service account password.

4.Click Validate Account to check if GFI FaxMaker can access the service using the details provided.

5. In Receive poll interval in minutes specify the frequency for GFI FaxMaker to check for new faxes.

6.ClickOK.

Next, configure a fax line for the fax service so that GFI FaxMaker can start sending/receiving faxes from
this service. For more information, refer to Fax Lines (page 90).

6.9 OCR
Optical Character Recognition (OCR) converts received and sent fax content to text. Due to the nature of fax
technology, the content of sent and received is not usable by the system. By converting faxes to text, the fax
content is more usable, for example, by enabling users and administrators to search through the fax
content.

1. From GFI FaxMaker Configuration right-click Advanced > OCR and select Properties.
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Screenshot 69: OCR properties

2. Configure the following options:

Option Description

Set Languages Click to select the languages to use during OCR analysis.
NOTE: The languages available depend on license type.

Enable spell checking and
correction

By enabling this option, the OCR engine checks and corrects spelling
problems.

3. From the Inbound OCR tab, configure OCR options for received faxes:

Option Description

Append OCR output text
below fax report

Insert the OCR text in the body of the transmission report email. This enables searching
through faxes using the email client’s search function.

Attach OCR output text
file with fax report

Store the OCR text in a text file and attach it in the transmission report.

Maximum pages to
convert

Set the maximum number of pages to convert to text.

4. From theOutbound OCR tab, configure OCR options for sent faxes:

Option Description

Enable OCR on sent faxes Select this option to run OCR on outgoing faxes.

Directory Specify a folder where to store the OCR content. The text is stored in a plain text file.

Maximum pages to convert The maximum number of pages that GFI FaxMaker converts per fax sent.
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5. ClickOK.

6.10 Log files
Log files enable administrators to review the activity of GFI FaxMaker.

6.10.1 Managing log files

NOTE
The following settings apply to the log files described in List of log files.

1. From the GFI FaxMaker Configuration, right-click Advanced > Logging node and select Properties.

Screenshot 70: Logging settings

2. Configure the following options:

Option Description

Folder The folder where to store the log files.

Start log-
ging to new
file

Select the condition when to start logging to new log files. Old log files are stored in the same folder,
extension is changed to BAK format (can be opened in text editor) and renamed as follows:
<log name><date>.fmlogger.bak
For example:
sendlog20150815.fmlogger.bak

Size limit
(Mb)

When selecting to start using new log files when a particular size is reached, specify the file size in
megabytes. GFI FaxMaker starts logging to a new log file when the current log file reaches this file size.
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Option Description

Delete old
files

Choose whether to keep or discard old log files. If enabled, GFI FaxMaker keeps only the number of log
files configured in Max number of files to keep. Older log files are automatically deleted.
NOTE: Deleted log files are permanently removed and not recoverable.

Compress
old files to
keep

Log files are compressed to ZIP format.

3. ClickOK.

6.10.2 List of GFI FaxMaker log files

Log file Description

sendlog.fmlogger.txt Contains a log of sent faxes in the following format:
Date, Time, SenderEmail, SenderName, BillingCode, RemoteId,
RecipientName, RecipientCompany, RecipientNumber, CallDuration,
PagesTransferred, Result, Info, Port, FilesInArchiveDir
For example:
"7/1/2018","2:16:48 AM", "jsmith@mydomain.com", "John", "", "88888888",
"Bob", "Company", "99999999", "05:30", "3", "SUCCESS", "Fax has been
sent successfully", "COM2", "C:\Sent\20110701_015642_00001.pdf"

rcvlog.fmlogger.txt Contains a log of received faxes in the following format:
Date, Time, RemoteID, CallDuration, PagesReceived, Result, Info, Port,
FileInArchiveDir, RoutedTo
For example:
"6/30/2018","8:47:01 AM","+557(833)343-3948", "03:30", "2", "SUCCESS",
"Fax received from +557(833)343-3948", "Line0", "C:\Received
Faxes\20110630_084657_00003.pdf", "jsmith@mydomain.com"

smtpin.fmlogger.txt A log of emails generated by GFI FaxMaker that are sent to local users. The log is in the
following format:
Date, Time, Subject, Sender, Recipient, Status
For example:
2018-06-29, 08-34, Success: Test fax (Fax sent to 123456)
[::resend=s3030be58], '+123456789' <'+123456789'@faxmaker.com>,
jsmith@mydomain.com, Success - Message uploaded.

smtpout.fmlogger.txt A log of emails sent by fax users to GFI FaxMaker. The log is in the following format:
Date, Time, Subject, Sender, Recipient
For example:
2018-06-29, 08-42-40, Test fax subject, jsmith@mydomain.com,
+123456789@faxmaker.com

smsout.fmlogger.txt A log of sent SMS in the following format:
Date, Time, Subject, Sender, Recipient
For example:
2018-06-29, 09-21-05, This is subject, jsmith@mydomain.com,
+123456789@smsmaker.com

smsin.fmlogger.txt A log of received SMS in the following format:
Date, Time, Sender, Recipient, Status, Message, Details
For example:
"09/05/2018", "09:06:32", "+123456789", "jsmith@mydomain.com",
"Success", "This is SMS message text", "Success. SMS received."

6.11 HP Digital Sender integration
GFI FaxMaker supports HPDigital sender scanner/copier. This enables you to send faxes directly from the
Digital sender device, by entering the document in the tray and dialling recipient fax number. Faxes are sent
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via GFI FaxMaker and the user will receive a confirmation in his mailbox. For the latest list of supported HP
Digital Sender devices, refer to http://go.gfi.com/?pageid=FM_HPDigitalSender.

To send faxes from an HPDigital sender:

1. From the HPDigital Sender link applet, select Inbox tab.

2. Select Enable receive.

3. In Path to receive inbox, provide a directory where the HPDigital Sender will pick up the fax information
files.

4. From GFI FaxMaker Configuration, right-clickHPDS/SAP node and select Properties.

Screenshot 71: HP Digital sender set-up

5. From the HPDS tab, select Scan folder for HPF files. Key in or browse to the directory specified in the
HPDigital Sender app and select the HPFSCAN folder.

6.ClickOK.

7. From the HPDigital sender JetAdmin utility, modify your HPDigital Sender to enable fax. ChooseOther
vendors with notification support as Network Fax Server.

6.12 Storing faxes
By default, GFI FaxMaker stores copies of fax attachments on the GFI FaxMaker server for a number of
days:

Sent faxes - A copy is stored for 2 days.

Failed faxes - A copy is stored for 1 week.

http://go.gfi.com/?pageid=FM_HPDigitalSender
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These are stored in <GFI FaxMaker installation folder>\data\attachments folder. This allows resending of
fax attachments.

To disable storage of fax attachments and consequently disable option to resend faxes:

1. From GFI FaxMaker Configuration, right-click Advanced > Miscellaneous node and select Properties.

2. From Fax server options area, configure:

Option Description

Do not store sent fax attachments for resending Select option to NOT store sent fax attachments.

Do not store failed fax attachments for resending Select option to NOT store failed fax attachments.

3. ClickOK.

6.13 Licensing information
During the GFI FaxMaker installation, you are requested to key in your GFI account or a license key.

NOTE
GFI FaxMaker stops sending faxes and SMS once the subscription expires. Renew the subscription to
unblock the fax queue.

To review and modify licensing details, from GFI FaxMaker Configuration, right-clickGeneral > Licensing
and select License product….

Alternatively, you can log in to the GFI FaxMaker website and go to Settings > System Settings >
Licensing.



GFI FaxMaker 6General configuration settings | 125

Screenshot 72: Viewing current licensing information

Use this node to view current licensing information or to enter your License key number.

Under the License Key Information, the following data is available:

Field Description

Subscription Status Expiration data and the number of remaining days of subscription.

Licensed User Limit Maximum number of users allowed by the subscription.

Current User Count Actual number of users listed as fax users. For more information, refer to Licensed users
(page 98).

Licensed user SMS
Limit

The maximum number of users allowed to use SMS. For more information, refer to SMS (page
185).

Current Fax Lines
Count

Number of lines configured in GFI FaxMaker. For more information, refer to Fax Lines (page
90).
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Field Description

OCR If the OCR module is enabled or not in the GFI subscription. For more information, refer to
OCR (page 119).

ClickChange Account to use another GFI Account or click Edit to edit your license key.
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7.1 Sending options
1. From GFI FaxMaker Configuration, right-click Sending/Receiving Options and select Properties.

Screenshot 73: Sending options

2. Select Sending tab and configure the following options:

Option Description

Enhance fax image
when sending normal
resolution faxes

Improves the quality of low-resolution faxes.

Send fax report
attachments in the
following format

By default GFI FaxMaker attaches incoming fax in .FAX format. Select this option to customize
the attachment format, for example attach the fax in PDF format.

Automatically print
outgoing faxes if
successful

Automatically print all outgoing faxes that are sent successfully. Click Setup printers... to
configure printer options.

Auto print if failed Automatically print all outgoing faxes that fail. Click Setup printers... to configure printer
options.

Automatically print
outgoing fax report if
successful

Automatically print transmission report after successfully sending a fax. GFI FaxMaker will
also print 6 fax pages on one printer page. Click Setup printers... to configure printer options,
including how many pages of the report to print.
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Option Description

Auto print report if
failed

Automatically print all transmission reports for outgoing faxes that fail. Click Setup printers...
to configure printer options.

3. ClickOK.

7.2 Document Conversion
GFI FaxMaker enables users to send faxes by attaching content to an email. GFI FaxMaker automatically
converts the attachment to fax. For this purpose, a built-in conversion engine is included for PDF, HTML,
PNG, GIF, JPG, RTF and TXT files.

NOTE
Microsoft®Office® 2007 or higher is required on the GFI FaxMaker server to convert Microsoft®
Office® files, such as DOCX and XLSX files.

1. From GFI FaxMaker Configuration, right-click Advanced > Document conversion and select
Properties.

Screenshot 74: Document conversion options

2. Configure the following options:

Option Description

File extension list
to ignore

Enter the extensions to ignore, separated by semi-colons - ;
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Option Description

File extension list
allowed for
conversion

List of extensions that can be converted by GFI FaxMaker.

Add To add new file formats for conversion, key in the Extension to add. In Command text box, key in
the Application Command that prints the file in Windows® Explorer (Usually this is Print). Click
Add.
NOTE: To verify whether GFI FaxMaker can convert a file extension, from Windows® Explorer,
right-click a file in that format and select Print. The file must print successfully.

Remove Click to delete a selected file extension.

3. ClickOK.

7.3 Transmission reports
GFI FaxMaker notifies the user about the status of sent faxes/SMS by sending a transmission report. The
report contains details of the fax/SMS transmission. Optionally you can configure to include the fax content
and fax body.

Screenshot 75: A sample fax transmission report
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7.3.1 Configuring fax transmission reports
1. From GFI FaxMaker Configuration, right-click Advanced > Transmission reports and select Properties.

Screenshot 76: Fax transmission report options

2. Configure the following options:

Option Description

Report successful
outgoing FAX
transmissions

Send a transmission report when a fax is sent successfully.

Include attachments
with success reports

Includes the transmitted fax with successful transmission reports.

Report failed
outgoing FAX
transmissions

Send a transmission report when a fax fails.

Include attachments
with failure reports

Includes the fax content with failed transmission reports.

Append original
message body

Include the original fax message body in the transmission report, below the report text. Using
this option allows users to re-submit faxes and find sent faxes.

Send one summary
report when faxing to
multiple recipients

When sending a fax to multiple recipients, GFI FaxMaker sends the fax to each recipient indi-
vidually. Select this option to group transmission reports in one summary report. When unse-
lected, a transmission report is sent for each fax recipient.

3. ClickOK.
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7.3.2 Configuring SMS transmission reports
1. From GFI FaxMaker Configuration, right-click Advanced > Transmission reports and select Properties.

Screenshot 77: SMS transmission report options

2. From the SMS tab, configure:

Option Description

Report successful out-
going SMS trans-
missions

Send a transmission report when an SMS is sent successfully.

Send one summary
report when sending
SMS to multiple recip-
ients

When sending an SMS to multiple recipients, GFI FaxMaker sends the SMS to each recip-
ient individually. Select this option to group transmission reports in one summary report.
When unselected, a transmission report is sent for each SMS recipient.

NOTE
A report is always sent if transmission of SMS fails.

3. ClickOK.

7.3.3 Customizing transmission reports
The template of transmission reports can be customized. To do this:

1. Navigate to <GFI FaxMaker installation folder>\data\reports.

2. Open the template to edit in Notepad:
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Report template Description

error.fbt Transmission report for failed faxes

recv.fbt Fax report for received faxes

sent.fbt Fax report for sent faxes

smserror.fbt Transmission report for failed SMS

smsrecv.fbt Fax report for received SMS

smssent.fbt Fax report for sent SMS

summarysent.fbt Summarized transmission report when a fax is sent to multiple recipients.

summarysent_
details.fbt

The details of failed fax transmissions. This section is appended to summarysent.fbt for each
failed transmission.

3. Modify the file using the following fields. Some fields may not be applicable for certain reports.

NOTE
Reports starting with html prefix (for example, htmlrecv.fbt), are the equivalent reports in HTML format.
In this case use square brackets [ and ] for fields instead of angled brackets.

Field Description

<status> Transmission status

<date> Transmission date

<time> Transmission time

<date_time> Shows both transmission date and time

<speed> Transmission speed

<connection_time> Duration of transmission

<pages> Number of pages sent

<total_pages> Total number of pages requested to be sent

<resolution> The fax resolution.

<remote_id> Recipient’s line number

<local_id> Local line number

<line> GFI FaxMaker line number.

<retries> Number of retries that GFI FaxMaker tried to establish connection with recipient.

<description> A description of the status of fax transmission.

<dtmf_did> The DTMF/DID number.

<subject> The subject of the email requesting the fax transmission.

<billing_code> The billing code.

<r_last_name> Recipient’s last name

<r_first_name> Recipient’s first name

<r_name> Recipient’s display name



GFI FaxMaker 7 Configuration - Sending faxes | 134

Field Description

<r_company> Recipient’s company name

<r_department> Recipient’s department

<r_email> Recipient’s email address

<r_fax> Recipient’s fax number

<r_voice> Recipient’s phone number

<s_last_name> Sender’s last name

<s_first_name> Sender’s first name

<s_name> Sender’s name

<s_company> Sender’s company name

<s_department> Sender’s department

<s_email> Sender’s email address

<s_fax> Sender’s fax number

<s_voice> Sender’s phone number

<total_faxes> Total number of faxes (summary reports only)

<succeeded_sendings> Number of faxes sent successfully (summary reports only)

<failed_sendings> Number of faxes that failed transmission (summary reports only)

7.4 Header/Footer options
GFI FaxMaker enables you to customize the header and footer text for all outgoing and incoming faxes.

7.4.1 Outgoing faxes
1. From GFI FaxMaker Configuration, right-click Advanced > Header/Footer/Stamping and select
Properties.
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Screenshot 78: Header/Footer options for outgoing faxes

2. From the Header/Footer tab, configure:

Option Description

Formatting and alignment Configure font, font size and alignment.
NOTE: During configuration, select the header and footer fields configuring to
apply different formatting.

Render this header text on all
outgoing faxes

Select to add a header on all outgoing faxes. Key in the text to display.
Set to default - Click to reset text to default.
Insert field... - Select custom field to add where there is the cursor.

Render this footer text on all
outgoing faxes

Select to add a footer to all outgoing fax. Key in the text to display.
Set to default - Click to reset text to default.
Insert field... - Select custom field to add where there is the cursor.

3. ClickOK.

7.4.2 Incoming faxes
1. From GFI FaxMaker Configuration, right-click Advanced > Header/Footer/Stamping and select
Properties.



GFI FaxMaker 7 Configuration - Sending faxes | 136

Screenshot 79: Stamping options for incoming faxes

2. From the Stamping tab, configure:

Option Description

Formatting and alignment Configure font, font size and alignment.
NOTE: During configuration, select the header and footer fields configuring to
apply different formatting.

Render this header text on all
incoming faxes

Select to add a header on all incoming faxes. Key in the text to render.
Set to default - Click to reset text to default.
Insert field... - Select custom field to add where there is the cursor.

Render this footer text on all
incoming faxes

Select to add a footer on all incoming faxes. Key in the text to render.
Set to default - Click to reset text to default.
Insert field... - Select custom field to add where there is the cursor.

3. ClickOK.

7.5 Coverpages
GFI FaxMaker enables you to include a front page to your fax content that includes custom information and
design. This page is attached and sent as the first page of a fax.

The coverpage typically includes important fax details (such as recipient and sender’s information) and the
message text (email body when user sends email via email client or fax message form).

By default, GFI FaxMaker includes a number of built-in coverpages. To access the list of coverpages, from
GFI FaxMaker Configuration navigate to Coverpages node and selectCoverpages or Front Covernotes.

Configuring coverpage settings:
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General coverpage options - enable/disable coverpages and conditions when to send a coverpage.

Adding new coverpages - add new and custom coverpages.

Default coverpage - the coverpage applied for all users that have no other coverpage configured.

Custom user coverpages - use different coverpages for different users or user groups.

Editing built-in coverpages - how to modify built-in coverpages.

Preview built-in coverpage - preview built-in coverpages in web browser or editor.

Coverpagemerge-fields - list of supported fields used to display useful fax information.

A Front Covernote complements a coverpage and is aimed to add a brief message before the coverpage
(similar to a ‘With Compliments’ note). For more information, refer to Front Covernotes (page 142).

General coverpage options

1. From GFI FaxMaker Configuration, right-clickCoverpages > Coverpages and select Properties.

Screenshot 80: Coverpage options

2. Configure the following options:

Option Description

Send coverpages Enable or disable coverpages.
NOTE: Disabling coverpages from the Coverpages properties dialog box also
disables Front Covernotes.
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Option Description

Only if message text is present Include a coverpage only when sending a fax that contains a message body (for
example, when sending a fax as an attachment via email and the email also
contains an email body).

Use this coverpage when no
default coverpage is associated
with a user

Select the default coverpage to use when a user does not have a custom
coverpage configured.

3. From the Rendering tab set the coverpage margins (in Inches).

4. ClickOK.

Adding new coverpages

Step 1: Create coverpage

You can create custom coverpages in HTML, RTF or MHT format, using custom designs, text and fields.
Use your preferred editor to create the page.

NOTE
1. You can use fields to display useful information. For more information, refer to Supportedmerge-
fields (page 140).
2. Use UTF-8 encoding for HTML coverpages.

Step 2: Add coverpage to GFI FaxMaker

1. From GFI FaxMaker Configuration, navigate to Coverpages > Coverpages.

Screenshot 81: Creating a new coverpage

2. ClickNew….

3. Key in a Display name.

4. Click Add from file…, browse to the newly created coverpage and clickOpen.

5. ClickOK.

6. Add any particular users to apply this coverpage for.

7. ClickOK.
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Default coverpage

The default coverpage is the coverpage applied for all users that have no other coverpage configured. To
specify a default coverpage:

1. From GFI FaxMaker Configuration navigate to Coverpages > Coverpages.

2. Right-click the coverpage and select Set as default global coverpage.

Using a custom coverpage for a list of users

GFI FaxMaker can use different coverpages for different users or user groups. To apply a custom
coverpage for a particular user or user group:

1. From GFI FaxMaker Configuration, navigate to Coverpages > Coverpages.

2. Right-click the coverpage to associate custom user for and select Properties.

Screenshot 82: Coverpage users

3. From the Users tab add the users for which to apply the coverpage.

4. ClickOK.

Editing built-in coverpages

1. From GFI FaxMaker Configuration navigate to Coverpages > Coverpages.

2. Right-click the coverpage to edit and select Properties.
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Screenshot 83: Coverpage options tab

3. From theOptions tab, click Edit. Coverpage is loaded in text editor.

4. Edit the page as required.

NOTE
When editing coverpages, you can use fields to show custom information. For more information, refer to
Supportedmerge-fields (page 140).

5. Save and exit when complete.

6. ClickOK.

Previewing built-in coverpages

To preview coverpages, navigate to <GFI FaxMaker installation folder>\coverpage\. Double-click
coverpage to preview in web browser (HTML or MHT format) or word editor (RTF format).

7.5.1 Supported merge-fields
The following fields are used in coverpages and front covernotes to display useful fax information.

NOTE
All fields must be in lower case.
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Sender’s details

Field Description

[s_last_name] Sender’s last name

[s_first_name] Sender’s first name

[s_name_fl] Sender’s first & last name

[s_name_lf] Sender’s last & first name

[s_company] Sender’s company name

[s_department] Sender’s department name

[s_fax] Sender’s Fax number

[s_voice] Sender’s telephone number

[s_e-mail] Sender’s email address

Table 2: Coverpage merge fields - sender’s details

Recipient’s details

Field Description

[r_company] Recipient’s company name

[r_department] Recipient’s department name

[r_first_name] Recipient’s first name

[r_last_name] Recipient’s last name

[r_name_fl] Recipient’s first & last name

[r_name_lf] Recipient’s last & first name

[r_fax] Recipient’s Fax number

[r_voice] Recipient’s telephone number

[r_e-mail] Recipient’s email address

Table 3: Coverpage merge fields - recipient’s details

Other fields

Field Description

[message] Show the email body text.
NOTE 1: Ensure enough space is allocated to fit in the email body.
NOTE 2: Emails normally include plain text and HTML formats for backward compatibility. By default, GFI
FaxMaker shows the HTML version. To choose the preferred format, right-click Coverpages node in GFI
FaxMaker and select the preferred format.

[time] Fax transmission time

[date] Fax transmission date

[longdate] Fax transmission date and time.

[subject] Shows the email subject

Table 4: Coverpage merge fields
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Field Description

[total_
pages]

Total number of fax pages, including the coverpage.

7.6 Front Covernotes
A front covernotes are aimed to contain less details than a Coverpage, Front covernotes serve to add a brief
message before the coverpage (similar to a ‘With Compliments’ note).

By default, GFI FaxMaker includes a number of built-in front covernotes. To access the list of front
covernotes, from GFI FaxMaker Configuration navigate to Coverpages node and select Front Covernotes.

NOTE
Front covernotes are aimed to compliment coverpages. Disabling Coverpages, disables also Front
covernotes.

Configuring front covernote settings:

General front covernote options - enable/disable front covernotes and set covernote margins.

Adding new front covernote - add new and custom front covernotes.

Default front covernote - the front covernote applied for all users that have no other front covernote con-
figured.

Custom user front covernotes - use different front covernotes for different users or user groups.

Front covernotemerge-fields - list of supported fields used to display useful fax information.

General front covernotes options

1. From GFI FaxMaker Configuration, right-clickCoverpages > Front covernotes and select Properties.
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Screenshot 84: Front covernote options

2. Configure the following options:

Option Description

Use front
coverpage

Select this option to always send a front covernote for emails sent by all users. Specify the Front
covernote to use when the user does not have a custom associated front covernote configured.
By disabling this option, GFI FaxMaker only sends a covernote for faxes originating from users who have
a Front covernote configured.

3. From the Rendering tab set the covernote margins (in Inches).

4. ClickOK.

Adding new Front covernotes

Step 1: Create Front covernote

You can create custom Front covernotes in HTML, RTF or MHT format, using custom designs, text and
fields. Use your preferred editor to create the page.

NOTE
1. You can use fields to display useful information. For more information, refer to Supportedmerge-
fields (page 140).
2. Use UTF-8 encoding for HTML Front covernotes.

Step 2: Add covernote to GFI FaxMaker

1. From GFI FaxMaker Configuration navigate to Coverpages > Front covernotes.
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Screenshot 85: Creating a new front covernote

2. ClickNew….

3. Key in a Display name for the covernote.

4. Click Add from file…, browse to the newly created coverpage and clickOpen.

5. ClickOK.

6. Add any particular users to apply this covernote for.

7. ClickOK.

Default Front covernote

The default Front covernote is the covernote applied for all users that have no other covernote configured.
To select a different default covernote:

1. From GFI FaxMaker Configuration navigate to Coverpages > Front covernotes.

2. Right-click the covernote and select Set as default global front covernote.

Using a custom Front covernote for a list of users

GFI FaxMaker can use different Front covernotes for different users or user groups. To apply a custom front
covernote for a particular user or user group:

1. From GFI FaxMaker Configuration navigate to Coverpages > Front covernote.

2. Right-click the covernote to associate custom user for and select Properties.
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Screenshot 86: Front covernote users

3. From the Users tab add the users to apply the covernote for.

4. ClickOK.

7.7 Call blocking
Call blocking enables you to control the fax numbers to which users can send faxes. GFI FaxMaker checks
the call block rules before fax transmission to block faxes sent to numbers starting with matching entries.

For example, to block specific users from sending faxes to international numbers, add a call blocking rule to
your international dial prefix (example, 00 or 011).
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Screenshot 87: Call blocking rules

1. From GFI FaxMaker Configuration, navigate to Advanced > Call blocking node.

2. ClickNew….

Screenshot 88: New call block entry

3. Key in the number to block and clickOK.

4. Assign users to the configured Call block or leave empty to apply the rule to every user.

5. ClickOK.

7.8 Dialling Options
Dialling options enable you to configure area codes and other special dialing procedures. This ensures that
GFI FaxMaker processes the fax number in a structured manner and dials numbers in the correct format for
the phone system.
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NOTE
1. GFI FaxMaker can only apply dialling configurations for fax numbers that are entered in the following
format: +<country code> (<area code>) <fax number>. For example, +44 (0) 555 5555, +1 (151)
5555 5555, +356 2555 5555
2. Dialling options are not applied when sending faxes through online fax services.

To configure dialling options, from GFI FaxMaker Configuration right-click Advanced > Dialling >
Properties.

Screenshot 89: Dialing options

IMPORTANT
Customize options for your country’s telephone dialling system. Failure to do so may cause fax
transmission to fail.

Configure the following options:

Option Description

My country
code is

Key in your country telephone code, excluding the international dial prefix (the dial prefix is usually
defined as +). For example, for the United States the country code is 1.
NOTE: The dial prefix is the number that a user must dial to place an international call. The country
code is the number identifying the country to call to.

My area
code is

Key in your area code.
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Option Description

International
dialling

Configure dialling options for sending faxes to international recipients. GFI FaxMaker identifies a call
as international when the number contains a + (dial prefix) in front of the number.
Configure the following options:

If dial string starts with my country code, strip it off - select this option to automatically remove the
country code from the number when dialling a number containing the local country code. If numbers
match this condition, a custom prefix can be added to the number.

If dial string does not start with my country code - select this option to replace the + symbol with
the international dial prefix, that is, the number required to place an international call from your coun-
try/area/telephone service provider, for example 00, 010, 0011, 011, etc...

National
dialling

Configure dialling options when sending faxes within the same country but to a different area. GFI
FaxMaker identifies a call as national when an area code is included in a number in round
parenthesis, for example, (234)-56789012.
Configure the following options:

If dial string contains my area code, strip it off - select to automatically remove area code from the
number when dialling a number containing the local area code. If numbers match this condition, a cus-
tom prefix can be added to the number.

If dial string does not contain my area code - select to add a custom prefix when dialling a
national number.

NOTE: The area code in the fax number must be included in round parentheses for the fax server to
determine which part of the number is the area code.

Exceptions Some national dialling procedures can be more complex and some exceptions may be required, for
example to handle multiple local area codes. Exceptions allow you to add a prefix and/or exclude an
area code when a number matches a particular combination.
1. Click Exceptions.
2. Key in the Area code for which to apply an exception.
3. If exception is required for a particular exchange number (number right after the area code), key in
the Exchange number, or key in * to apply for all numbers in that area code.
4. To add a prefix before the area code, select Dial prefix before the area code and key in the prefix.
5. To not dial the area code, select Do not dial the area code.
6. Click Add.
7. Repeat procedure for all exceptions.
NOTE: Use commas to add a delay between numbers, if required. Each comma represents
approximately a two second delay.
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7.9 Customizing the caller ID and TSID of outbound faxes
When sending faxes, GFI FaxMaker sets the caller ID (CLIP) to the sender's fax number as configured in
Active Directory or GFI Directory, and the TSID value to the Local Fax ID specified in the fax line settings.
GFI FaxMaker enables administrators to change these default values.

Setting CLIP/TSID to sender's fax number

Appending a custom domain to the CLIP value of outbound faxes

Setting CLIP to the local fax line ID

NOTES

Before applying any changes, it is recommended to check how your PABX and your tele-
communications service providers handle custom CLIP and TSID values. Certain telephony systems or
providers may override or block custom CLIP and TSID values.

These customizations require changes to Windows registry. Problems may occur if you modify the
registry incorrectly. Do not edit the Windows registry unless you are confident about doing so.

7.9.1 Setting CLIP/TSID to sender's fax number
This topic describes how to change the CLIP or TSID values of outbound faxes to the sender's fax number
as configured in Active Directory.

NOTES

Before applying any changes, it is recommended to check how your PABX and your tele-
communications service providers handle custom CLIP and TSID values. Certain telephony systems or
providers may override or block custom CLIP and TSID values.

These customizations require changes to Windows registry. Problems may occur if you modify the
registry incorrectly. Do not edit the Windows registry unless you are confident about doing so.

To customize TSID and caller ID values of outbound faxes:

1.Open the Registry Editor on the GFI FaxMaker server.

2.Navigate to the following folder:

32-bit: HKEY_LOCAL_MACHINE\SOFTWARE\GFI Fax & Voice\FAXmaker\Config

64-bit: HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\GFI Fax & Voice\FAX-
maker\Config

3.Create a DWORD value in this location called UseSenderFaxNumber.

4.Change the value of the newly created UseSenderFaxNumber DWORD as follows:

DWORD value Description

0 CLIP: Not set
TSID: Local Fax ID as configured in the fax line settings screen.

1 CLIP: Sender's fax number as configured in Active Directory or GFI Directory.
TSID: Local Fax ID as configured in the fax line settings screen.

NOTE: This is the default configuration if the UseSenderFaxNumber key is not set.
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DWORD value Description

2 CLIP: Not set
TSID: Sender's fax number as configured in Active Directory or GFI Directory

3 CLIP: Sender's fax number as configured in Active Directory or GFI Directory.
TSID: Sender's fax number as configured in Active Directory or GFI Directory.

6 CLIP: Not set
TSID: Sender's fax number as configured in Active Directory or GFI Directory, without any

spaces.

7 CLIP: Sender's fax number as configured in Active Directory or GFI Directory, without any
spaces.

TSID: Sender's fax number as configured in Active Directory or GFI Directory, without any
spaces.

NOTE
When using options 2, 3, 6 or 7 but a fax number is not set in Active Directory or GFI Directory, the TSID
value is set to the Local Fax ID as configured in the fax line settings screen.

5.Close the Registry Editor.

6.Restart the Fax Server service from the Services applet to apply changes.

7.9.2 Appending a domain to CLIP
This topic describes how to append a custom domain name to the CLIP value of outbound faxes. This is
sometimes required by certain FoIP systems.

NOTES

Before applying any changes, it is recommended to check how your PABX and your tele-
communications service providers handle custom CLIP and TSID values. Certain telephony systems or
providers may override or block custom CLIP and TSID values.

These customizations require changes to Windows registry. Problems may occur if you modify the
registry incorrectly. Do not edit the Windows registry unless you are confident about doing so.

To appending a domain to the CLIP value of outbound faxes:

1.Open the Registry Editor on the GFI FaxMaker server.

2.Navigate to the following folder:

32-bit: HKEY_LOCAL_MACHINE\SOFTWARE\GFI Fax & Voice\FAXmaker\Config

64-bit: HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\GFI Fax & Voice\FAX-
maker\Config

3.Create a STRING value in this location called AppendDomainToClip.

4.Change the value of the newly created AppendDomainToClip registry key to the domain that needs to
be appended with outbound fax CLIP numbers. For example, if the value is set to example.com then the
CLIP of outbound faxes is set to 123456@example.com. The @ symbol is automatically added by GFI
FaxMaker.

5.Close the Registry Editor.

6.Restart the Fax Server service from the Services applet to apply changes.
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7.9.3 Setting CLIP to the local fax line ID
This topic describes how to change the CLIP values of outbound faxes to the Local Fax ID as configured in
the fax line settings screen.

IMPORTANT
If key UseSenderFaxNumber is set, then the UseLocalIdForClipkey is ignored, since
UseSenderFaxNumber takes precedence. For more information, refer to Setting CLIP/TSID to
sender's fax number (page 149).

NOTES

Before applying any changes, it is recommended to check how your PABX and your tele-
communications service providers handle custom CLIP and TSID values. Certain telephony systems or
providers may override or block custom CLIP and TSID values.

These customizations require changes to Windows registry. Problems may occur if you modify the
registry incorrectly. Do not edit the Windows registry unless you are confident about doing so.

To set the CLIP to the local fax ID of the line used to transmit the fax:

1.Open the Registry Editor on the GFI FaxMaker server.

2.Navigate to the following folder:

32-bit: HKEY_LOCAL_MACHINE\SOFTWARE\GFI Fax & Voice\FAXmaker\Config

64-bit: HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\GFI Fax & Voice\FAX-
maker\Config

3.Create a DWORD value in this location called UseLocalIdForClip.

4.Change the value of the newly created UseLocalIdForClip DWORD to:

DWORD
value

Description

0 (Default) This is the default configuration, where the CLIP value is set to sender's fax number as configured in Act-
ive Directory or GFI Directory.

1 When set to 1, the CLIP value is set to the Local Fax ID as configured in the fax line settings screen.

5.Close the Registry Editor.

6.Restart the Fax Server service from the Services applet to apply changes.

7.10 Public contacts
Configure Public Contacts to enable GFI FaxMaker to retrieve the recipient information in Microsoft
Exchange environments.

NOTE
Configure Public Contacts when showing recipient information on cover pages or when using the email
client to send faxes. If none of these are required, Public Contacts does not have to be configured.

Configure Public Contacts depending on your Microsoft Exchange version:
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Microsoft Exchange 2010/2013/2016

1. Ensure that you have a working profile, configured as the default profile, to connect to your Microsoft
Exchange Server.

2. From GFI FaxMaker Configuration, right-click Advanced > Public Contacts and select Properties.

Screenshot 90: Public contacts node

3. Select Enable Exchange Public Contacts retrieval.

4. SelectWeb Services.

5.Choose how to discover and connect to Microsoft Exchange:

Auto-discover Exchange Server: Attempt to automatically detect and connect to Microsoft
Exchange. Key in a valid email address and clickDiscover.

Enter server details automatically: Specify the Microsoft Exchange information manually. Key
in the server fully qualified domain name or IP address. Also specify a valid username or email
address and password. Click Test to ensure that GFI FaxMaker can connect to the specified server
using the details entered.

6.ClickOK.

7. Select the public contacts list from where to retrieve company information and clickOK.

8.Click Add to add more public contacts lists.
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9.Click Test to ensure that GFI FaxMaker can query the listed public contacts folders.

10.ClickOK.

NOTE
When adding multiple lists, arrange the list order usingMove up andMove down buttons. GFI
FaxMaker queries lists in the displayed order when matching contacts.

7.11 NetPrintQueue2FAX
NetPrintQueue2FAX is a printer driver installed on user machines. This enables users to print content to
transmit by fax, directly from any application that supports printing.

For more information about which file types can be used with NetPrintQueue2FAX refer to
http://go.gfi.com/?pageid=FM_NPQ2FFileFormats

How it works

1.Users prepare content to fax using a third-party application (for example, Microsoft®Word® or an
invoicing software). The fax recipient details - number, name and company - must be embedded in the con-
tent.

2.Users print content to the NetPrintQueue2FAX printer driver. Ensure that the NetPrintQueue2FAX printer
drivers are installed on user machines. For more information, refer to Installing NetPrintQueue2FAX
printer driver on clients’ machines (page 156).

3.NetPrintQueue2FAX sends content to GFI FaxMaker.

4.GFI FaxMaker analyzes the content to determine fax recipient details. For more information, refer to Con-
figuring NetPrintQueue2FAX options (page 154).

5.GFI FaxMaker sends fax.

HINT
You can use this method to automatically send a custom fax to a number of recipients. For example,
through Microsoft®Word®Mail Merge feature you can send a personalized fax to a large number of
recipients. For more information, refer to Sending faxes usingMicrosoft WordMail Merge (page 156).

http://go.gfi.com/?pageid=FM_NPQ2FFileFormats
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Screenshot 91: A document ready to be printed to NetPrintQueue2FAX

7.11.1 Configuring NetPrintQueue2FAX options
GFI FaxMaker needs to be configured to determine the identifiers for recipient details. For example,
configure GFI FaxMaker so that the text following the string Fax: is the recipient’s fax number.

To configure recipient identifiers:

1. From GFI FaxMaker Configuration, right-clickNetPrintQueue2FAX and select Properties.
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Screenshot 92: NetPrintQueue2FAX configuration

2. Configure the following options:

Option Description

Enable
NetPrintQueue2FAX

Enable/Disable NetPrintQueue2FAX feature

Recipient Key in the text that identifies recipient’s name. Default value is To:.

Company Key in the text that identifies recipient’s company name. Default value is Company:.

Fax number Key in the text that identifies recipient’s fax number. Default value is Fax:.

End of field
terminator

After GFI FaxMaker finds a search field and retrieves the string that comes after the search
string, it needs to identify the end of the search string. To do this, either do not put more text
following that line or use a special character to determine the end of the field. To use a field
terminator, select this option and key in a terminator.

Case sensitive
search

Use this option to choose whether to match the case of field identifiers.

3. ClickOK.

NOTE
If GFI FaxMaker fails to find the search fields in the document, the fax is not sent and GFI FaxMaker
sends an error report to the user.
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7.11.2 Installing NetPrintQueue2FAX printer driver on clients’ machines
Install the printer driver on the client’s machines to enable users to use NetPrintQueue2FAX feature. This
procedure is the same as adding any other Windows® network printer driver.

To install the NetPrintQueue2FAX printer driver on Windows® 7/8/10:

1. From Control Panel selectHardware and Sound > Devices and Printers > Add Printer > Add a
network, wireless or Bluetooth printer and clickNext.

2. Select NetPrintQueue2Fax printer from the list of found printers, or click The printer that I want isn’t
listed to manually type the path of NetPrintQueue2Fax using the format
\\FaxServerName\NetPrintQueue2Fax.

NOTE
If GFI FaxMaker is installed on a 64-bit machine, the driver needs to be located manually:
a. ClickOK in the No driver found dialog to locate the driver manually.
b. Browse to the GFI FaxMaker server and open shared folder NetPrintQueue2Fax_Drivers.
c. Select npqf.inf and click Open to install the driver.
d. Windows®will verify the publisher of the driver software. Click Install this driver software anyway to
proceed.

3. Click Finish to add the NetPrintQueue2Fax printer to the list of printers.

7.11.3 Sending faxes using Microsoft Word Mail Merge
NetPrintQueue2Fax can be used to send out fax broadcasts from Microsoft Word, using the Mail Merge
feature.

Mail Merge is a feature in Microsoft Word that enables users to author one template that can be used to
produce customized and personalized documents. A template contains fields that are then automatically
filled in from a data source.

Step 1: Creating the mail merge

1.Create a new document.

2. From the Mail Merge feature settings, add the fax recipients list. Key in the list or import the recipients
from a data source such as a Microsoft Excel spreadsheet or a Microsoft Access database. This is a sample
table containing the recipient information:

Fax Number Name Company
+420313414515 Joe ABC Inc.
+441273123456 John DEF Ltd.
+420313414517 Steve GHI Inc.
+441273123458 Bob JKL Ltd.
+420313414519 Kevin MNO Inc.

3. At the beginning of the document, specify the recipient fields required by GFI FaxMaker to resolve the
recipient. Key in the fields as specified in the NetPrintQueue2Fax configuration screen. For example, cre-
ate a table in the document to show the recipient information as follows:

To: Company: Fax:

4.Next to each label, insert the applicable Merge field.

To: <<Name>> Company: <<Company>> Fax: <<Fax_Number>>
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5. Type or add any text and graphics to include in your fax. You may insert more merge fields in the content.

6. In a new line at the end of the document, add the characters @#. These 2 characters are referred to as
the fax separator characters, and are required to indicate to GFI FaxMaker that the next page is a new fax.

Step 2: Preview the fax

In Microsoft Word choose to preview the results. When this option is switched on, the merge fields in the
document are populated with real data from your data source. Toggle through each record and verify that
the fields are properly populated.

Step 3: Send the fax

When you are sure that the fax broadcast is ready to be sent, choose to finish and print the merged
documents. Select the NetPrintQueue2Fax printer driver and click Print.

NetPrintQueue2Fax submits the print job to GFI FaxMaker, which in turn prepares the documents for
transmission. Track the status of the submitted faxes from theGFI FaxMaker Monitor and from email
notifications.

7.11.4 Using Text API commands in NetPrintQueue2Fax
In addition to embedding recipient information in the document, further commands can be embedded at the
top of a document to be sent using NetPrintQueue2Fax. Amongst others, this enables scheduling a fax and
specifying fax resolution.

To do this, enter commands at the top of the document, for example
::priority=high,billingcode=1234

GFI FaxMaker automatically removes these commands on detection.

For more information regarding the Text API commands refer to the GFI FaxMaker API manual available
from: http://go.gfi.com/?pageid=FM19help&lang=en#cshid=APImanual.

7.12 GFI FaxMaker APIs
With APIs you can integrate your third party software with GFI FaxMaker.

This process automation can be used for a wide variety of industries and applications, such as healthcare,
retail and banking.

For example, use XMLAPI with your invoicing software to create an XML report template for account
statements and balances. Periodically, generate this report for each client that owes money and store it to
the XMLAPI pickup folder. GFI FaxMaker automatically transmits the statements to their intended
recipients.

Types of APIs available in GFI FaxMaker:

XMLAPI Send faxes or SMS using XML files. You can configure third party software to generate APIs automatically
and transmit faxes in bulk. GFI FaxMaker picks up and transmits all xml files stored in a custom XMLAPI
pickup folder.
XMLAPIs must be formatted to a standard convention, using fields and parameters which GFI FaxMaker
can use to process faxes and SMS. For more information refer to the GFI FaxMaker API Manual.

TextAPI Send faxes using plain text files. You can configure third party software to generate APIs automatically and
transmit faxes in bulk. GFI FaxMaker picks up and transmits all text files stored in a custom TextAPI pickup
folder.
TextAPIs must be formatted to a standard convention, using fields and parameters which GFI FaxMaker can
use to process faxes and SMS. For more information refer to the GFI FaxMaker API Manual.

http://go.gfi.com/?pageid=FM19help&lang=en#cshid=APImanual
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Web
Service
API

The GFI FaxMaker Web Service API enables you to develop your own applications that can connect directly
with GFI FaxMaker. You can then send and receive faxes directly from your application. For more inform-
ation refer to the GFI FaxMaker API Manual.

7.12.1 Enabling TextAPI
To enable and configure TextAPI:

1. From GFI FaxMaker Configuration, right-click Advanced > Text-API/XMLAPI node and select
Properties.

Screenshot 93: Enabling TextAPI

2. From TextAPI tab, configure the following options:

Option Description

Enabled Enables TextAPI.

Folders to
scan

Specify the folders where Text APIs will be stored for GFI FaxMaker to process. Click Add to select
folders. To run recursive TextAPIs scanning on sub-folders, select Include Subfolders.

Store all
response
files in one
folder

After processing a TextAPI which does not have the FROM parameter specified, GFI FaxMaker creates
a response file. By default, GFI FaxMaker stores response files in the pickup folders. To store all
response files in one location, select this option and specify a location.

Format text
using
coverpage

Select the coverpage to use for TextAPI faxes. For more information, refer to Coverpages (page 136).
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3. ClickOK.

Next step: Start creating TextAPIs. For more information refer to the GFI FaxMaker API Manual.

7.12.2 Enabling XMLAPI
To enable and configure XMLAPI:

1. From GFI FaxMaker Configuration, right-click Advanced > Text-API/XMLAPI node and select
Properties.

Screenshot 94: Enabling XMLAPI

2. From XMLAPI tab, click Enabled to switch on XMLAPI.

3. Click Add to select the folders where XMLAPIs will be stored. To also check sub-folders for XMLAPIs,
select Include Subfolders.

4. After processing an XMLAPI, GFI FaxMaker creates a response file (*.status extension). By default, GFI
FaxMaker stores response files in the pickup folders. To store all response files in one location, select Store
all response files in one folder and specify a location.

5. ClickOK.

Next step: Start creating XML APIs. For more information refer to the GFI FaxMaker API Manual.

7.13 Billing
GFI FaxMaker enables you to enforce the use of billing codes when sending faxes. Users or groups of users
use a particular billing code to send faxes. This allows the administrator to monitor fax usage by codes.

To use billing codes, when sending faxes, users add the following API command to the fax:
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::b=<billing number> or ::billingcode=<billing number>

Replace <billing number> with the billing number assigned to the user. For example:

::b=22343

NOTE
1. Faxes without billing codes are not sent if this feature is enabled.
2. When sending faxes via email, billing codes can be included in the email subject. Key in the command
enclosed in square brackets. For example, [::b=123456].

To enforce use of billing codes:

1. From GFI FaxMaker Configuration, right-click Billing and select Properties.

Screenshot 95: Enforcing billing options

2. Select Every fax sent must include a billing code.

3. ClickOK.
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8 Configuration - Receiving faxes
This topic contains information about:

8.1 Receiving Options 161

8.2 Fax routing 162

8.3 Printers 174

8.4 Junk Fax filter 176

8.1 Receiving Options
To configure fax receiving options:

1. From GFI FaxMaker Configuration, right-click Sending/Receiving Options and select Properties.

Screenshot 96: Receiving options

2. From the Receiving tab, configure the following options:
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Option Description

Cut long pages to standard page
size

If a received page is longer than 1.5 times the selected page size, page is cut to
the selected size.

Paper size threshold Select the paper size for the received faxes. Incoming faxes more than 1.5 times
the paper size, are automatically cut to the selected size.

Route incoming faxes in the
following attachment format

Select the format in which received fax files are stored and forwarded to
recipients.

3. ClickOK.

8.2 Fax routing
Fax routing enables GFI FaxMaker to determine the correct recipient of an incoming fax. When a fax is
received, GFI FaxMaker routes the fax to it's intended recipient.

GFI FaxMaker provides several methods for this, each with its advantages and disadvantages. Typically,
DID routing is recommended for larger installations, while MSN and Line routing are recommended for
smaller installations.

Select the type of routing to use:

Routing method Description

DID/DTMF Routing
(ISDN/Analog/Digital)

Through DID routing, the telecommunications provider assigns you a range of virtual numbers
that enable individual users/printers/public folders to have their own fax numbers, without the
need of a physical fax line for each.
For more information, refer to DID/DTMF Routing (ISDN/Analog/Digital) (page 162).

MSN Routing
(ISDN only)

Route received faxes based on the line MSN number.
For more information, refer to MSN routing (page 164).

OCR Routing Route incoming faxes depending on the fax’s text content. Fax pages are converted to text
using OCR technology and text is searched for the user's first and last name and/or other
configurable text phrases.
For more information, refer to OCR routing (page 164).

Line Routing Route faxes based on the fax line that the fax was received on.
For more information, refer to Line routing (page 166).

CSID Routing Caller Sender Identification routing uses the sender’s fax machine ID to route faxes to
particular users.
For more information, refer to CSID routing (page 167).

8.2.1 DID/DTMF Routing (ISDN/Analog/Digital)
Through DID routing, the telecommunications provider assigns you a range of virtual numbers that enable
individual users/printers/public folders to have their own fax numbers, without the need of a physical fax line
for each. If you already have ISDN you can use available lines from your PBX. On answering the fax call, the
ISDN protocol passes the number on which the call is being answered to GFI FaxMaker.

Pre-requisites

Configure the number of DID/DTMF digits to capture from the GFI FaxMaker device settings. From GFI
FaxMaker Lines/Devices node, open the properties of the DID/DTMF device. Navigate to the Advanced
tab and configure the Number of DTMF/DID digits to capture.

Adding DID/DTMF routes one-by-one

1. From GFI FaxMaker Configuration, right-clickRouting > DTMF/DID and selectNew….
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Screenshot 97: Creating a new DID route

2. Configure the following options:

Option Description

DTMF/DID numbers/ranges Key in the users’ routing number (or virtual fax number).
For example, for a 4 digit DID, enter the last 4 numbers.

Set number of DTMF/DID digits to Select this option to set the minimum number of digits for each number.
For example, if this value is 4 digits, number 1 is noted as 0001.

3. ClickOK and repeat for all DTMF/DID numbers/ranges.

For each rule created, configure how to process the received faxes:

Routing rule recipients

Automatically print incoming faxes

Backing up received faxes

Excluding routing rule from archiving

Importing a range of DID routes

GFI FaxMaker can import a large number of DTMF/DID numbers and associated users from a CSV or TXT
file in the following format:

"DTMF/DID number", "user1", "user2", "user3", …

For example: "1234", "John Doe", "Bill Smith", "Roger Brown", "Joe Bloggs"

NOTE
Specify the user name as either the Active Directory display name or the SMTP email address. Ensure
that all user names specified are included in the Licensed Users list.

To import a list of DID numbers:

1. From GFI FaxMaker Configuration, right-clickRouting > DTMF/DID and select Import DTMF/DID
range.

2. Select the CSV or TXT file containing the data to be imported.

3. ClickOpen.
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Exporting a range of DID routes

To export the list of DID numbers and associated user names in CSV format:

1. From GFI FaxMaker Configuration, right-clickRouting > DTMF/DID and select Export DTMF/DID
range.

2. Select the location where to export the list and specify a file name.

3. Click Save.

The list is exported in the following format:

"DTMF/DID number", "user1", "user2", "user3", …

For example: "1234", "John Doe", "Bill Smith", "Roger Brown", "Joe Bloggs"

8.2.2 MSN routing
While similar to DID routing this method uses the available Multiple Subscriber Numbering (MSN) numbers
instead of dedicated DID numbers (ISDN only). Each ISDN line has 1 or more MSN numbers (usually 9)
assigned to it. If your ISDN line has 9 MSN numbers, you can have 9 different routes for a fax.

Pre-requisites

Before adding MSN routes, enter the MSN numbers in the ISDN card Device options. From GFI FaxMaker
Lines/Devices node, open the properties of the DID/DTMF device. Navigate to the Device tab and enter all
the MSN numbers to answer.

Adding MSN routes

1. From GFI FaxMaker Configuration, right-clickRouting > MSN and selectNew….

Screenshot 98: Creating a new MSN route

2. Key in anMSN number for which to customize routing options.

3. ClickOK and repeat for all MSN numbers.

For each rule created, configure how to process the received faxes:

Routing rule recipients

Automatically print incoming faxes

Backing up received faxes

Excluding routing rule from archiving

8.2.3 OCR routing
Optical Character Recognition (OCR) converts received faxes to text and routes faxes to:
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Users assigned a custom set of phrases (OCR route). When a custom phrase is matched, GFI
FaxMaker routes the fax to its configured set of users. For example, route faxes containing text “Attention:
Sales” to the sales department.

Text matching user names within the Licensed users list. For example, GFI FaxMaker forwards a fax con-
taining text “John Smith” to licensed user John Smith.

NOTE
For more information, refer to OCR (page 119).

OCR routing properties

Configure OCR settings to use while processing faxes for routing.

1. From GFI FaxMaker Configuration, right-clickRouting > OCR and select Properties.

Screenshot 99: OCR routing properties

2. Configure the following options:

Option Description

Matching ratio
percentage

The matching ratio is the confidence that GFI FaxMaker needs to have before matching a
keyword or name to a routing rule.
NOTE: The recommended matching ratio is between 60% and 80% since this is dependent on
the fax quality. Poor quality faxes cause OCR to not recognize all the letters and may result in
faxes routed to the wrong users.

Route faxes using
the users’ first and
last names

Automatically routes faxes to users if OCR matches a name with the list of Licensed users.
NOTE: When both a user name and a custom search phrase (OCR route) are found, the custom
search phrase routing overrides the matching user routing.
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3. ClickOK.

Adding an OCR route

1. From GFI FaxMaker Configuration, right-clickRouting > OCR and selectNew….

Screenshot 100: New search phrase - Creating a new OCR search phrase

2. Key in a phrase to search for.

3. ClickOK and repeat for all OCR phrases.

For each rule created, configure how to process the received faxes:

Routing rule recipients

Automatically print incoming faxes

Backing up received faxes

Excluding routing rule from archiving

8.2.4 Line routing
Line routing enables fax routing based on the fax line (Lines/Devices node) that the fax was received.

Adding a line route

1. From GFI FaxMaker Configuration, right-clickRouting > Line and selectNew….

Screenshot 101: Creating a new Line route

2. Select a fax line.

3. ClickOK and repeat for all fax lines.

For each rule created, configure how to process the received faxes:

Routing rule recipients

Automatically print incoming faxes

Backing up received faxes

Excluding routing rule from archiving
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8.2.5 CSID routing
Call Subscriber Identification (CSID) routing routes faxes based on the FAX ID of the sender (the number
that the sender’s FAXmachine/FAX card displays when sending a fax).

NOTE
This method is not recommended since fax senders may hide the CSID.

Adding CSID routes

1. From GFI FaxMaker Configuration, right-clickRouting > CSID, and selectNew….

Screenshot 102: Creating a new CSID route

2. Key in the CSID.

3. ClickOK and repeat for all CSID numbers.

For each rule created, configure how to process the received faxes:

Routing rule recipients

Automatically print incoming faxes

Backing up received faxes

Excluding routing rule from archiving

Importing a range of CSID routes

GFI FaxMaker can import a high number of CSID numbers and associated users from a CSV or TXT file in
the following format:

"CSID", "user1", "user2", "user3", …

For example: "1234", "John Doe", "Bill Smith", "Roger Brown", "Joe Bloggs"

NOTE
Specify the user name as either the Active Directory display name or the SMTP email address. Ensure
that all user names specified are included in the Licensed Users list.

To import a list of CSID routes:

1. From GFI FaxMaker Configuration, right-clickRouting > CSID and select Import CSID….

2. Select the CSV or TXT file containing data to import.

3. ClickOpen.
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Exporting a range of CSID routes

To export the list of CSID numbers and associated user names in CSV format:

1. From GFI FaxMaker Configuration, right-clickRouting > CSID and select Export CSID….

2. Select the location where to export the list and specify a file name.

3. Click Save.

The list is exported in the following format:

"CSID", "user1", "user2", "user3", …

For example: "1234", "John Doe", "Bill Smith", "Roger Brown", "Joe Bloggs"

8.2.6 Received fax recipients
Routing rule transmission reports are sent by GFI FaxMaker to users configured to receive faxes that match
a particular routing rule. Transmission reports provide users with the received fax data, using one of the
following methods:

Fax attached to transmission report

Link to the fax stored in a network share. For more information, refer to Store incoming faxes to a net-
work share (page 171).

For each routing rule created, configure the list of users and the method to deliver the fax data:

Screenshot 103: Users to route incoming faxes to

1. From the routing rule propertiesUsers tab, select one of the following options:
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Option Description

Do not send
transmission report

A transmission report is not sent to users.

Send transmission
report with the fax
attached

A transmission report is emailed to the list of users, with the fax attached to the report.

Save fax and send
transmission report with
link to fax

A transmission report is emailed to the list of users, containing a link of the fax stored on a
network share. For more information, refer to Store incoming faxes to a network share
(page 171).

2. When sending transmission reports, click Add to specify the list of users to whom to send the report to.

3. Click Apply.

8.2.7 Automatically print incoming faxes
Faxes received on particular routing rules can be automatically printed on receipt.

NOTE
Configure printers before using this option. For more information, refer to Printers (page 174).

Screenshot 104: Automatically print fax

1. From the routing rule properties dialog, select the Printers tab.

2. Select Enable fax auto-printing.
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3. From the Select printer list, select the printer.

4. Click Apply.

8.2.8 Backing up received faxes
Faxes received on particular routing rules can be backed up to a folder.

NOTE
1. The file name of each fax backed up contains the fax delivery time-stamp.
2. GFI FaxMaker does not create duplicates for faxes that match two or more routing rules and that
have the same Backup2Folder destination.
3. This feature requires that the target folder can handle 'long file names'. Hard-disk partition formats
that handle long file names include NTFS and FAT32.

Screenshot 105: Automatically backup faxes

1. From the routing rule properties dialog, select the Backup2Folder tab.

2. Select Automatically backup faxes to folder and specify where to backup faxes.

3. Select Backup faxes in this format and select the format in which to store faxes.

4. Click Apply.

8.2.9 Modifying routing rule name/number
To change a CSID, DID/DTMF or OCR route name or number:
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1. From the routing rule properties dialog, select theOptions tab.

2. Change the name or number of the routing rule.

3. Click Apply.

8.2.10 Received faxes that match no routing rule
When a fax matches no routing rule, it is routed to the list of Default Routers.

To configure Default Routers:

1. From GFI FaxMaker Configuration, right-clickRouting, and select Properties.

Screenshot 106: Default fax routers

2. Select the Default Routers tab.

3. Click Add and specify the user/mailbox where to deliver faxes not routed.

4. ClickOK.

8.2.11 Store incoming faxes to a network share
Received faxes can be stored in a shared folder. An email with a link to the saved fax is sent to the
configured routers.

When receiving a fax on a routing rule that uses this option, GFI FaxMaker creates a sub-folder in the share
as follows:

<network share path configured>\yyyy_mm\dd\

Where:
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<network share path configured> - the shared folder where received faxes are stored

yyyy - year

mm - month

dd - day

Step 1: Create network share

Create a shared folder with:

Full access to the GFI FaxMaker account (user credentials specified during installation) in order to be
able to save faxes.

Read permissions to all users that will be accessing faxes on this share.

NOTE
For security reasons, only fax recipients can access stored faxes. For example faxes routed to John
Doe, are only accessible by John Doe.

Step 2: Configure GFI FaxMaker

Specify the network share where routing rules with network sharing enabled store faxes.

1. In GFI FaxMaker Configuration, right-clickRouting and select Properties.

Screenshot 107: Configuring the Network Share path

2. Select the Network Share tab.

3. Specify the network share path (for example, \\MyServer\MyFaxes).
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NOTE
Enter share in UNC format so that users can access it through the network.

4. Click Apply.

8.2.12 Users that receive all incoming faxes
Specify users that should receive all incoming faxes.

NOTE
Use this feature to store all incoming faxes to an exchange store or a public mailbox.

1. From GFI FaxMaker Configuration, right-clickRouting and select Properties.

Screenshot 108: Routing properties - users that receive all incoming faxes

2. Select the Receive all faxes tab.

3. Click Add and specify the user/mailbox that should receive all faxes.

4. ClickOK.

8.2.13 Routing to a public folder in Microsoft® Exchange

GFI FaxMaker can route received faxes to a Microsoft® Exchange public folder so that these are accessible
to everyone or a particular group of users.

For example, route all faxes related to sales to a public folder dedicated to all sales communications and
accessible by all representatives.
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To do this:

1. Create a mail-enabled public folder on your mail server.

NOTE
A dedicated user mailbox may need to be created and configured to forward all faxes to the mailbox.

2. Configure GFI FaxMaker routing options:

Fax routing to
public folder

Description

Faxes that match a
particular routing
rule

Add the public folder mailbox (or the dedicated user mailbox) email address to the routing
rules’ users lists. For more information, refer to Transmission reports (page 130).

Route all received
faxes to public
folder

Add the public folder mailbox (or the dedicated user mailbox) email address to the Receive all
faxes list. For more information, refer to Users that receive all incoming faxes (page 173).

8.2.14 Excluding routing rules from archiving
You can exclude faxes received on particular routing rules from being archived.

1. From the routing rule properties dialog, select theOptions tab.

2. Select Exclude this number/phrase/line from all archiving options.

3. Click Apply.

NOTE
This setting overrides other fax archiving settings. For more information, refer to Fax archiving (page
107).

8.3 Printers
To automatically print incoming faxes, first configure printers and print settings. Then configure routing
options to print to particular printers.

NOTE
Printers must be first added and pre-configured in the operating system’s printers list.

To add printers in GFI FaxMaker:

1. From GFI FaxMaker Configuration, right-click Advanced > Printers and selectNew….

2. Key in a name for the printer.
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Screenshot 109: Configuring printers

3. From theGeneral tab, specify howGFI FaxMaker should resize incoming faxes and the printers to use
for each paper size.

Option Description

Automatically fit to Select how to resize received faxes. Select from:
Nearest size - Resizes fax to the size nearest to the content

received.
A4 only - Resize to A4 paper size
Letter only - Resize to Letter paper size
Legal only - Resize to Legal paper size

A4 printer settings Click ... to select printer for A4 paper size.

Letter printer settings Click ... to select printer for Letter paper size.

Legal printer settings Click ... to select printer for Legal paper size.

4. ClickOK.

8.3.1 Auto-print options
GFI FaxMaker can be configured to never resize incoming faxes and to always print in the same size that a
fax is received.

NOTE
If this option is enabled, faxes larger than the printer’s paper size will not fit and some areas may not be
printed.

1. From GFI FaxMaker Configuration, right-click Advanced > Miscellaneous and select Properties.

2. From theGeneral tab, select Force 1:1 printing.
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3. ClickOK.

8.4 Junk Fax filter
GFI FaxMaker enables automatic deletion of faxes received from certain fax IDs.

Screenshot 110: The junk fax filter options

To block a fax ID:

1. From GFI FaxMaker Configuration, right-click Advanced > Junk Fax filter and select Properties.

2. Configure the following options:

Option Description

Delete faxes received from these FAX
CSID’s

Enables Junk Fax Filter. Add CSIDs of fax senders to block.

Delete faxes received from fax machines
with an empty CSID

Deletes faxes received from senders with no CSID.
NOTE: Use with caution since some senders can choose to hide CSID.

Keep a copy of junk faxes Store all junk faxes to a folder. Use this option to reviewed blocked faxes
before deletion (Recommended).

Table 5: Junk fax filter options

3. ClickOK.
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9 Maintenance
This topic contains information about how to maintain your GFI FaxMaker installation:

9.1 How to move your GFI FaxMaker installation to a different server 177

9.2 Moving GFI Directory user list to a different server 180

9.3 How to backup GFI FaxMaker settings 181

9.4 Version information 183

9.5 Product Patches 184

9.1 How to move your GFI FaxMaker installation to a different server
This topic describes how to move your existing GFI FaxMaker installation to a new server while retaining
your current settings.

WARNING
Moving aGFI FaxMaker installation and settings to another server requires a considerable amount of
manual work, fax service downtime, third-party software re-configuration and extensive testing. It is
highly recommended to review the information in this topic and plan ahead before undertaking this task.

9.1.1 Important notes
Certain features in GFI FaxMaker use system resources such as locations on disk, printer drivers and

third-party software. GFI FaxMaker has no control over these resources and must therefore be manually
reconfigured. For example, OCRmay be configured to store a copy of OCR content on disk. This folder
must be re-created on the new server or a new directory reconfigured in GFI FaxMaker. Refer to Step 7:
Update feature settings in this topic.

This procedure is applicable for the latest version of GFI FaxMaker only.

The old instance of GFI FaxMaker must be running the latest version of GFI FaxMaker and the same ver-
sion used to install the new instance.

If GFI FaxMaker is currently installed in Active Directory, the new installation should be in the same Act-
ive Directory structure, referencing the same Active Directory domain.

When moving Brooktrout SR140 FoIP software, a rehosting of the license key is required since the
license is tied to the host machine. For more information refer to http://go.gfi.com/?pageid=FM_SR140re-
hostlicense

9.1.2 Step 1: Upgrade old server to the latest version
Before moving your installation, ensure that you are running the latest version of GFI FaxMaker on the old
server. If an upgrade is required, upgrade the old GFI FaxMaker installation. For more information, refer to
UpgradingGFI FaxMaker (page 57).

9.1.3 Step 2: Migrate GFI Directory (if applicable)
When using GFI Directory, migrate the directory service and data BEFORE proceeding with the GFI

http://go.gfi.com/?pageid=FM_SR140rehostlicense
http://go.gfi.com/?pageid=FM_SR140rehostlicense
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FaxMaker move. For more information, refer to MovingGFI Directory user list to a different server (page
180).

9.1.4 Step 3: Copy the old configuration files
On the old server, stop the following services:

GFI FaxMaker Fax Server

GFI FaxMaker Message Transfer Agent

GFI FaxMaker Attendant

IIS Admin

Copy the following files and folders that reside in the GFI FaxMaker installation folder.

Unless modified manually during installation, by default, GFI FaxMaker installs to the following path:

C:\Program Files (x86)\GFI\FaxMaker\

Files and folders to copy:

Folder\Files Type Notes

All files with extension
FST

File For example: fmdb_rul.fst and fmdevcfg.fst.

fmdb_rul.mdb File

File config.mdb File

fmsmscomms.xml File

doccvt.ini File

remclient.ini File

modems.dev File

rcvlog.txt File

sendlog.txt File

File capi.dev File If available.

options.ini File If available.

mobiles.dev File If available.

logs\rcvlog.fmlogger.txt File This is the default location of log files. If you changed the default location, copy
the file from that folder.

logs\sendlog.fmlogger.txt File This is the default location of log files. If you changed the default location, copy
the file from that folder.

coverpge Folder Include all folder contents.

data Folder Include all folder contents.

archive Folder Include all folder contents. This is the default location of the Firebird database
fax archive feature. If you changed the default location, backup that folder as
well.

9.1.5 Step 4: Install GFI FaxMaker
Ensure that the new server meets or exceeds the GFI FaxMaker system requirements. If using a fax
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modem, install the modem on the new server.

Save and close any open applications and run the GFI FaxMaker installer using an account with
administrative privileges. Apply the settings below when prompted during the installation wizard:

When asked to choose the installation path, select the same installation path as the old instance.

Key in your existing license key to activate the product.

Important
Do NOT run the post-install configuration wizard. ClickCancel to stop and close the post-install wizard.
If you proceed with the wizard, your old settings will be overwritten.

9.1.6 Step 5: Move configuration files
On the new server, stop the following GFI FaxMaker services from the Services applet:

GFI FaxMaker Fax Server

GFI FaxMaker Message Transfer Agent

GFI FaxMaker Attendant

IIS Admin

Move the files copied in step 3 to the GFI FaxMaker installation folder on the new server, overriding existing
files.

Start the GFI FaxMaker services that were stopped.

9.1.7 Step 6: Reconfigure mail server connectors
Adjust your mail server connectors to route fax and SMS emails to the newGFI FaxMaker server. Change
the connectors IP address to the address of the newGFI FaxMaker server. For more information, refer to
Mail server configuration (page 15).

9.1.8 Step 7: Update feature settings
Various features in GFI FaxMaker utilize system resources. These settings are imported on to the new
server as previously configured on the old installation. Consequently these old settings require manual
reconfiguration to be adapted to the new server.

Examples:

XMLAPI and TextAPI pick up APIs from a folder on disk. After migration, the new installation is still con-
figured to pick up APIs from the directory configured on the old server. This path may, however, not exist on
the new server. Re-configure the TextAPI and XMLAPI pickup folders to new paths on the new server.
Third-party applications that automatically generate APIs for faxing will also require re-configuration to
deploy APIs to the new pickup location.

Fax linesmay have been configured to backup sent/received faxes to a folder on disk. Re-configure the
folder where to backup faxes to a new location on the new server. Fax lines may also be configured to auto-
matically print received faxes. In this case re-configure the fax line to print on another printer.

The below table lists some features and settings that may require reconfiguration. Various other tweaks and
re-configurations may be required depending on your deployment scenario and environment.
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Feature Notes

Fax archiving to
database

Microsoft® SQL/MSDE: ensure that the new server has access to the database server.
Firebird: re-configure path to database.

OCR Directory where OCR content is stored.

Log files Log files custom folder.

HP Digital Sender
and SAP

Directories where the HP Digital Sender and/or SAP pick up the fax information files.

Fax lines Locations where lines store copies of sent/received faxes and printer drivers.

Sending options Revise printer options.

Document con-
version

Install any software that is used to convert attachments to fax format.

NetPrintQueue2Fax May require re-installation of printer driver on client machines when moving from a 32-bit
server to a 64-bit server.

Printers Install the old printer driver on the new server or re-configure new printers. When re-con-
figuring new printers, ensure that features using old printers are adjusted accordingly.

Junk fax filter Directory where junk faxes are stored.

SMS Install GSM modems (if applicable) on the new server.

9.1.9 Step 8: Test the new faxing setup
Ensure that the new fax setup is properly configured and fully functional.

Send test faxes to check fax transmission. For more information, refer to Testing your installation (page 64).

It is also recommended to test individual features to ensure that the configuration is migrated successfully.

9.2 Moving GFI Directory user list to a different server
This topic describes how to move your existing GFI Directory installation to a new server while retaining your
current user list. Run this process before migrating

9.2.1 Important notes
This procedure is applicable for the latest versions of GFI FaxMaker and GFI Directory only.

Both the old instance and the new instance of GFI Directory must be running the latest version which is
available with the latest version of GFI FaxMaker. For more information, refer to UpgradingGFI FaxMaker
(page 57).

This information is not applicable when GFI FaxMaker is currently installed in Active Directory mode.

9.2.2 Step 1: Upgrade old server to the latest version
Before moving your installation, ensure that you are running the latest version of GFI FaxMaker on the old
server. If an upgrade is required, upgrade the old GFI FaxMaker installation. For more information, refer to
UpgradingGFI FaxMaker (page 57).

9.2.3 Step 2: Run backup of the GFI Directory data
Open an elevated command line window and run the following commands in the sequence shown, hitting
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carriage return after each command:

1. dsdbutil

2. activate instance GFIDirectoryDataStore

3. ifm

4. create full GFIDirectoryDataStoreBackup

On completion, take note of the backup location. The data files are stored in this location.

9.2.4 Step 3: Copy the data files
Copy the backup files generated in step 2 above:

1.Open the backup file location in Windows Explorer. This is usually stored in this folder: c:\win-
dows\system32\GFIDirectoryDataStoreBackup\

2.Copy the file adamntds.dit.

9.2.5 Step 4: Install GFI Directory
Ensure that the new server meets or exceeds the GFI FaxMaker system requirements.

Retrieve the GFI Directory installer from the current GFI FaxMaker installation. Go to <GFI FaxMaker
installation folder>\GFIDS\ and copy gfidirectory.exe to the new server.

Run the installer on the new server to install GFI Directory.

9.2.6 Step 5: Move the data file
After installing GFI Directory, copy the user data to the new server:

1. Stop the following GFI Directory services from the Services applet:

GFI Directory Services

GFIDirectoryDataStore

2.Open the folder: <GFI Directory installation folder>\GFIinstance\data\

3.Delete all files in this folder.

4.Move the file adamntds.dit copied in step 2 to this folder.

5. Start the services that were previously stopped.

9.2.7 Step 6: Test and confirm user migration
Ensure that the existing GFI FaxMaker users are present in the new instance of GFI Directory.

1. In an internet browser, go to http://[server name]/GFIDirectory.

2.Go toManage > Users to view the list of users.

3. Ensure that users and user information was migrated successfully.

You may now proceed to continue migration of GFI FaxMaker. For more information, refer to How tomove
your GFI FaxMaker installation to a different server (page 177).

9.3 How to backup GFI FaxMaker settings
This topic describes how to backup your GFI FaxMaker configuration.
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NOTES

1. These instructions apply to the latest version of GFI FaxMaker only.

2. Log on to the GFI FaxMaker server using an account with administrative privileges.

3.GFI FaxMaker services are stopped during backup. Consequently fax transmission is also stopped
and no faxes are sent or received.

4.When GFI FaxMaker machine is virtualized, it is recommended to create a snapshot of the virtualized
machine. This allows to restore previous GFI FaxMaker version easily.

9.3.1 Step 1: Stop GFI FaxMaker services
GFI FaxMaker services must be stopped when backing up the configuration. When using a backup software
to automate the backup, ensure that the selected backup software stops these services before the backup
job starts. If services or files are open and/or running, the backup may be unusable. If this is the case, a
manual backup is recommended.

When stopping services manually, use either the Services applet or create a batch file using the net stop
command.

GFI FaxMaker services to stop:

GFI FaxMaker Fax Server

GFI FaxMaker Message Transfer Agent

GFI FaxMaker Attendant

When using a Brooktrout device or SR140 also stop:

Brooktrout Boston Host Service

NOTES

1.Older versions of GFI FaxMaker utilize different service names. In this case, stop all services with a
name that start with GFI FaxMaker or FAXmaker.

2.When services are stopped, no faxes or SMS are sent or received.

9.3.2 Step 2: Backup files
Copy the following files and folders that reside in the GFI FaxMaker installation folder.

Unless modified manually during installation, by default, GFI FaxMaker installs to the following path:

C:\Program Files (x86)\GFI\FaxMaker\

It is recommended to take note of the installation path since if the backup needs to be used, the files need to
be deployed to the same path (either on the same or on a different server).

Files and folders to backup:

Folder\Files Type Notes

All files with extension
FST

File For example: fmdb_rul.fst and fmdevcfg.fst.

fmdb_rul.mdb File
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Folder\Files Type Notes

File config.mdb File

fmsmscomms.xml File

doccvt.ini File

remclient.ini File

modems.dev File

rcvlog.txt File

sendlog.txt File

File capi.dev File If available.

options.ini File If available.

mobiles.dev File If available.

logs\rcvlog.fmlogger.txt File This is the default location of log files. If you changed the default location, copy
the file from that folder.

logs\sendlog.fmlogger.txt File This is the default location of log files. If you changed the default location, copy
the file from that folder.

coverpge Folder Include all folder contents.

data Folder Include all folder contents.

archive Folder Include all folder contents. This is the default location of the Firebird database
fax archive feature. If you changed the default location, backup that folder as
well.

When using a Brooktrout TR1034 fax board, go to folder ..\FaxMaker\brooktrout\TR1034\Boston\config\
and back up callctrl.cfg and btcall.cfg.

9.3.3 Step 3: Start the GFI FaxMaker services
Start the services that were stopped in Step 1.

When starting services manually, use either the Services applet or create a batch file using the net start
command.

For more information, refer to How tomove your GFI FaxMaker installation to a different server (page 177).

9.4 Version information
To review information about your GFI FaxMaker installation, from GFI FaxMaker Configuration, right-click
General > Version information and select Properties.

You can also check for newer versions of GFI FaxMaker from the GFI web site.



GFI FaxMaker 9Maintenance | 184

Screenshot 111: GFI FaxMaker version information

9.5 Product Patches
The Product Patches feature verifies if there are any software patches available for your version of GFI
FaxMaker by directly connecting to the GFI Update Servers.

NOTE
It is highly recommended to check for patches periodically to keep GFI FaxMaker updated.

1. From GFI FaxMaker Configuration, go toGeneral > Product Patches.

2. GFI FaxMaker connects to the GFI Update Server and lists all available updates.

3. Click the link of patches to download.

4. Decompress the downloaded patch file.

5. Follow the instructions included with the downloaded file to implement the patch.

NOTE
Incorrect patch installation (for example, by not following instructions) may cause GFI FaxMaker to
malfunction or degrade its performance.
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10 SMS
GFI FaxMaker also features a complete SMS gateway that enables users to send SMS from their
workstations.

10.1 How to send an SMS 185

10.1.1 Method 1: Via email 185

10.1.2 Method 2: Using the web-based SMSClient 186

10.1.3 Method 3: XMLAPI 187

10.2 Receiving SMS 187

10.3 SMSRequirements 188

10.3.1 Web based SMS 188

10.3.2 Network-connected SMS servers 188

10.3.3 GSM modem 189

10.4 Configure SMS settings 189

10.4.1 SMS gateway settings 189

10.4.2 SMS options 196

10.4.3 SMSUsers 198

10.4.4 Routing received SMS 198

10.4.5 Archiving SMS 199

10.4.6 SMS log files 199

10.1 How to send an SMS
Method 1: Via email

Method 2: Using the web-based SMS Client

Method 3: XMLAPI

10.1.1 Method 1: Via email
To send an SMS from an email client, such as Microsoft®Outlook®, address an email to
<number>@smsmaker.com. For example: 12345678@smsmaker.com

Key in the SMSmessage in the email body.

NOTES:

Remove email signature and any other not required content from the email body, as this will be included
in the SMSmessage.

The default fax (faxmaker.com) and SMS (smsmaker.com) domains can be customized by the GFI
FaxMaker administrator. Use the configured SMS domain accordingly.
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This method is only applicable when routing emails via SMTP. This is not applicable when using the
POP3 Downloader to poll SMS from a POP3 Mailbox. For more information, refer to Sending faxes/SMS via
a POP3Mailbox (page 105).

Screenshot 112: Sending SMS from email client

10.1.2 Method 2: Using the web-based SMS Client
Licensed users can send SMS by accessing the GFI FaxMaker web client from a supported web browser.

1. Login to the GFI FaxMaker web console and click the Client tab.

2. From the left pane, go to SMS > Compose.

3. In the To... field key in the recipients' SMS numbers or click To... to select recipients from the address
book. For more information, refer toWeb client address book (page 74).

4. Enter the SMS text in the body.

5.Click Send.
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Screenshot 113: Composing an SMS in the web-based SMS Client

10.1.3 Method 3: XMLAPI
Use third-party tools to automatically generate XMLAPIs containing the information about the SMSs to send.

Store XMLAPIs to a central location and GFI FaxMaker automatically processes files located in this folder.

A wide range of applications can be configured to automatically create such files and automating the SMS
sending process.

For more information refer to the GFI FaxMaker API manual available from:
http://go.gfi.com/?pageid=FM19help&lang=en#cshid=APImanual.

10.2 Receiving SMS
GFI FaxMaker routes incoming SMS directly to the user’s mailbox via email. The email contains details
about the SMS transmission and the SMSmessage.

http://go.gfi.com/?pageid=FM19help&lang=en#cshid=APImanual
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Screenshot 114: Received SMS viewed in email client

For more information, refer to Configure SMS settings (page 189).

10.3 SMS Requirements
Use one of the following types of SMS gateways:

Web based SMS

Network-connected SMS servers

GSMmodem

10.3.1 Web based SMS
Use a custom web based service that allows sending SMSmessages via SMTP or subscribe to a supported
web based SMS provider:

Message Media - For more information, refer to MessageMedia SMS service (page 195).

Clickatell - For more information, refer to Clickatell web based service (page 194).

Note that web based SMS setups are usually quicker and easier to setup than purchasing and installing
GSM devices.

10.3.2 Network-connected SMS servers
GFI FaxMaker integrates with MultiTech MultiModem® iSMSwhich is a network-connected device for
sending and receiving SMS. For more information, refer to MultiTechMultiModem® iSMS SMS Server
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(page 191).

10.3.3 GSM modem
Use a supported GSM modem connected to the GFI FaxMaker fax server machine. Using a GSM SMS
modem enables sending SMS even when the internet connection is down. You can also receive messages,
which may not be possible with certain web-based SMS gateway.

For the latest list of supported mobile phones and GSM devices, refer to:

http://go.gfi.com/?pageid=FM_GSMDevices

10.4 Configure SMS settings
Configure SMS options:

SMS gateway settings - select and configure the type of SMSmodem or device.

SMS options - various SMS options, such as maximum SMS length.

SMS Users - the list of users allowed to send SMS.

Routing received SMS - howGFI FaxMaker routes received SMS.

Archiving SMS - archive sent and received SMS to database.

SMS log files - SMS activity logs

10.4.1 SMS gateway settings
Configure the SMS gateway settings depending on the type of SMS gateway chosen.

GSMdevice

MultiTechMultiModem® iSMS SMS Server

A customWeb based SMS provider

Clickatell web based service

MessageMedia SMS service

GSM device

Set up the SMS server to communicate directly with the GSM devices to send and receive SMSmessages.

NOTE
For the latest list of supported mobile phones and GSM devices, refer to:
http://go.gfi.com/?pageid=FM_GSMDevices

1. From GFI FaxMaker Configuration, right-click SMS and select Properties.

2. InGeneral tab, select Enable SMS Gateway.

http://go.gfi.com/?pageid=FM_GSMDevices
http://go.gfi.com/?pageid=FM_GSMDevices
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Screenshot 115: Configuring the GFI SMS server

3. SelectGFI SMS server and configure:

Option Description

Automatic
Detection

Select this option to detect GSM devices connected to serial ports. In the GFI Device Detection
dialog, click Start Detection to automatically detect devices. Click OK.
If devices are not detected automatically, click Add Line to add device manually. Ensure that device
drivers are installed properly.

Add Line Click to manually add a line and configure its properties. Specify the following options:
Communication Port - Select the communications (COM) port that the GSM device is connected

to. Click Validate to ensure that GFI FaxMaker finds and is able to communicate with the device.
Line name – Specify a friendly name for the new line.
Copy settings from installed device – Select this option to copy the settings of another device.

Edit Line Select a line to edit properties for and from the GSM Device tab, configure the following options:
COM Port - The communications (COM) port that the GSM device is connected to.
Baud Rate – Select the speed in bits-per-second (bps) at which PC and GSM device talk to each

other. Check with the device manufacturer for the best baud rate that the device can use.
Line name – (Optional) A friendly name for the line.
SMSC Number – (Optional) The Service Center Number given by the GSM network or SIM card

provider.
Initialization String – (Optional) The initialization string used when initializing the GSM device. If

empty, GFI FaxMaker uses AT&F as the default initialization string.

From the Line Options tab, configure the following options:
Receive Incoming SMS – Select to allow SMS to be received on this line.
Send outgoing SMS – Select to allow SMS to be sent from this line.
Enable international numbers – Select this option to allow sending SMS from this line to inter-

national numbers.

Click OK.
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Option Description

Enable/Disable
Lines

From the SMS Properties dialog, select/unselect the checkbox next to the configured lines to
enable/disable SMS transmission over that line.

Delete Line Select a line to delete and click Delete Line. Click Yes to confirm deletion.
WARNING: Deleted lines are not recoverable. If in doubt, it is recommended to disable a line.

4.ClickOK.

(Optional) To verify settings click Send test.... Key in a test recipientNumber to send SMS to and customize
the Textmessage. Click Send to send the test message. Verify that the test SMS is received by the test
recipient.

MultiTech MultiModem® iSMS SMS Server

GFI FaxMaker can send/receive SMS via a MultiTech MultiModem® iSMSSMS server. To use this device
with GFI FaxMaker, first setup the SMSAPI options in MultiTech, then enable the SMSGateway options in
GFI FaxMaker.

Step 1: Configure the MultiTech MultiModem® iSMS API options

1. Log in to the MultiTech iSMS device SMSServices configuration and click the SMS API node.

2. Enable HTTP API Status and select the HTTP Port to use. Take note of the port number.

3. Ensure that TCP API Status is disabled.

4.Disable Non Polling Receive API Status.

5.Under Protocol, choose HTTP.

6. Save all settings.

7.Reboot the MultiTech iSMS by navigating to Save & Restart. Save configuration to Flash memory and
restart MultiModem iSMS.

Step 2: Enable MultiTech iSMS in GFI FaxMaker

1. From GFI FaxMaker Configuration, right-click SMS and select Properties.

2. InGeneral tab, select Enable SMS Gateway.
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Screenshot 116: Configuring a MultiTech iSMS SMS Server

3. SelectMultiTech iSMS (SMSFinder) Service and configure:

Option Description

Username Your MultiTech iSMS username.

Password Your MultiTech iSMS password.

IP
Address

The MultiTech iSMS device IP address. Usually this is the same IP address used when accessing the
MultiModem iSMS web configuration. For example, 192.168.2.22

Port The port number as configured in the MultiTech iSMS HTTP API settings in step 1.

4.ClickOK.

(Optional) To verify settings click Send test.... Key in a test recipientNumber to send SMS to and customize
the Textmessage. Click Send to send the test message. Verify that the test SMS is received by the test
recipient.

NOTE
If the device is busy with a heavy load of SMS, the test may fail due to a time-out. Ensure that the test is
run when the device is not very busy.

A customWeb based SMS provider

Configure the following SMS gateway settings when using a Web-based SMS service that allows SMS to be
submitted via SMTP:



GFI FaxMaker 10 SMS | 193

1. From GFI FaxMaker Configuration, right-click SMS and select Properties.

2. InGeneral tab, select Enable SMS Gateway.

Screenshot 117: Configuring an SMS service provider

3. SelectGeneric SMS service provider template and configure the following settings:

Option Description

SMTP
server

Specify your own mail server or the mail server of the service provider.

SMTP
port

Specify SMTP port number.

From Specify your email address.

To Specify to which email address SMS are sent.
NOTE: If provider requires the SMS number to be inserted in the To address, use field [smsnumber] to
replace the recipient’s number. GFI FaxMaker automatically replaces this field with the recipient’s number.
For example, [smsnumber]@providerdomain.com.

CC (Optional) Specify if to send a copy of the message to another email address.

Subject (Optional) Specify an email subject.
NOTE: If provider required the SMS number to be inserted in the subject, include field [smsnumber]. GFI
FaxMaker automatically replaces this field with the recipient’s number.

Body
line 1 -
X

Key in text to show in each email body line, as required by the provider. Fields that can be used:
[smsnumber] - replaced by the recipient’s mobile number.
[smsmessage] - replaced by the SMS text to be sent.

4.ClickOK.
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(Optional) To verify settings click Send test.... Key in a test recipientNumber to send SMS to and customize
the Textmessage. Click Send to send the test message. Verify that the test SMS is received by the test
recipient.

Clickatell web based service

When using Clickatell service, a number of settings are automatically pre-configured.

NOTE

GFI FaxMaker accepts the two authentication methods supported by Clickatell. Clients can use
either the API Identifier or the username and password.

When using the Clickatell SMS service, ensure that users always include the country code of recip-
ients.

Configure the following options:

1. From GFI FaxMaker Configuration, right-click SMS and select Properties.

2. InGeneral tab, select Enable SMS Gateway.

Screenshot 118: Configuring the Clickatell service

3. SelectClickatell Web2SMS service.

4. Select the following options and click Edit... to configure:
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Option Description

API
Identifier

Value assigned by Clickatell on signing up to the service.
Verify if your account has this value assigned. When available, it is enough to add the API Identifier and
then you can jump to step 5.

From (Optional) Specify the sender value of an SMS message, for example ‘MyCompanyName’.

User
name

(Optional) Value assigned by Clickatell on signing up to the service.

Password (Optional) Value assigned by Clickatell on signing up to the service.

5.ClickOK.

(Optional) To verify settings click Send test.... Key in a test recipientNumber to send SMS to and customize
the Textmessage. Click Send to send the test message. Verify that the test SMS is received by the test
recipient.

Message Media SMS service

When using the Message Media service, a number of settings are automatically pre-configured.

To create a Message Media account for GFI FaxMaker, go to http://go.gfi.com/?pageid=FM_
MessageMedia.

NOTES

1.When using the Message Media SMS service, ensure that users always include the country code of
recipients.

2. The Message Media SMS service does not support Unicode.

3.GFI FaxMaker uses HTTPS port 443 to communicate with Message Media servers. Ensure that this
port is open on your firewall.

Configure the following options:

1. From GFI FaxMaker Configuration, right-click SMS and select Properties.

2. InGeneral tab, select Enable SMS Gateway.

http://go.gfi.com/?pageid=FM_MessageMedia
http://go.gfi.com/?pageid=FM_MessageMedia
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Screenshot 119: Configuring the Message Media service

3. SelectMessage Media Service.

4. Select the following options and click Edit... to configure:

Option Description

Username Your Message Media username.

Password Your Message Media password.

SMS Receive Polling Interval Key in the frequency in minutes for GFI FaxMaker to check for new incoming SMS.

5.ClickOK.

(Optional) To verify settings click Send test.... Key in a test recipientNumber to send SMS to and customize
the Textmessage. Click Send to send the test message. Verify that the test SMS is received by the test
recipient.

10.4.2 SMS options
Configure SMS sending settings:

1. From GFI FaxMaker Configuration, right-click SMS and select Properties.
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Screenshot 120: SMS options

2. From the SMS Options tab, configure:

Option Description

Send multiple SMS messages
if text length is greater than
one standard SMS message

Select to split messages longer than the allowed length into multiple SMS
messages. Specify the maximum number of SMS messages allowed.
NOTE: Each short message is up to 160 characters when using Latin characters, or
70 characters when using non-Latin characters such as Arabic and Chinese.

Append user information to
outgoing SMS messages

Add one of the following sender information fields either before or after the SMS
message:

Display Name
Name
Surname
Company
Department

Detect and remove personal
signature. Truncate SMS
message on the first blank
line.

Select to automatically send the text before the first blank line. This ensures that
email signatures are not sent as part of an SMS.

Enable automatic routing for
incoming messages

Received SMS are automatically routed to the user who sent an SMS to that number.
For example, Joe Bloggs sends an SMS to number 123456. When number 123456
replies back, SMS is automatically routed to Joe Bloggs.
NOTE: If more than one user sends an SMS to the same number, GFI FaxMaker
routes replies to the latest sender. However, replies are always routed to all users
that had sent an SMS to the same number in the previous 5 hours.

3. ClickOK.
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10.4.3 SMS Users
To specify the list of users allowed to send SMS:

Screenshot 121: Configuring SMS users

1. From GFI FaxMaker Configuration, right-click SMS > SMS users and selectNew SMS user….

2. Select users to add, depending on the user directory service:

Active Directory: Add users or groups from the Active directory user dialog.

GFI Directory: Select the users allowed to send SMS. Only users that were previously added to the
Licensed Users screen can be set as SMS users.

3. ClickOK.

10.4.4 Routing received SMS
Configure howGFI FaxMaker routes received SMS.

NOTE
GFI FaxMaker can automatically route received SMS to the user that originally sent SMS. To enable
option, select Enable automatic routing for incoming messages from SMS Options. For more
information, refer to SMS options (page 196).

1. From GFI FaxMaker Configuration, right-click SMS > SMS Routing and select Properties.
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Screenshot 122: SMS routing properties

2. Configure the following options:

Tab Description

Default SMS Routers Users to whom GFI FaxMaker routes all SMS that have no associated users.

Receive All SMS Messages Users to route all SMS messages to.

Table 6: SMS routing properties tabs

3. ClickOK.

10.4.5 Archiving SMS
All inbound and outbound SMS are archived in the same archiving database as fax archiving. For more
information, refer to Fax archiving (page 107).

10.4.6 SMS log files
GFI FaxMaker logs all activity of incoming and outgoing SMS in two log files within the GFI FaxMaker
installation folder:
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Log file Description

sms_
sent.log

Contains a log of sent SMS in the following format:
Date,Time,Sender,Recipient,Status,Message,Details
For example:
"7/6/2018","8:23:38 AM","jsmith@masterdomain.com","123126","Success","This is a
test SMS sent from GFI FaxMaker - John Smith","Success. SMS posted to
destination."

sms_
recv.log

Contains a log of received SMS in the following format:
Date,Time,Sender,Recipient,Status,Message,Details
For example:
"7/6/2018","8:52:39 AM","621321","bjones@masterdomain.com","Success","This is a
test SMS received by GFI FaxMaker","Success. SMS received."

Table 7: SMS log files
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11 Uninstalling GFI FaxMaker
This topic describes how to uninstall GFI FaxMaker.

NOTE
Any configurations done on other machines, such as send and receive connectors on the mail server,
are not removed.

1. Exit GFI FaxMaker.

2. From Control Panel select Programs and choose to uninstall a program.

3. From the list of installed software selectGFI FaxMaker and clickRemove or Uninstall.

4. Follow on-screen instructions.

11.0.1 Removing the Microsoft® Exchange 2007/2010/2013 Connector

This topic describes how to remove the GFI FaxMaker connectors.

Removing the connectors automatically

GFI FaxMaker installed onMicrosoft® Exchange Server

If the connectors were created automatically during installation of GFI FaxMaker, the connectors are
automatically removed during uninstall.

No further configuration is required.

NOTE
If the connectors are not named GFIFaxMaker (for example, if connectors were renamed or were
manually created using a different name), remove the connectors manually. For more information, refer
to Removing the connectorsmanually (page 201).

GFI FaxMaker installed on a separatemachine

If the connectors were created automatically by running the GFI FaxMaker setup on the Microsoft®
Exchange server, the connectors are automatically removed by uninstalling GFI FaxMaker from the
Microsoft® Exchange server.

No further configuration is required.

NOTE
If the connectors are not named GFIFaxMaker (for example, if connectors were renamed or were
manually created using a different name), remove the connectors manually. For more information, refer
to Removing the connectorsmanually (page 201).

Removing the connectors manually

GFI FaxMaker installed onMicrosoft® Exchange Hub Transport Server

From the Microsoft® Exchange Management Shell, run the following commands:
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NOTE
If a custom name was given when creating the connector manually, replace GFIFaxMaker with the
name of the connector.

1. Remove Receive Connector:

Remove-ReceiveConnector "GFIFaxMaker"

2. Remove Send Connector:

Remove-SendConnector -identity "GFIFaxmaker" -confirm:$false

GFI FaxMaker installed on a separatemachine

From the Microsoft® Exchange Management Shell, run the following commands:

NOTE
If a custom name was given when creating the connector manually, replace GFIFaxMaker with the
name of the connector.

1. Remove Receive Connector:

Remove-ReceiveConnector "GFIFaxMaker"

2. Remove Foreign Connector:

Remove-ForeignConnector -Identity "GFIFaxmaker"

11.0.2 Removing the Microsoft® Exchange 2000/2003 Connector

To remove the GFI FaxMaker connectors from Microsoft® Exchange 2000/2003:

1. Launch Exchange System Manager and expand Connectors node.

2. Right click the GFI FaxMaker connector name (default value is FaxMaker SMTP connector) and click
Delete.
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12 Troubleshooting and support
This topic explains how to resolve any issues encountered during installation of GFI FaxMaker. The main
sources of information available to solve these issues are:

This manual - most issues can be solved through the information in this help system.

GFI Knowledge Base articles

Web forum

Contacting GFI Technical Support

A list of common issues encountered when using GFI FaxMaker:

12.1 Email2FaxGateway test fails 203

12.2 Problems accessing the web interface 204

12.3 Error “Call failed 46” when sending fax 205

12.4 Error 1701 during document conversion 205

12.5 Error 1706 during document conversion 206

12.6 Problems with Microsoft®Office® attachments 206

12.7 Transmission failure report when using online fax services 206

12.8 No calls answered on a particular fax number 207

12.9 Cannot send SMS via GSM device 207

12.10 Debug mode 208

12.11 Other troubleshooting resources 208

12.11.1 Knowledge Base 208

12.11.2 Web Forum 208

12.11.3 Request technical support 208

12.1 Email2FaxGateway test fails
The Email2FaxGateway settings specify howGFI FaxMaker communicates with the mail server for sending
and receiving faxes.

From the Configuration Wizard or Email2FaxGateway dialog, click Test to ensure correct communication
between the two servers.

If the test fails, refer to table below for most common causes and solution:

CDO Error Possible Solutions

The transport failed to connect to the
server.

Connection with the mail server couldn’t be established. Confirm the
following settings:

IP address of the mail server.
Secure connection (encryption) settings.
Check if firewall is blocking connection between GFI FaxMaker and

the mail server.
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CDO Error Possible Solutions

The server rejected one or more recipient
addresses. The server response was: 550
5.7.1 Unable to relay for <email address>

Connection with mail server was established but mail server refused
the domain of the recipients address.
This normally occurs because relaying is not allowed from the GFI
FaxMaker server. Configure SMTP server to accept relaying from the
GFI FaxMaker machine's IP or allow relaying for the internal email
domain only.

The server rejected the sender address.
The server response was: 530 5.7.3 Client
was not authenticated.

GFI FaxMaker can connect with mail server but user authentication
details are missing. Select Use SMTP Authentication and key in
credentials.

The message could not be sent to the
SMTP server. The transport error code was
0x80040217. The server response was not
available

GFI FaxMaker can connect with mail server but user authentication
details are invalid. Check credentials.

12.2 Problems accessing the web interface

Issue encountered

When accessing the GFI FaxMaker web interface, the web server is reached but does not render the GFI
FaxMaker login page. Instead, the following may occur:

HTML code is displayed in the browser

A blank page is returned to the browser

You may receive instructions to download the aspx page

Possible causes

If the web browser and site can be reached, but the returned data is invalid, the most likely cause is that
ASP.NET is not registered with IIS.

Solution

Register ASP.NET with the IISWeb Server using the below instructions depending on your operating system
or IIS version:

How to register ASP.NET on Microsoft Windows Server 2016

To register ASP.NET on Microsoft Windows Server 2016, launch an elevated command prompt and run the
following command:

dism /online /enable-feature /featurename:IIS-ASPNET45

How to register ASP.NET on Microsoft Windows Server 2012

To register ASP.NET on Microsoft Windows Server 2012, open a command prompt session as administrator
and execute the following command:

dism /online /enable-feature /featurename:IIS-ASPNET45

Registering ASP.NET on IIS 7.0

To register ASP.NET on operating systems running IIS 7.0, such asWindows 7 and Windows Server 2008
R2:

1.Open Command Prompt and change the directory as follows:
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<WindowsDir>\Microsoft.NET\Framework64\<version number>\

2.Run the following command: aspnet_regiis.exe -i

3.Go to Start > Administrative Tools > Internet Information Services (IIS) Manager.

4. Select the local computer node and launch ISAPI and CGI Restrictions.

5.Right click ASP.NET v4.x.xxxxx and select Allow.

12.3 Error “Call failed 46” when sending fax

Issue encountered

An error Call failed: 46 is shown in theGFI FaxMaker Monitor or in the debug logs.

Causes

This is a generic error indicating that GFI FaxMaker attempted to dial a fax number, but failed to set up the
call. The reasons for this failure can be various depending on the environment where GFI FaxMaker is
installed. For example:

The fax device is behind a PABX that does not accept the local fax ID when making an outbound call

The fax number is invalid

The fax line requires a prefix to dial out

CLIP is required to authenticate outbound fax calls

Old Dialogic (Eicon) Diva Server drivers

Possible solutions

Check manually whether the fax number can be dialed and can hear a fax tone

Check if the issue persists only with this fax number and if it is reproducible

Check if a prefix is required in order to dial out

If GFI FaxMaker is behind PABX that does not accept the local fax ID when making an outbound call,
remove the Local fax ID value from the Lines/Devices settings in GFI FaxMaker.

Check if CLIP is required

If using Dialogic (Eicon) Diva Server, download and install the latest drivers from Dialogic website.

If these initial approaches do not resolve the issue, then the root of the problem might be outside of GFI
FaxMaker.

12.4 Error 1701 during document conversion

Issue encountered

Faxes in theGFI FaxMaker Monitor get stuck converting attachments when processing outbound fax jobs.
Eventually conversion times out with error 1701 and message:

Document conversion timeout, or

Coverpage Conversion timeout

Solution

There are various causes for this issue. To determine cause and applicable solution, refer to:
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http://go.gfi.com/?pageid=FM_Error1701

12.5 Error 1706 during document conversion

Issue encountered

When sending a fax that contains an attachment, the sender receives a report with the following error:

1706 : Document Conversion Timeout.

There is no application associated with the file extension of the attachment.

Cause

This issue normally arises when there is no application associated with the extension of the file to fax.

Possible solution

On the GFI FaxMaker server, ensure that the file format sent in the fax can be printed. In Windows®
Explorer, right-click a similar (same extension) file and ensure the option Print is available.

If printing is not available, install an application that can open and print that extension. For example,
install an OpenDocument Text reader (such as OpenOffice) to open and print ODT files.

If printing is available, try using the print option to check whether the association is working correctly

12.6 Problems with Microsoft® Office® attachments

Issue encountered

GFI FaxMaker encounters problems when converting Microsoft®Office® files to fax.

Possible solutions

Verify that Microsoft®Office® 2007 or later is installed on the GFI FaxMaker server.

Ensure that Microsoft®Office® is not in trial mode or has an expired license.

Ensure Microsoft®Office®was installed using the same account as that used by GFI FaxMaker fax
server services.

Confirm that the account used for installing GFI FaxMaker and Microsoft®Office® has administrator
rights.

Run all Microsoft®Office® applications, such as Microsoft®Word® and Excel®, to clear any messages
displayed the first time the applications are run.

Ensure that GFI FaxMaker printer driver is set as the default printer for the machine.

Re-start GFI FaxMaker machine to ensure that changes take effect.

12.7 Transmission failure report when using online fax services

Issue encountered

Receiving a transmission failure report when sending faxes using an online fax service

http://go.gfi.com/?pageid=FM_Error1701
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Possible cause

Online fax services require the full recipient number, including the international dial symbol "+", the country
and area codes. Do not use hyphens, spaces or dashes between any parts of the fax number.

The full recipient number is also required when sending faxes locally.

Possible solution

Re-send fax using the full fax number that includes the "+" international dial symbol, the country and area
codes.

For more information, refer to Fax services (page 116).

12.8 No calls answered on a particular fax number

Issue encountered

GFI FaxMaker does not answer calls on a particular fax number.

Cause

This issue usually arises when MSN numbers are specified incorrectly.

Possible solution

Configure MSN numbers that GFI FaxMaker should answer from the device properties.

To determine the MSN numbers to answer:

1. Send a fax to GFI FaxMaker, dialling the number that you want GFI FaxMaker to answer.

2. From GFI FaxMaker Monitor Fax Server node, take note of the number displayed.

3. Enter this MSN number in the list of MSN numbers of the device properties. ClickOK and restart theGFI
FaxMaker Fax Server service.

NOTE
To answer a whole range of numbers (for example, when using DID routing), enter the starting number
of the range of numbers. For example: to answer all numbers from 35922410 to 35922419, enter
3592241.

12.9 Cannot send SMS via GSM device

Issue encountered

GFI FaxMaker cannot send SMS via a GSM device

Possible solutions

GFI FaxMaker is not configured to use the COM port as a fax modem.

GSM modem is not installed as a modem in control panel. Other applications such as RAS or Microsoft®
Fax may attempt to take control of the modem.

Test SIM card with a mobile phone. Check operation, checking amongst others that there is reception,
no pin number has been set, there is enough credits to send SMS.

If no issues are found, perform other checks on GSM device. Refer to:
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http://go.gfi.com/?pageid=FM_IssuesSMS

12.10 Debug mode
By switching on the GFI FaxMaker debug mode, GFI FaxMaker creates more detailed log files in the logs
folder within the installation directory.

To enable this option, from GFI FaxMaker Configuration, navigate to Advanced > Miscellaneous and
select Properties. Select option Enable debug mode.

12.11 Other troubleshooting resources

12.11.1 Knowledge Base
GFI maintains a comprehensive Knowledge Base repository, which includes answers to the most common
installation problems. In case that the information in this manual does not solve your installation problems,
next refer to the Knowledge Base. The Knowledge Base always has the most up-to-date listing of technical
support questions and patches. Access the Knowledge Base by visiting:
https://www.gfi.com/support/products/gfi-faxmaker/.

12.11.2 Web Forum
User to user technical support is available via the GFI web forum. Access the web forum by visiting:
http://forums.gfi.com/.

12.11.3 Request technical support
If none of the resources listed above enable you to solve your issues, contact the GFI Technical Support
team by filling in an online support request form or by phone.

Online: Fill out the support request form and follow the instructions on this page closely to submit your
support request on: https://www.gfi.com/support/technical-support-form

Phone: To obtain the correct technical support phone number for your region visit: https://www.g-
fi.com/contact-us

NOTE
Before contacting Technical Support, have your Customer ID available. Your Customer ID is the online
account number that is assigned to you when first registering your license keys in the GFI Customer
Area at: http://customers.gfi.com.

We will answer your query within 24 hours or less, depending on your time zone.

http://go.gfi.com/?pageid=FM_IssuesSMS
https://www.gfi.com/support/products/gfi-faxmaker/
http://forums.gfi.com/
https://www.gfi.com/support/technical-support-form
https://www.gfi.com/contact-us
https://www.gfi.com/contact-us
http://customers.gfi.com/
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13 Glossary

A

AD
Active Directory

B

Backup2Folder
A feature of fax routing rules that automatically backs up received faxes in a folder.

Basic Rate Interface
An ISDN channel intended for small systemswhich achieves up to 128kbps data rate.

BRI
Basic Rate Interface

C

Called Subscriber Identification
An identification string transmitted by the recipient's fax device to the sender during a fax trans-
mission.

CAPI
Common ISDN Application Programming Interface

CLIP
The Caller Line Identity Presentation is used to identify the calling party's number. It is also com-
monly referred to asCLI (Caller Line Identity), CLID (Caller Line Identity Display), CND (Caller
Number Display) or just Caller ID.

Common ISDN Application Programming Interface
A standard interface that enables applications to communicate with ISDN devices.

Coverpage
A page containing information attached and sent as the first page of a fax. This page is cus-
tomizable and can contain company logo and colors, sender and recipient information, fax details
andmore.

CSID
Call Subscriber Identification

D

Default routers
A list of users that receive faxeswhen an incoming faxmatches no routing rules.
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Dialtone
A tone heard at the start of a telephone call indicating connectivity with the telephone exchange sys-
tem and that the line is ready for dialing.

DNS
Domain NameSystem

Domain Name System
A database used by TCP/IP networks that enables the translation of hostnames to IP addresses
and provides other domain related information.

DTMF
Dual-tonemulti-frequency signalling

Dual-tone multi-frequency signalling
The tone generated by the telephone (or fax) device when dialling. This is used for communicating
with the telephone line provider.

E

ECM
Error correctionmode

Error correction mode
A faxmode that automatically detects and corrects errors during fax transmission.

Exchange connector
A Microsoft Exchange feature that forwards sent or received emails to a certain server or domain.

F

Fax administrators
Users whomonitor andmanage the fax server. They are also notified by email when critical con-
ditions occur.

Fax line
A physical telephone line or software-based (FoIP) line, linked to a fax device (modem or ISDN/fax
card).

Fax over Internet Protocol
Fax transmission over the internet, rather than the telephone line.

Firebird
A free, open source SQL based database with a 10GB size limit. GFI FaxMaker can be configured
to archive faxes and SMS to Firebird.

FoIP
Fax over Internet Protocol

FQDN
Fully qualified domain name
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Fully qualified domain name
The absolute domain name of a network device that specifies the exact location of the device in a
domain's hierarchy.

G

GFI FaxMaker Client
An application installed on clients' machines used to send faxes and SMS.

GFI FaxMaker server
Themachine where GFI FaxMaker is installed.

Global System for Mobile Communications
A standard that defines the protocol for digital 2G cellular networks that is usually used bymobile
phones.

GSM
Global System for Mobile Communications

H

HTTP
Hypertext Transfer Protocol

Hypertext Transfer Protocol
A protocol used to transfer hypertext data between servers and internet browsers.

I

IIS
Internet Information Services

IMAP
Internet Message Access Protocol

Initialization string
A command transmitted between two deviceswhile initiating a connection, used to specify import-
ant parameters of the connection.

Integrated services digital network
A technology enabling digital transmission of data and voice signals over a telephone network.

Internet Information Services
A set of Internet-based services created byMicrosoft Corporation for internet servers.

Internet Message Access Protocol
One of the twomost commonly used Internet standard protocols for e-mail retrieval, the other being
POP3.



GFI FaxMaker 13Glossary | 212

ISDN
Integrated services digital network

J

Junk fax
Unwanted incoming faxes that are not to be delivered to users.

M

Mailbox
A directory or folder on themail server used for receipt, filing, and storingmessages of emails.

MFP
Multi-function peripheral

Microsoft Exchange System manager
A specializedMMC console that enablesmanaging your Microsoft Exchange Server organization.

MSN
Multiple Subscriber Numbering

Multi-function peripheral
A device that performs a selection of common office tasks such as printing, scanning and faxing.

Multiple Subscriber Numbering
A service given by the telephone company that enablesmultiple telephone numbers on one tele-
phone line.

N

NDR
Non delivery report

NetPrintQueue2FAX
A GFI FaxMaker printer driver installed on client machines and used for sending faxes. On printing
to this driver, it delivers content to GFI FaxMaker for transmission. GFI FaxMaker determines fax
recipient details fromwithin the printed content.

Non delivery report
An automated email sent to the sender on an email delivery problem.

O

OCR
Optical Character Recognition

Optical Character Recognition
The process of converting text embeded in images intomachine-encoded text.
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P

PABX
Private Automatic Branch Exchange

POP3
Post Office Protocol 3

POP3 Downloader
TheGFI FaxMaker feature that retrieves faxes and SMS from a POP3mailbox for transmission.

Post Office Protocol 3
A protocol used by local email clients to retrieve emails frommailboxes over a TCP/IP connection.

PRI
Primary Rate Interface

Primary Rate Interface
An ISDN channel intended for larger systemswhich is capable of achieving higher speeds than
Basic Rate Interface.

Private Automatic Branch Exchange
A digital telephone systemwithin a network. This enables internal calls within the network and tele-
phone connectivity with the external system.

PSTN
Public switched telephone network

Public folder
A common folder within Microsoft Exchange that allows users to share information.

Public switched telephone network
A global telecommunications network that operates the traditional telephony system.

R

Routing
Themethods used byGFI FaxMaker to determine how to route faxes to internal recipients.

S

Secure Sockets Layer
A protocol that ensures integral and secure communication between networks.

Short message service center
The center that routes and regulates SMS functionality of a wireless network.

SIM card
A card that plugs in to a GSM cellular device which stores cellular subscription information.
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Simple Mail Transport Protocol
An internet standard used for email transmission across IP networks.

SMSC
Short message service center

SMTP
SimpleMail Transport Protocol

SMTP Connector
TheGFI FaxMaker process that connects to themail server and uploads emails for transmission to
internal users.

SSL
Secure Sockets Layer

T

Transmission report
An email sent byGFI FaxMaker to internal users that contains information about sent/received
faxes/SMS.

TSID
The transmitting subscriber identification is a string sent by the fax sender to the recipient which typ-
ically includes the fax or telephone number.

U

UNC path
A standard that specifies the location path of a network resource.

URL
The UniformResource Locator is the address of a web page on the world wide web.

V

Voice over Internet protocol
A digital telephone system that uses the internet as the transmissionmedium, rather than the
PSTN.

VoIP
Voice over Internet protocol
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B
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Baud Rate 190

Billing 70, 87, 133, 159

Brooktrout fax board 13, 55, 59-62, 91, 177, 182

C

Call blocking 145

Call failed 205

CAPI devices 55

CDO error 203

Character delay 98

Clickatell 188-189

Cluster 12, 18

Communications ports 97

Configuration Wizard 14, 35, 37-38, 52, 59-61, 63,
203

Country code 54, 117, 147, 194

Covernotes 136-137, 140, 142-144

Coverpages 9, 70, 136-144

CSID Routes 167

CSID Routing 162, 167

D

Data initialization string 98

Debug mode 208

Default coverpage 70, 137-139

Default routers 36, 38, 40, 171

Dial prefix 93, 117, 145, 148

Dial tone 91

Dialling options 146

DID 91, 133, 162, 164, 170, 207

DLE codes method 98

Document conversion 129, 180, 205-206

Dual-tone multi-frequency signalling 91, 133, 162,
164, 170

E

Email2Fax gateway 103

Email2FaxGateway test 203

Error correction mode 94

F

Failed faxes 70, 108, 123, 133

Fax administrators 57, 76, 101

Fax card 90

Fax class 98

Fax ID 93, 149, 151, 205

Fax initialization string 98

Fax lines 54, 59-62, 79, 90, 96-97, 125, 166, 179

Fax modem 13, 90, 97-98, 178, 207

Fax transmission 10, 13, 15, 80, 88, 106, 131, 141,
145, 147, 180, 182

faxmaker.com 15-19, 33, 35-36, 38, 40, 44, 63-66, 70,
105, 117, 122, 185

Firebird 61, 82, 108-109, 116, 178, 183

Firewall 13, 42, 195, 203

Flow control 98

FoIP 13, 150, 177

Footer 134

Forum 203, 208

Front Covernotes 136-137, 140, 142-144

G

Gateway devices 91

Gateway settings, SMS 189

Gmail 34, 38, 46

Google Apps 12, 34, 38

GSM modem 188, 207

H

Hardware 12, 48, 55, 58-60, 62, 156

Header 94, 134
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HPDS 123

HPFSCAN 123

Hub Transport role 12, 15-17

I

IIS SMTP 12, 16, 44, 52, 63

Initialization String 92, 98, 190

International dialling 148

Internet Address 27

Internet Message Access Protocol 20, 27

ISDN 55, 90-91, 162, 164

ISDN BRI CAPI2.0 devices 91

J

Junk fax 176, 180

K

Knowledge base 203, 208

L

Licensed users 63, 66-67, 96, 98, 101-102, 105, 108,
163, 165, 167, 186, 198

Line Routing 162, 166

Local fax ID 93, 149, 151, 205

Log files 46, 121, 180, 183, 189, 199, 208

Lotus Domino/Notes 19, 26, 30

M

Max. resolution 93

Max. speed 93

Merge-fields 137, 140, 142

Message Media SMS service 188-189

Microsoft Exchange 8, 12, 15-18, 35, 50, 52, 74, 106,
148, 151, 173, 201-202

Microsoft Office 365 12, 34, 36, 106

Modem type 92, 97-98

MSN 91, 162, 164, 207

Multiple mail servers 45

Multiple Subscriber Numbering 164

N

National dialling 148

NetPrintQueue2Fax 9, 45, 64, 66, 156-157, 180

Network Share 46, 168, 172

O

OCR 8, 119, 126, 162, 164, 170, 177

Operating systems 11, 48, 58-59, 61-63, 174, 204

Optical Character Recognition 119, 164

P

PABX 93, 149-151, 205

POP3 8, 12, 15, 19, 24, 27, 44-45, 53, 63, 67, 103,
105, 186

POP3 Downloader 45, 67, 103, 105, 186

Port 13, 35, 37, 39, 42, 103-104, 122, 190, 207

Pre-command delay 98

Printers 94, 128, 156, 162, 174, 180

Public folder 173

R

Receive all faxes 64, 173-174

Receiving faxes 8, 13, 16, 19, 36, 38, 40, 44, 46, 54,
59-62, 64, 71, 89, 93, 95, 100, 108-109, 112,
114, 118-120, 122, 128, 133, 161-164, 166-
167, 170-171, 173, 175, 179, 187-188, 203,
206

Receiving SMS 46, 187

Requirements, SMS 188

Routing, fax 9, 162, 166, 174

Routing, SMS 189, 198

S

SAP 4.7 44-45

Secure Password Authentication 35, 37, 39, 54, 103

Sending faxes 12, 16, 19, 36, 38, 44-45, 58-61, 63,
66-67, 72, 89, 92, 105, 117, 124, 127, 145, 147,
149, 156, 159, 206

Sending SMS 185

SIM card 190, 207

SMS

Archiving 189, 199

Log files 46, 189, 199

smsmaker.com 15-19, 33, 36, 38, 40, 44, 63-64, 66,
70, 105, 122, 185

SMTP Connector 42, 50, 103, 202

SMTP/POP3 mail servers 8

SR140, Brooktrout 13, 55, 177, 182

SSL 39, 54, 72, 77, 103, 105, 113
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Suffix 93

Supported mail servers 11

Supported operating systems 11

System Requirements 11, 178, 181

T

Technical support 203, 208

Test fax 36, 38, 40, 43, 59-62, 64, 96, 107, 122

TextAPI 53, 63, 157-158, 179

Thread priority 98

Tone 91, 205

Transmission report 16, 19, 44, 46, 64, 70, 108, 117,
120, 128-130, 168

Troubleshooting 203, 208

Truncate 197

U

Uninstall 58, 60-61, 201

Upgrading installation 48, 57-61, 116, 177, 180

Use SMTP Authentication 35, 37, 39, 54, 103, 204

Use SSL 105

Users, SMS 189, 198

V

Voice chipset 98

Voice initialization string 98

W

Web based SMS 188-189

Wizard 14, 35, 37-38, 52, 59-61, 63, 203

X

XMLAPI 53, 157-159, 179, 185
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